
© 1997 - 2019  Railcar Tracking Company a Division of Savage Services Corp.

Version 8.00.40



RMS - Railcar Management System
User Manual and Reference



All rights reserved. No parts of this work may be reproduced in any form or by any means - graphic, electronic, or
mechanical, including photocopying, recording, taping, or information storage and retrieval systems - without the
written permission of the publisher.

Products that are referred to in this document may be either trademarks and/or registered trademarks of the
respective owners. The publisher and the author make no claim to these trademarks.

While every precaution has been taken in the preparation of this document, the publisher and the author assume no
responsibility for errors or omissions, or for damages resulting from the use of information contained in this document
or from the use of programs and source code that may accompany it. In no event shall the publisher and the author be
liable for any loss of profit or any other commercial damage caused or alleged to have been caused directly or
indirectly by this document.

Printed: July 2019 in Midvale, UT

Railcar Management System Help

© 1997 - 2019  Railcar Tracking Company a Division of Savage
Services Corp.



Table of Contents

Foreword 0

Part I What's New 5

Part II Getting Started 24

Part III How Do I 28

................................................................................................................................... 281 Data Imports 

.......................................................................................................................................................... 28Get sighting data from Steelroads 

................................................................................................................................... 302 Email a report automatically 

................................................................................................................................... 303 Scrub Data 

................................................................................................................................... 334 Sort data on a data grid 

................................................................................................................................... 345 Copy data from a data grid 

................................................................................................................................... 356 Trace railcar locations 

Part IV Custom Reports 37

................................................................................................................................... 381 Creating Custom Reports 

................................................................................................................................... 392 Creating Specific Custom Reports 

.......................................................................................................................................................... 40Union Pacific Demurrage 

......................................................................................................................................................... 40Serving Area Arrivals

......................................................................................................................................................... 42Railcars in Serving Area

......................................................................................................................................................... 44Railcars at Industry

................................................................................................................................... 453 Setting Up Automatic Delivery of Custom Reports 

................................................................................................................................... 474 Tracking Exported Data 

................................................................................................................................... 485 Faxing Custom Reports 

................................................................................................................................... 496 Creating a Dataset (Report Framework) 

................................................................................................................................... 497 Dataset descriptions 

.......................................................................................................................................................... 50CLM Format H 

.......................................................................................................................................................... 51Contract Rates 

.......................................................................................................................................................... 53Cycles 

.......................................................................................................................................................... 57Demurrage Proprietary 

.......................................................................................................................................................... 61Demurrage Proprietary by Month 

.......................................................................................................................................................... 63Demurrage Railroad 

.......................................................................................................................................................... 68Duration of Bad Orders 

.......................................................................................................................................................... 70First Sighting in RR Serving Area 

.......................................................................................................................................................... 71Last Sightings 

.......................................................................................................................................................... 78Last Sightings History 

.......................................................................................................................................................... 81Last Sightings with Inventory 

.......................................................................................................................................................... 85Last Sightings with Last Loaded Shipping Instruction 

.......................................................................................................................................................... 91Last Sightings with Pool Trip Plan 

.......................................................................................................................................................... 93Problem Logs 

.......................................................................................................................................................... 95Railcar Utilization 

.......................................................................................................................................................... 97RMS Events 

.......................................................................................................................................................... 98RMS Statistics 

Railcar Management System HelpI

© 1997 - 2019  Railcar Tracking Company a Division of Savage Services Corp.



.......................................................................................................................................................... 99Round Trip Cycles 

.......................................................................................................................................................... 104Shipping Instructions (formerly Bills) 

.......................................................................................................................................................... 112Sightings 

.......................................................................................................................................................... 115Railcar Leases 

Part V Daily Reports 118

................................................................................................................................... 1181 Bad Orders 

................................................................................................................................... 1182 Demurrage - Railroad In Progress 

................................................................................................................................... 1193 Inbound Railcars 

................................................................................................................................... 1194 Last Sighting - various 

................................................................................................................................... 1195 Railcar history view and report 

Part VI Management reports 120

................................................................................................................................... 1201 Bad Order Activity by Railroad 

................................................................................................................................... 1202 Bad Order Duration by Railroad 

................................................................................................................................... 1213 Demurrage - Proprietary by Month 

................................................................................................................................... 1234 Demurrage - Proprietary by Party 

................................................................................................................................... 1235 Demurrage - Proprietary by Station 

................................................................................................................................... 1236 Demurrage - Railroad by Station 

................................................................................................................................... 1247 Last Sighting History 

................................................................................................................................... 1258 Pool Changes 

................................................................................................................................... 1259 Railcar Utilization 

................................................................................................................................... 12710 Shipping Instructions Detail 

................................................................................................................................... 12811 Trip Cycles - Load-Unload Performance 

................................................................................................................................... 12912 Trip Cycles - Round Trips 

................................................................................................................................... 12913 Trip Cycles - Segments Detail 

................................................................................................................................... 13014 Trip Cycles - Total Trip by Route 

................................................................................................................................... 13015 Trip Cycles - Transit Performance 

Part VII Data Management 131

................................................................................................................................... 1311 Commodities 

.......................................................................................................................................................... 132Add, Update or Delete Standard (STCC) Commodities 

.......................................................................................................................................................... 133Add Update or Delete Proprietary Commodities 

................................................................................................................................... 1342 Contract Rail Rates 

.......................................................................................................................................................... 134Add, Update, Delete Contract Rail Rates 

................................................................................................................................... 1353 Cycles 

.......................................................................................................................................................... 135Review cycles 

................................................................................................................................... 1394 Demurrage/Detention 

.......................................................................................................................................................... 139Proprietary Demurrage Criteria 

.......................................................................................................................................................... 140Railroad Demurrage Criteria 

................................................................................................................................... 1425 EDI File Transfer 

.......................................................................................................................................................... 142EDI File Transfer setup 

................................................................................................................................... 1446 Import Properties 

IIContents

II

© 1997 - 2019  Railcar Tracking Company a Division of Savage Services Corp.



.......................................................................................................................................................... 144Import Properties 

................................................................................................................................... 1467 Origin-Destination (OD) Pairs 

.......................................................................................................................................................... 147Add, Update, or Delete origin-destination (OD) pairs 

................................................................................................................................... 1488 Parties 

.......................................................................................................................................................... 148Add, Update, Delete Parties 

................................................................................................................................... 1499 Problem Logs 

.......................................................................................................................................................... 149Add, Update, or Delete Problem Logs 

................................................................................................................................... 15010 Railcar Pools 

.......................................................................................................................................................... 151Add a railcar pool 

.......................................................................................................................................................... 151Update a railcar pool 

.......................................................................................................................................................... 152Delete a railcar pool 

.......................................................................................................................................................... 152Assign one or more railcars to a pool 

................................................................................................................................... 15311 Railcars 

.......................................................................................................................................................... 153Add / select multiple railcars 

.......................................................................................................................................................... 155Add a single railcar 

.......................................................................................................................................................... 155Assign railcars to report group 

.......................................................................................................................................................... 157Assign railcars to sublease 

.......................................................................................................................................................... 159Change Status 

.......................................................................................................................................................... 161Change ownership 

.......................................................................................................................................................... 161Deactivate and reactivate railcars 

.......................................................................................................................................................... 163Delete railcars 

.......................................................................................................................................................... 163Search railcars 

.......................................................................................................................................................... 164Update railcars 

................................................................................................................................... 16512 Railroads 

.......................................................................................................................................................... 166Add, Update, Delete railroads 

................................................................................................................................... 16613 Reference Values 

.......................................................................................................................................................... 167Update Reference Values 

.......................................................................................................................................................... 167Days to Keep Data Files 

.......................................................................................................................................................... 167Days to Keep Error Logs 

.......................................................................................................................................................... 167Days To Save Backup 

.......................................................................................................................................................... 168Days Until Deactivate Non-Moving Temporary Railcars 

.......................................................................................................................................................... 168Email address 

.......................................................................................................................................................... 168Emailed Report Supplemental Message  

.......................................................................................................................................................... 169Flat File Directory 

.......................................................................................................................................................... 170Outgoing mail server settings 

.......................................................................................................................................................... 171Proxy Server Settings 

.......................................................................................................................................................... 172Relate BOL Days 

.......................................................................................................................................................... 172Relate BOL Days Early Release 

.......................................................................................................................................................... 172Steelroads settings 

.......................................................................................................................................................... 173Technician Email Address 

................................................................................................................................... 17314 Scheduler 

.......................................................................................................................................................... 174Add, Update, Delete a scheduled activity 

.......................................................................................................................................................... 175Backup Database 

.......................................................................................................................................................... 175Create Cycles Only 

.......................................................................................................................................................... 175Delete Railcar Data 

.......................................................................................................................................................... 176Import Data and Create Cycles 

.......................................................................................................................................................... 176Import Data Only 

.......................................................................................................................................................... 176Output Batch Reports 

.......................................................................................................................................................... 177Update Trip Plans 

................................................................................................................................... 17715 Shipping Instructions (AKA: Bills of Lading, Waybills) 

.......................................................................................................................................................... 178Add shipping instructions manually 

Railcar Management System HelpIII

© 1997 - 2019  Railcar Tracking Company a Division of Savage Services Corp.



.......................................................................................................................................................... 179Update shipping instructions 

.......................................................................................................................................................... 180Update multiple shipping instructions 

.......................................................................................................................................................... 181Delete shipping instructions 

.......................................................................................................................................................... 182Review shipping instructions 

.......................................................................................................................................................... 183Import from Railroad Customer 417 Account 

.......................................................................................................................................................... 185Import from RTC Data Services 

.......................................................................................................................................................... 185Import from a text file 

................................................................................................................................... 18816 Sightings 

.......................................................................................................................................................... 188Add / Update / Delete railcar sightings 

.......................................................................................................................................................... 190Restore Archived Sightings 

.......................................................................................................................................................... 190Import railcar sightings 

......................................................................................................................................................... 190Import from Steelroads

......................................................................................................................................................... 191Import from a text file

......................................................................................................................................................... 192Import from Data Services

................................................................................................................................... 19217 Stations 

.......................................................................................................................................................... 192Add a station 

.......................................................................................................................................................... 193Update a station's characteristics 

.......................................................................................................................................................... 193Merge a station 

.......................................................................................................................................................... 194Managing & Responsible stations 

.......................................................................................................................................................... 195Delete a station 

................................................................................................................................... 19618 Trip Plans 

.......................................................................................................................................................... 196Automatic Generation 

.......................................................................................................................................................... 197Update multiple event days to destination manually 

Part VIII Admin 198

................................................................................................................................... 1981 Create User 

................................................................................................................................... 1992 User Management 

................................................................................................................................... 2013 Create Role 

................................................................................................................................... 2024 Change Password 

Part IX Help 202

................................................................................................................................... 2021 Error Logs 

................................................................................................................................... 2032 Event Logs 

Part X Glossary 203

Part XI Advanced 206

................................................................................................................................... 2061 Email Reports 

................................................................................................................................... 2072 Import Railcar Sightings 

................................................................................................................................... 2073 Release Sightings 

................................................................................................................................... 2074 Known Issues 

Index 208

IVContents

IV

© 1997 - 2019  Railcar Tracking Company a Division of Savage Services Corp.



Railcar Management System Help5

© 1997 - 2019  Railcar Tracking Company a Division of Savage Services Corp.

1 What's New

NOTE: To determine the RMS version, click on the Help > About RMS menu. It will also display the
version of the database.

RMS 8.00.10 released 2/15/2019

Improvements

[ 162464519 ] As a user, I would like to bulk assign railcars to Owned = True. See
Change Ownership Status.
[ 154038277 ] As a user, I would like to edit a single railcar in a list of newly added/selected railcars
and when the change is saved, the list of newly added/selected railcars is preserved.  See
Add / Select Multiple Railcars.
[ 153643222 ] & [ 162556886 ] & [ 162558542 ] As a user, I need to see product / hazmat information
including emergency contact phone number on the Shipping Instrucstions Detail report.  See
Shipping Instructions Detail report.
[ 156694861 ] As a User, I want to know the average days from origin and plan days from origin for any
particular trip. See the fields DaysFromOriginAvg and DaysFromOriginPlan available in the
Last Sightings custom report dataset.
[ 159450232 ] As a user, I would like to see the same ETA on the Daily Reports as on the Trace page.
NOTE: the railroad-provided ETA to destination, if provided, is now the ETA that is shown by default. If
the railroad ETA is not available or is not to destination, then the RMS ETA is shown.
[ 160659442 ] As a system, I need to separate cycles based on location and consecutive events
provided by the user. See Data Management > Import Properties.
[ 157526943 ] As a system, my database must be compatibility level 2012. This will allow RMS to use
much more advanced functions and it will allow users to use more advanced functions in the
Custom Expression Filters.
[ 161092582 ] As a system, I need to attach shipping instructions to cycles without considering
load/empty status for intermodal equipment shipment. See
Data Management > Reference Values > Relate BOL Days and
Data Management > Reference Values > Relate BOL Days.
[ 156865591 ] As a user, I need to bill my customers for completed or in-progress demurrage incurred

in the prior calendar month. See Management Reports > Proprietary Demurrage by Month

Fixes

[ 160807079 ] Steelroads webservice timeout issue
[ 160303190 ] Steelroads web service multiple trace lists are not handled
[ 153563937 ] Export of temp files for Sightings export have conflicting file names
[ 159839621 ] ETA2Source seems to be displaying the incorrect value, but when exported, it is correct.
[ 160081056 ] ETA not showing on the Last Sighting reports when user enters a new sighting manually
[ 152928344 ] procSaveShipment will need to declare @intShipmentID before the procInsertShipment
call. This will break when we start using a newer version of SQL Server.
[ 159806386 ] Imported date/time getting updated when a sighting is updated due to updated ETA from
Staging system
[ 159810913 ] Updating ETAs on sighting records was triggering the deletion of the cycle causing
performance issues

RMS 7.60.10 released 7/17/2018
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Improvements

[ 158991662 ] As a user, I need to see updated ETAs from the railroad (Part 3)
[ 156817704 ] As a user, I need to see updated ETAs from the railroad (Part 2)
[ 156900156 ] As a user, I need to see updated ETAs from the railroad (Part 1)
[ 157609183 ] Add Commodity and ShipmentDesc from the last loaded shipping instruction to the
Last Sightings custom dataset
[ 157579081 ] Add ETAOriginalDttm, ETAOriginalSource, ETA2OriginalDttm, ETA2OriginalSource,
ETARROriginalDttm and ETARMSOriginalDttm fields to the LastSightings custom dataset
[ 113757407 ] Add option to use Steelroads web service interface. As of 3/28/2019, this is the only
interface to Steelroads that is supported. This has been implemented for all customers who use
Steelroads for a data source.
[ 151964377 ] Add a custom report dataset that exports sightings to CLM Format H. This is used
primarily by RMS to share data from one RMS application to another. However, you could use this to
export data in an industry standard format to share with other systems that are able to import this type
of file.
[ 155236557 ] Add key railcar property fields to viewLastSightings and add ReportGroup to viewBills
[ 155868768 ] Change ETADttm and ETASource on Daily Reports to ETA2Dttm and ETA2Source
[ 153643409 ] As a user, I would like to print out a single page summary of a shipping instruction
[ 153801961 ] As a user, I need to see multiple line description of the commodity
[ 149847986 ] As a user, I need to see all parties involved in the shipment
[ 151660882 ] As a system, I need filter data delivery by CIF for all parties
[ 152899948 ] Add "Available for Placement" sighting event code 4 to T_EVENT_DESCRIPTIONS
[ 151698235 ] Expand the number of sightings shown on Home page to 500
[ 151616331 ] Proprietary Demurrage by Station / Customer: Add option to apply filter to Cycle Start
(Release), Placement (CP/AP) or Cycle End (Release End)
[ 150620292 ] As a system, I need to include the user id on the RMS Event Logs
[ 151695643 ] Add ETARMSDttm field to viewLastSightings
[ 150532361 ] Must be able to manually enter a negative number in the DaysToDestination field on the
Edit Trip Plan Event

Fixes

[ 159023172 ] Duplicate station record insert error crashes Update Trip Plans
[ 156027851 ] Manual updates to Trip Plan Events Days to Destination must remove days of week
Days to Destination
[ 156935198 ] Add New Shipping Instruction is not allowing the record to be saved - no error
[ 156704904 ] When Steelroads server not available, errors are raised, but not emailed to Technician
[ 152220360 ] Track exports filters are not concatenating the Custom Expression Filter properly
(WORK-AROUND IS AVAILABLE)
[ 151864367 ] Trip Cycles - Total Trip: Incorrect syntax near 'Is Not Null' error raised during scheduled
export
[ 151862693 ] Data Management > Cycles filtering is not using parenthesis properly - it is including too
many records
[ 151889340 ] Stations - notice of duplicate station alias doesn't provide the correct station name
[ 151660370 ] Data Management > Cycles when edit a cycle record, the filter is lost
[ 151662718 ]D ata Management > Shipping Instruction: Quick Filter, Advanced Filter, and Custom
expression filter not getting cleared after this page is closed and reopened
[ 150532397 ] Can't clone all of the field values when cloning a Trip Plan
[ 152367695 ] Tabs on the Home page are not refreshing when change railcar and then switch to
another tab
[ 152567509 ] Error saving CSV formatted shipping instruction: Must declare the scalar variable
"@intShipmentID"
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RMS 7.10.00 released 10/11/2017

Improvements

[ 148439927 ] ETA calculations changed to handle day of week. RMS will now check the day of the
week that an event happens and will use the DaysToDestination for historical moves when the event
happened on the same day. This will make RMS ETAs more accurate if there is less than daily service
to a particular destination. If a matching day of week DaysToDestination is no found, then RMS will use
the overall average.

[ 150067611 ] ETA calculations changed to handle negative DaysToDestination. If a user enters a
negative number in a DaysToDestination field for a Trip Plan Event, then RMS will not calculate an
ETA for that event.

[ 147446317 ] As a user, I would like to manually update Days To Destination for Trip Plan Events for
multiple Trip Plans at once based on values copied from a spreadsheet. See
Update multiple event days.

[ 136510281 ] RMS branded with the Savage logo and colors.

[ 141947085 ] As a user, I need see the Origin, Destination, Route, LE, TransitMethod on the Trip
Plans list page.

[ 137998869 ] 3 and 6 month option added to the Delete Railcar Data scheduled activity.

[ 146963187 ] As a user, I want to be able to filter reports by origins, destinations, or locations using
simplified stations. This is an alternative to merging stations into one another. It would be useful in the
situation where shipments are billed to one station, but are actually placed at another station close by.
See Managing & Responsible stations.

[ 149504853 ] Add ReportGroup field to the Shipping Instructions custom report dataset. See
Shipping Instructions dataset.

[ 142795001 ]  Add new measures to RMS Statistics custom report dataset: Shipping Instructions in
last 31 days with no related cycle; Cycles in last 31 days with no related shipping instruction; Cycles
completed in last 7 days with missing key event; Completed cycles in last 31 days that are invalid.

Fixes

[ 131893737 ] Error logged during shipping instruction import doesn't notify technician.

[ 102529050 ] Round Trip Cycles by Route: Step 3: filter not saved.

[ 90322684 ] Problem Logs: Occurred date can't be set.

[ 89465468 ] Imported date/time field is not getting populated when shipping instructions are manually
added using the Save & New or the Save & New Similar buttons.

[ 140503095 ] When select a different railcar initial, data on Home page is not refreshed.

[ 137998869 ] When editing the Delete Rail Data scheduled activity - Years Old value is incorrect; 3
and 6 month option.

[ 116907713 ] ETA year calculation during leap year problem When the ETA month and day with a leap
year is more than 30 days behind the Event month and day with a leap year, RMS assumes that the
ETA is the next calendar year. Example is when the event date is 3/31/2016 and the ETA date is
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2/29/2016. The number of days difference is -31. So RMS was trying to create an ETA of 2/29/2017
since the current year is 2016.

[ 143976691 ] Import sightings process is not deleting duplicate sightings out of the staging table; they
collect and then eventually, with large shippers, the import times out.

[ 151539432 ] Tracking Exports: the ad hoc filter is getting used instead of the saved filter. If a user ran
and viewed the report in the RMS UI and changed the filter for that ad hoc view of the report, then the
next time (and all future runs) that the scheduled run of the report ran, it would use the filter from the
ad hoc session.

[ 145146855 ] Company text box on Add/Edit Party page must be extended to allow 35 characters.

[ 151312625 ] Output Batch Report scheduled activity error: Object reference not set to an instance of
an object.

[146631717 ] Tab character in between railcar initial and number raises error on Railcar Add / Select
page.

[ 107579204 ] Archived sightings not refreshed properly on the Home page.

[ 133137849 ] Update Trip Plan process is not finishing with high volume shippers.

[ 147619805 ] Last Sighting History report is crashing.

[ 148264545 ] Advanced filter should have parenthesis around user created filters.

[ 148150085 ] Cannot delete Advanced Filter.

[ 115534029 ] Station 333 abbreviation add JCT for JUNCTION.

[ 114020243 ] Internet browser save password feature doesn't work.

RMS 6.15.00 released 5/15/2017

Improvements

[ 134379927 ] Ability to update multiple shipping instructions at once.

[ 128026685 ] ETA related fields added to the viewSightings Custom Report Dataset: ETARRCity,
ETARRState, ETARRDttm, ETARREvent, ETARREventDesc, ETARRType

[ 130129947 ] ETA related fields added to the viewLastSightings Custom Report Dataset: ETARRCity,
ETARRState, ETARRCityState, ETARREvent, ETARREventDesc, ETARRType, ETA2Dttm,
ETA2Source. The ETA2Dttm field displays the ETA that comes from the sighting record by default; if
there is no ETA provided on the sighting record, then it will display the ETA that RMS calculates from
historical moves; if there is no RMS ETA, then no ETA will be displayed.

NOTE: The ETA that RMS calculates (ETADttm) will now be based on the system date / time plus the
Days From Destination for the particular station, event, railroad from the Trip Plan that RMS creates
from historical shipments. Prior to this version, the RMS ETA was based on the EventDttm plus the
Days From Destination for the particular station, event, railroad from the Trip Plan that RMS creates
from historical shipments. We spoke with customers about this change and got solid feedback that this
is a more logical and reliable way to estimate ETAs especially for delayed railcars. For example, a
railcar was last reported arrived Denver, CO on the BNSF on May 1, 2017 and it is destined to
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Houston, TX, which historical shipments have taken 4 days to reach the final destination from this
location. Prior to this version, RMS would calculate the ETADttm by adding 4 days to the EventDttm
(5/1/2017). In this version, RMS now calculates the ETA by adding 4 days to the system date/time. If
the railcar is delayed in Denver for 3 days, RMS will continue to show the railcar as 4 days out 3 days
from now. The prior versions of RMS would show the railcar 1 day away from the destination on the 3rd
day even though the railcar is still last reported in Denver. We feel that this way of calculating ETAs will
be more accurate for delayed shipments and will be about the same as pior version for normally
moving shipments.

Fixes

[ 138071755 ] Last Sighting History report is timing out after running for a long time. It was redesigned
and runs much faster now.

[ 135138715 ] Invalid railcar initials are not prevented. Sometimes users accidentally paste railcar
initials with invalid characters (e.g. //of 3011 ).

RMS 6.14.00 released 3/6/2017

Improvements

[ 133640443 ] Quickly combine / merge two stations into one. Occasionally, two station records are
created in RMS for the same station city & state due to inconsistent spelling of the city / state. This
feature now enables a station to be merged into another station with only a few mouse clicks.

Fixes

[ 138071067 ] The Daily Report Last Sightings with Inventory has been removed from the user
interface. It is not usable at this time.

[ 98483826 ] When there was a failure during the scheduled activity Output Batch Reports, errors
would not be emailed to the technician.

[ 107397672 ] When an Advanced Filter is created where an open parenthesis is on one line and the
close parenthesis is on another line, when the user tries to edit the filter, an error is raised.

[ 84336286 ] When a mis-formatted, single sighting (CLM) record raises an error during the Import
Sightings scheduled process, the entire sightigns import process would fail.

[ 140068727 ] After a new shipping instruction is added or deleted to/from the Home page, the list of
shipping instructions in the data grid is not refreshed properly.

RMS 6.13.00 released 2/9/2017

Improvements

[ 133638099 ] RMS can now transmit multiple fleet updates to Railinc (our data team). It will also be
able to communicate include / exclude railroad instructions. This will enable data feeds to be more
targeted at a lower cost.

Fixes

[ 126833289 ] The Origin / Destination Pairs Origin City filters gets cleared after the search, which
makes it difficult to paginate through multiple pages of results.
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[ 110776656 ] When the user enters a user ID that doesn't exist, RMS raises a hard to understand
error.

[ 97836816 ] When the user enters a new shipping instruction record on the Home window, after the
user clicks the Save button, the data grid is not refreshed to show the new record.

[ 132669211 ] The scheduled batch proces Delete Railcar Data times out when run on a large
database.

[ 133640275 ] The user enters filters on the Data Management > Shipping Instructions page; the data
grid of results is shown; if the user clicks the Edit link for one of the records and then clicks the Cancel
button on the specific shipping instruction page the focus returns to the data grid of results, but the
filter is no longer applied properly.

RMS 6.12.00 released 11/29/2016

Improvements

[ 130774601 ] Add Trace Railcars page that shows last location for each railcar pasted / entered by
user and/or that belongs to a selected Pool and/or Report Group. By clicking on the railcar initial /
number hyperlink in the trace results, the Home window will display in a new browser tab window with
the last 30 days of sighting, cycle, shipping instruction and problem history for that particular railcar.

NOTE: The Data Management menu has been moved to the right sight of the menu bar, to the left of
the Admin menu. This may cause brief user confusion. This was done to place the most often used
menus on the left and the lesser used menus on the right to increase productivity. The Custom Reports
menu has been moved to the left-center of the menu bar ahead of the Daily Reports and Management
Reports menus since it is used more often on average than the Daily Reports and Management
Reports menus.

[ 124984651 ] Field description popup when hover pointer over a field name. When editing a report in
the Custom Report Builder, the mouse pointer will trigger a popup window with a description of the
field. The latest user survey indicated that this was highly desired, which would make creating custom
reports easier.

[ 127943249 ] Add Station, Start Commodity, End Commodity columns to Data Management >
Demurrage > Railroad list page. This makes it easier to identify railroad demurrage rules that are
specific to a commodity and/or location.

Fixes

[ 130415627 ] Search text box on Data Management > Railcars > Veiw/Add/Update window needed to
find railcars that are formatted with leading zeros and with or without a space between the initial and
number: For example: KEYX000750 or KEYX 000750.

[ 130416041 ] Validate text box on Data Management > Railcars > Veiw/Add/Update > Add/Select
Multiple window needed to validate railcars that are formatted with leading zeros and with or without a
space between the initial and number. For example: KEYX000750 or KEYX 000750.

[ 110422596 ] The Import Properties option "Create a new cycle on consecutive Actual Placement (Z)
and Release (W) events regardless of Load/Empty status" was not working properly. This option is
useful if you ship "reloads".

[ 115958573 ] Update Daily Reports > Demurrage - Railroad in Progress and Management Reports >
Demurrage - Railroad by Station default filtering was not working properly.
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[ 128002887 ] Some Quick Filters for reports based on the Demurrage Railroad dataset were not
getting saved.

[ 130758131 ] Management Reports > Last Sighting History report was timing out as well as custom
reports based on the Last Sightings History dataset fail to display in the report viewer with an error
"Connection Timed Out".

RMS 6.10.60 released 8/10/2016

Improvements

NOTE: The railroad demurrage settings maintained in the Data Management > Demurrage > Railroad
section of the application will be changed by this update. If you have non-standard demurrage
agreements with any of the railroads, you may create a new railroad demurrage record for a specific
location that will override the railroad demurrage calculations for that location. You may also change
the records back to your preferences.

[ 114826677 ] Updated BNSF demurrage rules

[ 127600683 ] Update CSX demurrage rules

[ 127600255 ] Update KCS Demurrage rules

[ 127573897 ] Two railroad demurrage report improvements related to specifically to Union Pacific
serving areas:

1) Add ability of railroad demurrage reports to show when railcar arrived at the serving area. A new
field has been added to the Demurrage Railroad custom report dataset named SAArriveDate, which
shows the date that the railcar was first reported at a station, which is considered the beginning of
the railroad demurrage serving area. You will need to tell RMS about the station by creating a new
railroad demurrage record for the particular railroad, activity (loading or unloading) and station.  To
add this field to a report, edit the report, if it is a custom report, clone the report if it is a Daily or
Management Report. In the custom report builder, click on the Fields tab, highligh the SAArriveDate
in the list box on the left and then click the Select Fields button. This will add the field to your report.

2)  Add the ability to create monthly serving area reports. This report will be helpful for Union Pacific
demurrage estimates since they provide credits and debits based on when the railcar enters the
serving area.

[ 127599405 ] Create new custom report dataset named Last Sightings History and a new
Management Report named "Last Sighting History". This report will be helpful if you want to see the
latest location of railcars on any given day for up to the last 45 days.

[ 126640699 ] Add several fields to the Railcars and Lease Information custom report dataset. Here is
a list of fields added:

· Tare Weight
· IsCarSubleased
· IsSubleaseInactive
· Lessee (of sublease)
· SubleaseType
· ContractNumberSub (the contract number of the sublease)
· MonthlyRateSub (the monthly rate of the sublease)
· EffectiveDateSub (effective date of the sublease)
· ExpirationDateSub (expiration date of the sublease)
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· IsCarOwned
· Height
· Width
· RetireDate
· Class
· LoadLimit
· UserField1 (can be used for any text up to 30 characters)
· UserField2 (can be used for any text up to 4000 characters)
· LoadFeeSub (the dollar amount of a fee related to each load for a subleased railcar

Follow this link for additional information about these and each field in the Railcars and Lease
Information dataset.

RMS 6.10.50 released 7/8/2016

Improvements

[ 120244311 ] Data Management > Railcars > View / Add / Update -  Add / Select Multiple Railcars
feature enhancement:

· Persist the recently added / selected list of railcars after bulk activities have been performed so
that other bulk activities may be performed on them. The exception to this is when railcars are
Deleted (it is rare that you will ever delete a railcar - it is not recommended because it will remove
all of the history of the railcar movements. You should, in most cases, deactivate a railcar that is
no longer being used).

· The Select All button has been removed, replaced with a checkbox in the column header of the
data grid where users place checks select a particular railcar. By placing a check in this check
box, all railcars visible on the data grid will be selected with checks in their corresponding check
boxes. By removing the check in the check box in the column header, all checks in the data grid
will be removed, thus deselecting all the railcars.

· Users can now deselect some of the recently added / selected railcars and perform bulk activities
with just the selected railcars (i.e. checks in their check boxes). The deselected railcars will
continue to display after the bulk activities, but the bulk activities will not be performed on them.

· The order of recently added / selected railcars will be identical to the order that the user entered /
pasted them.

· Multiple contiguous railcars may be selected (i.e. checks in their checkboxes) by a user placing a
check in the first railcar checkbox, pressing the Shift key, and placing a check in another railcar
checkbox below or above the first railcar; all railcars in between will get selected (i.e. checks in
their checkboxes). This feature will work with recently added / selected railcars as well as active,
inactive, all or no pool assignement railcars.

Fixes

[ 107586440 ] Adding Destination field to custom report the default size is 0.

[ 114819721 ] Data Management > Demurrage > Railroad page: Activity drop down list box is
displaying the incorrect entry based on the value stored in the database. When it was displaying
"UNLOADING" these were actually the settings that the system was using for "LOADING" demurrage
calculations. This would not have any impact to railroad demurrage reports unless a user modified the
demurrage settings.
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RMS 6.10.01 released 4/22/2016

Fixes

[ 116907713 ] ETA year calculation during leap year problem. When the ETA month is 02 and ETA day
is 29 and the current date is March 30 or later, the incorrect year was getting assigned to the ETA. The
algorithm has been changed so that the system will never try to create a 02/29/YYYY ETA with a non-
leap year. Also the assumptions for how old ETAs can be have been changed to 6 months instead of
30 days. Therefore, ETAs can only be up to 6 months in the future now.

RMS 6.10.00 released 2/25/2016

Improvements

[ 110567284 ] Add / Select Multiple Railcars feature has been added. This was the most popular
request on the recent Product Feature Survey. Users may now copy a list of railcars from a
spreadsheet, email or other electronic document and then paste this list onto an RMS page. With two
button clicks, RMS will add and select (if the railcars are already in the database, they will just be
selected) this list. The users then can perform the usual tasks on this selected list such as: Assign to
Report Group, Assign to Pool, Assign to Lease, Assign to Sublease, Delete, Reactivate, Deactivate,
and Change Status.

[ 110277882 ] Change password process is confusing. After the password has been changed, the
change password dialog box will now close automatically and the user is returned back to the main
Login window with a message "Password changed successfully".

Fixes

[ 114433853 ] Reports using the wrong filter or no filter at all

[ 105579394 ] Ultimate Consignee company name (UC qualifier) is getting populated into the Care Of
(C1 qualifier) party field. This is causing confusion and difficulty in finding out why sightings/CLM is not
sent for certain shipments.

[101084948 ] Shipping Instruction CSV import not importing all fields.

RMS 6.00.36 released 1/15/2016

Improvements

[ 110567530 ] Add ReportGroup field to various Management Reports: Demurrage - Proprietary by
Party, Demurrage - Proprietary by Station, Demurrage - Railroad by Station, Trip Cycles - Load-Unload
Performance, Trip Cycles - Round Trip by Pool Summary, Trip Cycles - Round Trip by Pool, Trip
Cycles - Round Trip by Route Summary, Trip Cycles - Round Trip by Route, Trip Cycles - Total Trip by
Route, Trip Cycles - Transit Performance. This will enable users to add this field to these reports after
cloning them. It will also enable them to filter, sort, and group by this field.

RMS 6.00.35 released 12/02/2015

Improvements

[ 109281474 ] Changed the password expiration default setting to never expire. Only a few customers
wish to have the password expire on a regular basis. We will keep that setting for those customers who
request it.
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Fixes

[ 98141018 ] RMS Web Run Batch button and RMS Agent doesn't export records that were modified
after the Track Exports? date/time.
[ 107414632 ] Add Modified field to the report template fields table for the viewBills (Shipping
Instructions) dataset. This will now enable the exporting of shipping instructions that were already
exported, but a correction updated the record in the meantime.
[ 107330384 ] RMSAgent: Track Exports feature incorrectly ignores Quick, Advanced and Custom
Expression filters.
[ 106491538 ] Manual deactivation of railcar - archive sightings option is failing when a duplicate record
already exists in the archive. Added better error logging to detect other issues.

RMS 6.00.34 released 10/12/2015

Improvements

[ 104920298 ] Changed dashboard dataset to show waybills that have been imported yesterday and
current day. This will help us better identify waybill download problems.

Fixes

[ 102425410 ] Certain waybills  raise so many ExtremeTranslator warnings, that it crashed the import
by trying to pass too large of a string to the error log table.
[ 102424528 ] Large imports are timing out.
[ 100861418 ] Sightings archived by manual railcar deactivation process cannot be restored and are
missing RR field values.
[ 104745444 ] Railcar Utilization reports: Extended LE status not getting reported properly
[ 82527530 ] Railcar Utilization reports: if permanent railcars are deactivated and returned to temporary
status and system cars pool, the reports will incorrectly ignore them.

PLEASE NOTE: RAILCAR UTILIZATION REPORTS NOW RETRIEVE ALL RAILCARS (INSTEAD OF
JUST PERMANENT RAILCARS). IF YOU ARE TRACKING A LARGE NUMBER OF SYSTEM
RAILCARS (USED FOR JUST ONE SHIPMENT AND THEN RETURNED TO THE RAILROAD OR
SHIPPER), THE RAILCAR UTILIZATION REPORTS WILL TAKE MUCH LONGER TO RUN THAN
BEFORE. IF YOU WISH TO EXCLUDE CERTAIN RAILCARS (I.E. TEMPORARY RAILCARS), YOU
MUST INCLUDE AN ADVANCED FILTER: POOL <> 'SYSTEM CARS'. IT IS ALSO RECOMMENDED
TO NEVER ASSIGN TEMPORARY RAILCARS TO A POOL OTHER THAN THE SYSTEM CARS
POOL. WHEN YOU DEACTIVATE RAILCARS THAT WERE OWNED, LEASED OR ASSIGNED BY A
RAILROAD, IT IS RECOMMENDED THAT YOU USE THE NEW DEACTIVATE OPTIONS: CHANGE
FLEET STATUS TO TEMPORARY; RETURN RAILCAR TO SYSTEM CARS POOL; REMOVE ANY
INCOMPLETE CYCLES AND ARCHIVE THE RELATED SIGHTINGS. THIS WILL PUT THE RAILCAR
IN A STATE WHERE IT CAN BE AUTOMATICALLY REACTIVATED IF A SHIPPING INSTRUCTION
IS IMPORTED FOR IT.

RMS 6.00.33 released 7/08/2015

Improvements

[ 87579492 ] Increase user password control

To make RMS more compliant with our larger customers:

· Force user to change password on first login
· Force user to change password in a certain number of days. The number of days is configurable
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by Railcar Tracking Company support upon request. The default is 90 days.
· Require user to change the password to something different.
· Give the user the ability to change their password whenever they want. This will reset the

expiration period.
· The password validation policy will be a minimum of 8 characters and maximum of 12 characters.

It requires at three out of the four types of characters: one upper case, one lower case, one
number, one special character (! @ # $ % ^ & *).

· Add label on the login window indicating the number of days before their password expires.

[ 82573690 ] Data Management > EDI File Transfer: Add "CSV shipping instruction".

· RMS now can download and import shipping instruction records in CSV format.

[ 82527840 ] Create Cycles: Complete cycle when a W sighting event immediately follows a Z event
when the load / empty status remains the same.

· This feature is an improvement upon an older, similar feature. It is more robust and less prone to
cause problems when the data is not complete or accurate. It enables RMS to properly end and
start another cycle when a railcar is reloaded.

[ 84221432 ] Import Data: Add Import Property option to import all sightings regardless of whether the
railcar is active or exists.

[ 82527972 ] Custom Report: Track Exports? option: add option to include records with a Modified date
that is later than the saved date.

[ 85570210 ] Daily Reports > Inbound Inventory report implemented specifically for a customer. The
functionality has yet to be improved so that it is usable for for other customers.

Fixes

[ 86756472 ] Report Tracking for reports based on the viewSightings dataset was not working. Users
may now track which sighting records have been exported to ensure no duplicate records are
exported.

[ 95758274 ] The process that relates shipping instructions to cycle records was timing out for some
larger customers.

RMS 6.00.32 released 3/17/2015

Fixes

[ 81988894 ] Output Batch Reports: if one report in a multiple report batch fails, then the following
reports don't get emailed properly

[ 82522708 ] Home window: Refresh button progress indicator not working

[ 84940872 ] Import Data: Missing City and State in Sighting data file prevents following records from
getting imported

[ 83358816 ] RMSAgent Installer: EDIMapFiles folder not installed

[ 85314530 ] Import Data: for Steelroads Dynamic Trace: must accommodate newly discovered



What's New 16

© 1997 - 2019  Railcar Tracking Company a Division of Savage Services Corp.

business rule of 10,000 railcar limit; also added an option to configure the number of railcar sightings
that are requested - this is designed to overcome timeout issues with large fleets.

[ 85549174 ] Import Data: in some situations, incorrect years are inserted for sighting event dates
and ETAs

[ 86728700 ] Output Batch Reports: when an ad hoc filter is applied to a custom report and then that
custom report is exported using the Output Batch Reports scheduled activity, the ad hoc filter was
incorrectly used.

RMS 6.00.31 released 10/31/2014

Improvements

29527: Import Properties / Create Cycles: add option to not deactivate Temporary railcars upon
completion of the cycle
29550: Import Properties / Create Cycles: add option to not archive unnecessary sightings for
Temporary railcars
29551: Home window: add new Archived Sightings tab window
29553: When a railcar is deactivated manually, ask user if they want to change to temp and truncate
the incomplete cycle
29561: RMS DB Update: New Label in viewDashboard
29457: Add validation and billing indicator to cycle screen

Fixes

29554: RMS Microsoft Partner Testing > Failed Binary "Product Name" Property
29555: Error log record lables (i.e. "ERROR: " "INFO:" "WARNING:" "STATISTIC:") are not formed
properly
29556: Track Report and CSV Exports: if writing file to a designated folder fails,
T_REPORT_NEW.ImportedTrackDttm incremented
29557: Reference Values: ProxyAddressPort must be able to handle NULL or blank/zero length
strings

RMS 6.00.30 released 9/26/2014

Fixes

29495: Microsoft Certification testing failures - mainly needed better company identification on DLL
files.
29542: Need to handle "No Events" statement in sighting data files. Add CLM_IGNORE %No
Events%:

RMS 6.00.29 released 9/17/2014

Fixes

29543: Data Management > Reference Values: Emailed Report Supplemental Message Error
29545: Custom Report > CSV Export from report viewer raises error when there is no Output record
for the report
29546: Custom Report > Output > CSV Export: Enclose each field in double quotes is excluding
fields
29547: Custom Reports > CSV Export from Report Viewer creates Output without Column Titles
(Headers)
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29548: Custom Reports > CSV Export from Report Viewer Does Not Consistently Take Settings
from CSV Output
29549: Custom Reports >  CSV Export option from Report Viewer on MailTo button click Unable to
send mail to multiple recipients
29520: Custom Report: Output tab window: Output drop down list box: error raised when selecting
blank entry the second time
29529: Custom Report: Output record: Each change to an existing output record increases the
number of back slashes before the file name

RMS 6.00.28 released 9/10/2014

Improvements

29524: Custom Reports: Output: CSV: option to enclose every field value in double quotes
29525: CSV file export default format change
29532: Custom Report: Track Exports? checkbox and text box: Move to top of Filter tab window

Fixes

29517: Custom Report: Output tab window: File Path and Name displays entry when no output
record is selected
29523: Output Batch Reports: Selected Field for Custom Report should not be included on CSV
export
29518: Custom Report: Output window: output record gets unselected, but control entries remain
after Save/Preview the report
29519: Run Batch button: Track Exports: T_REPORT_NEW.ImportedTrackDttm is not updated
properly - milliseconds not included
29521: Data Management > Parties: Delete - raises error: "The party cannot be deleted since it has
children repair records"
29538: Report: CSV Export: RailcarNumber field values show decimal places
29539: Custom Report: Track Exports option: when the Track Exports? check box is checked and
there is no entry in the text box, error
29526: Custom Report: Output tab: CSV: Exclude column titles (headers) checkbox doesn't display
when re-selected

RMS 6.00.27 released 8/18/2014

Improvements

29509: Add/Edit Railcar window: add "5 Year Test", "10 Year Test", "Stub Sill Insp." fields
29510: RMS Agent installation folder: change back to "RMSAgent"
29511: RMSAgent config file: CommandTimeout key value should default to 1800
29512: RMSAgent config file: Default Technician Email Address in the RMSAgent config file should
be support@railcartracking.com
29506: New view: Create a new Custom Report dataset: viewDashboard
29507: Output Batch Report: add User Reference that enables user to enter a statement in the email
message
29515: Add Imported field to the Add/Edit Sighting window
29516: Add Imported field to the Add/Edit Shipping Instruction window

Fixes

29508: Import Data: failed login for railroad FTP server does not raise/log an ERROR: message.
29514: Add UserField1 and UserField2 to custom report dataset Railcars and Lease Information



What's New 18

© 1997 - 2019  Railcar Tracking Company a Division of Savage Services Corp.

RMS 6.00.26 released 7/29/2014

29500: Home window: Railcar Text Box search must consider the Active Inactive option buttons
29501: Home window: when two railcars have different initials, but same number retrieval of data is
faulty
29503: Railcar Initial drop down list is sorted in descending order
29498: Output Batch Reports: Output record - New File with Time file write option
29504: Add New Railcar window: Inactive and Temporary check box not getting cleared from prior
added railcar
29505: Home window: Add New Sighting link raises error when the railcar entry in the railcar text box
doesn't exist in the database
29502: Home window: lower case and upper case railcar intials are separated in the drop down list

RMS 6.00.25 released 7/11/2014

29494: Home window: Customer wants to have the copy and paste of railcar initial and number
29496: Add/Edit Sighting window does not allow saving of record that has identical entries except for
time of day.
29497: Edit Sighting window: Save/New raises "Another user updated the record... " error
29499: Edit Sighting window: can't change Event Date
29489: RMS must handle temporary railcar reloads when railroad reports an empty release sighting
and load waybill  on same day
29491: Data Management > Trip Plans window: Search feature is not filtering all results
29492: Data Management > Trip Plans > Edit / View window: the Back to Trip Plans button should
return focus to the Trip Plans window
29493: Data Management > OD Pairs window: Search feature is not filtering properly

RMS 6.00.24 released 6/26/2014

29488: Import Data: Add STATISTIC message with the number of records that were deleted
because the Event = 3 (ETA)
29490: Output Batch Reports: Additional filter expressions getting added to existing report filters;
Fixed rare issue with extra filter expressions being added to a custom report when emailed by the
Output Batch Reports RMSAgent process.
29485: Home screen: Railcar Number must keep the initial value selected after refresh when Railcar
Initial is the same as prior search
29487: Home Screen: The Refresh button on the Home screen maintains focus after tabbing out of
Railcar Number combo box.

RMS 6.00.23 released 6/2/2014

29479: Users can now search by railcar Status on the Railcars View/Add/Update screen.
29480: The Import Data process now accommodates CLM records that do not have a value for the
Railroad field.
29482: Changed RMSAgent.exe.config file defaults to make it more fault tolerant.
29483: Sightings with Event = '3' must be excluded from import
29484: Added a new keyword to the CLM_IGNORE table to improve CLM imports.
29478: Clicking the Back button when a user views or edits a cycle record no longer raises an error.
29477: Excel export from the report viewer in Firefox now functions properly.

RMS 6.00.22 released 5/9/2014
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29475: Add "Save & New" and "Save & New Similar" buttons / functionality to the Add/Edit Sightings
window
29476: Fixed EDI File Transfer process to selectively download files by naming convention.
29474: Users can now add a Station Alias record that has the same city name as the existing Station
record city name.

RMS 6.00.21 released 5/2/2014

29461: RMS now raises an error message if the Steelroads login fails.
29462: RMS now raises an error when the Steelroads Trace List in the Reference Values does not
match the trace list stored in the Steelroads account.
29465: Improved sighting data import to ignore text file lines that match the ignore table entries.
29466: Implemented code to validate dates based on regional settings.
29467: Improved the Trip Cycle Segment report:

1) Segment filter records may only be deleted if used by a report other than the default report.
2) The segment filter record may be deleted if it is only being used by the default report
3) When the default report is viewed and there is no segment filter record, the QuickFilter page
displays blank controls.

29469: Reference Values now accepts multiple technician email addresses.
29458: All QuickFilter screens allow clearing and typing in the date fields.
29459: Station entries are now optional in the Management Reports > Trip Cycle Segment.
29470: Shipping Instruction records with SenderCode of more than four characters is now processed
properly.
29471: Fixed issue with fields calculated from the difference of two dates displaying as a date on a
report. The result now displays as an integer.
29468: Missing BOL Time prevents import of shipping instruction record. Improved import of
Shipping Instruction record. If missing BOL Time, the record is now imported and a default time is
inputted.
16833: procSaveShipment: user supplemental entries should not get overwritten by imported
corrected waybill. Shipping instructions user supplemental entries no longer get overwritten by
imported corrected shipping instructions.
24854: Group footer labels overlap for third group. Group footer labels no longer overlap for third
group on custom reports.
29463: procProcessShipments is not handling duplicates properly. Database process for importing
shipping instruction records no longer raises errors when duplicate shipping instructions are
received.
29464: EDI File Transfer incorrect user name or password error needed. Error now raised if the
incorrect username and/or password is entered into an EDI File Transfer.
29472: FTP download process doesn't raise error when host address is faulty. Error now raised
when an invalid FTP address is input into an EDI File Transfer.

RMS 6.00.20 released 3/28/2014

29429: RMSAgent: Output Batch Report: emailed report: if there is no data records to display on the
report, include a message. Now RMS creates a message informing recipients of a scheduled report
if there are no new records to attach to the report instead of sending a report that is empty.
29441: If user enters the incorrect credentials and the account gets locked, the interface should
notify them of this. Users now get an error if their accounts get locked from trying to log in too many
times.
29442: Administrator must be able to reset a user's password. Administrators now have the ability to
reset user passwords.
29455: "License expires in X days"  displayed on dialog box when user clicks the Log In button on
Login page. Users get a message with a countdown to the expiration of their current license when it
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is within 30 days of expiration.
29460: Encryption of existing passwords on update. Existing user passwords are encrypted with the
update to 6.00.20.
29427: Passwords must be encrypted. Passwords are encrypted in the database.
29430: Reports: sorting of fields with an alias that is different than the field name. Fixed rare error
when sorting fields with an alias that is different than the field name.
29431: CSV export from report viewer in FireFox isn't opening in Excel properly. Fixed CSV export
from report viewer in Firefox so that it opens in Excel properly.
29432: Error raised when Task Scheduler triggers RMSAgent.exe, but there are no scheduled
activities. RMSAgent.exe no longer raises an error when the Task Scheduler triggers it when there
are no scheduled activities.
29242: Update to sighting record not reflected on Last Sighting reports. Last Sightings reports now
reflect the most recent sighting events regardless if they are automatically imported or manually
entered into the system.

RMS 6.00.19 released 2/21/2014

29412: Custom Reports: Cycle filter issue. Fixed Custom Report Quick Filter for Cycle dataset.
When 'Complete' is checked in the Quick Filter when a user clicks Save and Preview Report, it is
now saved as the default.
29413: Custom Reports: Sighting filter issue. Fixed New Custom Report quick filter to keep the
Temporary fleet status box checked after saving and previewing the report.
29414: Custom Reports: reports based on Cycle dataset: the QuickFilter filters are not saved
properly. Custom Reports based on Cycle dataset now save QuickFilter filters properly.
29415: Custom Reports: Demurrage Railroad dataset - based reports: QuickFilter selections not
getting saved properly. Custom Reports QuickFilter selections based on the Demurrage Railroad
dataset are now saving properly.
29416: Custom Reports: Demurrage Proprietary dataset - based reports: QuickFilter settings not
getting saved properly. Custom Reports QuickFilter settings based on Demurrage Proprietary
dataset are now saving properly.
29417: Reports saved to CSV standard - record delimiter must be CR/LF. Reports exporting to CSV
standard now delimits records with a carriage return and line feed (CRLF).
29418: Data Management > Reference Values> Flat File Directory: Browse screen raises unhandled
exception error. Fixed issue where a Visual Studio dialog box would open in the task bar when
editing the Flat File Directory reference value by clicking Browse and choosing the folder.
29419: Data Management > Cycles: QuickFilter is not selecting records properly. Fixed the Data
Management > Cycles QuickFilter. The QuickFilter now selects records properly.
29420: Various Cycle QuickFilters include an extra field name. Fixed issue where using a QuickFilter
on Custom Reports based off of the Cycle dataset would include an extra partial filter that prevents
the report from returning records.
29421: Custom Reports: clone of Round Trip by Route Summary doesn't store date filters properly.
Reports cloned from Round Trip by Route Summary now stores date filters properly.
29422: QuickFilter for reports based on the Cycles dataset: labeled cycle filter not working properly.
Fixed issue where the labeled cycle filter was not working properly for reports based on the Cycles
dataset. Removed the Label='True'/'False' part of the filter.
29423: Re-arrange controls on the Home screen. Re-arranged controls on the Home screen for
greater usability.
29424: Custom Reports: Demurrage Railroad dataset - based reports: QuickFilter settings not
getting saved properly. Custom Reports QuickFilter settings based on Demurrage Railroad dataset
are now saving properly.
29425: RMSAgent raises error: The number of members in the conceptual type
'RMSDataModel.T_REPORT_FILTER' does not match. Fixed RMSAgent issue where it raised an
error about tables not matching.
29426: RMSAgent: Output Batch Reports: CSV file is generated and emailed successfully, but no
data. Fixed CSV file report outputs. The CSV format now outputs files with data.
29408: Custom Reports: Quick Filter doesn't get saved properly
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RMS 6.00.18 released 1/31/2014

29397: Home: Problem Logs tab screen data grid record count should display. Records now display
under data grid on the Problem Logs tab on the Home Screen.
29407: Import Data - EDI File Transfer batch process must be able to selectively download files by
naming convention. RMS data import improved to selectively download files based on naming
convention of files.
29398: Home: Shipping Instructions: Add new shipping instruction screen: railcar initial and number
should default to railcar selected. Add New Shipping Instruction screen now automatically
popoulates the Railcar Initial and Number controls with the currently selected railcar. If no railcar is
selected, the Railcar Initial and Number controls are blank.
29399: Add New Problem Log screen: Railcar Initial and Number controls should default to railcar
selected on Home screen. Add New Problem Log screen now automatically populates the Railcar
Initial and Number controls with the currently selected railcar. If no railcar is selected, then the
controls are blank.
29400: Data Management>Railcars>View Add Update screen: Change label above the Search text
box. Changed the label above the Search text box in the Data Management > Railcars >
View/Add/Update screen.
29401: Data Management>Scheduler: Add New Schedule screen: Hours, Minutes, AM/PM default to
current date/time. Add New Schedule link in the Scheduler now automatically populates with the
current system data and time.
29402: Data Management > Railcars > View/Add/Update Railcars menu rename. Removed the word
"Railcars" from Data Management > Railcars > View/Add/Update Railcars link.
29403: Add New Shipping Instruction: not recognizing a railcar. Fixed Add New Shipping Instruction
to first railcar selected by default.
29404: Home: Shipping Instruction: Add New Shipping Instruction: Save & New button not working
properly. Fixed Save & New Button in Add New Shipping Instruction tab of the Home screen.
29405: Import Data & Created Cycles batch process: duplicate sighting records causing RMSAgent
to log "ERROR". Fixed RMSAgent duplicate sighting records error message.
29406: Import Data batch process: FTP error when the folder has no files. Fixed RMSAgent to not
log an error when the FTP folder has no files.
29410: RMS Web application shows 6.00.16 for version on Help > About RMS screen. Fixed RMS
Web Application version to reflect current version (6.00.18).
29411: RMSAgent shows 6.00.14 in Control Panel\Programs\Programs and Features. RMSAgent
now reflects current version (6.00.18) in Control Panel.
29345: Import Data: Error raised when all railcars show "No New Events" from Steelroads. Fixed
Steelroads import when all railcars show "No New Events."
29391: Home: Sightings tab data grid. Fixed issue with Sightings tab on the Home screen. When a
user viewed the second page of the Sightings data for a railcar and changed the railcar to view
another set of data, the screen would show the second page of the new railcar. This is now fixed to
refresh to the first page of the Sighting data for the new railcar.
29393: ShippingManager.ImportBOL raises a timeout error. Fixed database scripts to move
Shipping Instructions between tables successfully.
29394: Home: Cycle, Shipping Instructions, Problem Logs tab screen data grids don't have a vertical
scroll bar. Restored a vertical scroll bar on the Cycle, Shipping Instructions, and Problem Logs tabs
of the Home screen.
29395: Home: Add New Shipping Instruction screen controls are misaligned. Fixed the alignment of
the controls when adding new shipping instructions from the Add New Shipping Instruction link from
the Home screen.
29396: Home: Add New Shipping Instruction screen: cannot insert new record. Fixed issue with Add
New Shipping Instruction not responding when clicking on the Save, Save & New, and Save & New
Similar buttons.
29409: Import Data batch process: shipping instructions are records as imported successfully when
they are not. Fixed statistical logging issue with RMSAgent where shipping instructions were being
recorded as successfully imported when they were not.
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RMS 6.00.17 released 1/10/2014

28374: Import Data process must be able to import sighting data files with header and trailer
records. Fixed RMS Import Data process to import sighting data files with header and trailer records.
28375: Data Management > Railcar view/add/update screen: add button that changes a railcar's
fleet status (i.e. Temporary or Permanent). Users can now change multiple railcars to Permanent
status from the Railcar > View/Add/Update screen.
28183: Home screen: after the Refresh button is clicked, move focus to Railcar Initial combo box.
RMS focuses on the Railcar Initial combo box after clicking the Refresh button on the Home screen.
28907: Migration Script 6.00.16 to 6.00.17 - Data.sql: does not update the database version. Fixed
the database migration script to update the database version.
29052: "000000" for CLM Format H file for ETA month, day, hour (characters 69 - 74) causes fatal
error. Fixed import business rules for sighting data coming from certain railroads.
27773: Add New Station Alias popup window: No message to user indicating that the alias already
exists when Save clicked. Added a new Station Alias popup window indicating whether or not the
alias the user is trying to enter already exists in the database.
27781: Add / Edit Railcar screens: no error message is provided when user attempts to enter a
duplicate railcar. RMS now provides an error message when trying to enter a duplicate railcar on the
Add/Edit Railcar screens.
27945: Backup Database Error: No message returns from CheckDB procedure. Fixed database
backup procedures.
25379: Daily Reports>Demurrage - Railroad in Progress: Advanced Filter: When Label field selected
Value list is wrong. Fixed Value drop down list when changing an advanced filter in Daily Reports >
Demurrage - Railroad in Progress from the IsValid field to the Label field.
25592: Management Reports > Demurrage Proprietary by Party: Advanced Filter: Field CycleLabel is
selected, Value control not correct. Fixed Management Reports > Demurrage Proprietary by Party
Advanced Filter. RMS now brings up the correct value control when editing an advanced filter and
changing the field from ContractNum to CycleLabel.

RMS 6.00.16 released 12/29/2013

25131: Data Management>Railcars>View/Add screen: Search Railcars button full text search
Railcar, Pool, Lease, Sublease, Report Group. The Search Railcars button now applies the search
keyword to the Railcar, Pool, Lease, Sublease, and Report Group columns.
26619: Custom Reports: Output: add option for CSV to exclude column titles (headers). Added
option Custom Reports output to exclude column titles (headers) in CSV format.
26915: Management Reports>Demurrage - Proprietary report Quick Filter: allow user to clear dates.
User can now clear dates from the Quick Filter in Management Reports > Demurrage - Proprietary
report.
27127: RMS agent and web application version must be updated to 6.00.16 for release. RMS Agent
and RMS Web Application updated to version 6.00.16.
27170: Add scroll to sightings tab screen on the Home screen. Added scroll to sightings tab on the
Home screen.
27171: Add Save & New Similar button to Clone a shipping instruction. Added "Save & New" and
"Save & New Similar" buttons to the Add New Shipping Instruction dialogue box.
27263: Home & Event Logs screen: Separate the Railcar combo box into two: one for Railcar Initial
and one for Railcar Number. Separated Railcar Initial and Railcar Number on the Home screen for
faster load times.
27606: Home screen & Event Logs screen: Railcar Initial / Number combo boxes lists must be
sorted ascending. Sorted Railcar Initial and Railcar Number in ascending order on the Home screen.
25727: Check to see if space below the report title and column titles (where filters are displayed) can
be dynamically sized. Space between report title and column headers dynamically increases with
large / long filters.
27128: 6.00.15 release has strange data displaying when a customer's custom report is viewed.
Fixed issue with certain custom reports showing incorrect data after clicking View Report from the
Quick Filter screen.
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26960: Technician is not notified if errors are encountered in several GetData processes. Technician
is now notified if errors are encountered in several GetData processes.
26914: Custom Report: page footer looks bigger than .67 inches. Reduced size of footer on new
custom reports to .67 inches.
26327: Q_LAST_SIGHTINGS_SUB.ResponsiblePartyID field incorrect expression. Fixed issue with
RMS database field to have it return the proper value.
26579: Help > About RMS menu screen is not displaying the correct web application version. Fixed
About RMS menu screen to display the current web application version.
27607: Help > Event Logs screen: Railcar No combo box is too narrow. Widened the Railcar
Number combo box to display all six characters.
27609: Help > Event Logs screen: Railcar number combo box not requeried when Active / Inactive
option buttons selected. Fixed Event Logs screen to refresh the Railcar Number combo box when
toggling between Active and Inactive railcars.
27651: Home and Event Logs Railcar Number combo box lists do not take into consideration the
Active / Inactive selection. Fixed Railcar Number combo box to refresh according to the Active /
Inactive railcar selection.
27831: Home screen: Railcar Number combo box: when focus, the whole entry should be
highlighted. Fixed Railcar Number combo box on the Home screen to highlight the whole entry to
overwrite the existing railcar number by manual entry of the desired railcar number.
27480: Alter table statement should be removed from Data script and added to Schema script. Fixed
database scripts.
26006: Error log file is emailed to technician when "Error:" logs logged earlier in the day. Fixed issue
with error logs emailing to technician when a Warning log is created. Error logs only email to
technician when there is an Error log created.
25382: Daily Reports>Demurrage: Advanced Filter: Invalid column name error STCCDesc field is
misspelled. Fixed issue with Daily Reports > Demurrage advanced filter when using STCCDesc
field.
25088: No progress indicated when Edit link clicked on Sightings data grid on Home screen. Added
progress indicator when Edit link is clicked on the Sightings data grid on the Home screen.
25089: No Back button on Cycle record when displayed from Data Management>Cycles. Added a
Back button on a cycle record when displayed from Data Management > Cycles.
25093: Data Management>Cycles: Advanced Filter: Mileage field the Value text box should not be a
drop down. Fixed an issue with the advanced filter on the Data Management > Cycles page. When
using the "Between" operator on the Mileage field, there are now two text boxes instead of drop
down menus.
25426: Management Reports>Bad Order Activity by Railroad: has uneeded Custom filter. Removed
unnecessary customer expression filter from Management Reports > Bad Order Activity by Railroad
report.
25381: Daily Reports>Demurrage: Advanced Filter: RlseRR field filter has no value when report is
run. Corrected filter summary output on Daily Reports > Demurrage when using the advanced filter
on the RlseRR field.
25588: Management Reports > Bad Order by Duration: Advanced Filter screen: when Destination
field is chosen, Value control not correct. Fixed issue with the advanced filter screen of Management
Reports > Bad Order by Duration. When choosing Destination field a drop-down list that contains all
the Station records is created.
25380: Daily Reports>Demurrage - Railroad in Progress: Advanced Filter: can't filter by Railcar field.
Fixed issue with Daily Reports > Demurrage - Railroad in Progress report advanced filter. User can
now filter by the railcar field by entering a value in a text box.

RMS 6.00.15 Release

· Management Reports > Trip Cycles - Round Trip reports. Increased time before timeout error is
raised when running unfiltered Trip Cycles - Round Trip reports in Management Reports.

· Custom Reports: Run Batch button doesn't work. Fixed issue with the Run Batch button in Custom
Reports. Users can now press the Run Batch button in Custom Reports to perform a one-time
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output of the report batch.
· Backup Database scheduled process raises error: Column name or number of supplied values

does not match table definition. Fixed RMS database backup in SQL Server 2012.
· Tracking Exports feature is not limiting record output. Tracking Exports feature has been fixed to

limit record output.
· Custom Reports: Editing an Advanced Filter raises error. Fixed error raised by editing an

Advanced Filter.
· Management Reports > Bad Order by Duration: Quick Filter: Date range cannot be changed.

Fixed issue with changing default date range on the Quick Filter tab of reports.

· Report page footer margins are too big after cloning. Reduced page footer of reports cloned from
Daily Reports > Inbound Railcars to proper size.

RMS 6.00.14 released 2013-11-01

Improvements
· Hosted and Web Access: Use RMS on a tablet at home, from your laptop on the road and of

course in the office. The application will now be hosted for you. No more software updates or data
backups to manage.

· Configurable User Access Control that limits access and type of access to parts of the application
making RMS more deployable throughout different departments within the enterprise.

· Report Group: Quickly and easily add many railcars to a group with which you may easily filter
Daily Reports. This is helpful when you have a handful of hot shipments that you want to watch
closely for a while.

· Sub Lease Tracking: Create a sub lease record and add railcars quickly and easily to it. It will be
available for reports soon.

· Error logs may be filtered by whether they are Errors, Warnings, Informational, or Statistical
making it easier to troubleshoot.

· Sort data on all data grids in the entire application increasing ease of use and more effective
analysis of data.

· Copy data on all data grids and paste to an Excel spreadsheet for quick analysis of data.
· Easily duplicate Trip Plans including all of their events.
· View, Edit and Add Problem Logs on the Home window for a selected railcar increasing ease of

use and greater efficiency.

2 Getting Started

Open Microsoft Internet Explorer 8 or higher or use your tablet

Use RMS on a tablet at home, from your laptop on the road and of course in the office.  The appication
will now be hosteed for you.  No more software updates or data backups to manage.

RMS has been tested and optimized for use with Microsoft Internet Explorer version 8 or higher. If you
do not have Internet Explorer, open your existing web browser, go to your favorite search engine and
type, "download internet explorer". You will find many links pointing you to a free download of this
browser. RMS works well with Chrome, Firefox and Safari.
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Log on to Railcar Management System (RMS)

You will be given a URL or address to enter into the Internet address text box. In this example, the
address is "myserver.hyperfive.com/rms". You can simply copy and paste or type that address into
the browser address text box and press the Enter key on your keyboard or click the arrow on the right
side of the address text box. The "http://" will be added automatically.

The Login window will appear. Enter the Username and Password that you have been provided in the
corresponding text boxes and click the Log In button or press the Enter key on your keyboard.
Passwords are encrypted in the database for your protection.

If this the first time you are logging in to RMS, the first time that you are logging into to 6.00.34 or
higher version of RMS, or your password has expired, you will be prompted to change your password.
Enter your old password, then enter the new password and confirm it in the provided text boxes. After
this, RMS can be configured to expire passwords every X days. Contact support to set the number of
days. The default is 36,500 (100 years).

Click the OK button
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You will be returned to the main Login window and prompted that the password has been changed
successfully.

Enter your new password and click the Log In button.

NOTE:  If incorrect username and password is entered too many times (5), this will lock your account.
A locked account message will appear.  To unlock, contact your administrator to reset your account.

Navigating through RMS

This user documentation has been organized in a similar way as the application.

Data Management - windows that enable adding, updating and deleting of data records.
Daily Reports - reports based mainly on the last sighting of each active railcar.
Management Reports - report based mainly on the trip cycle records that summarize a shipment trip
from origin to destination. They are mainly historical in nature.
Custom Reports - reports, similar to Daily and Management Reports, created by users where fields
may be added / removed, filters may be saved, and automatic delivery may be configured.

You may open several windows at once. The easiest way to do this is to right click when the mouse
pointer is hovering over a menue and choose "Open in new tab". This way you can keep windows that
you use regularly open and just click the tab to go back to it without having to wait for the page to
refresh. Sometimes you will need to refresh a window if it depends on data that was just entered in
another window. To refresh a window, simply left click on its menu again.

Add railcars

If you will be managing railcars that you own or lease, you will want to be sure to get them entered into
RMS before you go any further. If you have been assigned railcars that will be only in your company's
control for a specified period of time, you will also want to get them entered into RMS now. Follow this
link to get instructions on how to get Railcars entered into RMS.

If you are going to be tracking shipments where the railcar is borrowed for just that particular shipment,
then you do not need to enter railcars into RMS. However, you will need to get shipping instructions
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entered or imported into RMS in order to track these type of shipments.

Get data

If data feeds have not already been configured for you, here is more information on how to enter and/or
import Shipping Instructions and Sightings into RMS.

RMS imports data into a database that is dedicated soley to your company. TODO: Link to explanation
of how often to import data, explanation of how it may be out of sync with railroad websites, Steelroads
implications, etc.

Find out where railcars are and have been

Once you have railcar movement data coming into RMS, you will naturally want to see where your
railcars are and have been. The fastest access to this information is through the Home screen. Click
on the Home menu.

1. Select a railcar by entering entering or selecting the railcar initial using the Railcar Initial Field, then
enter or selecting the railcar number in the Number field.

NOTE:  You may also enter or paste the railcar initial and number in the text box below the two fields
then press Enter for faster retrieval of data. It doesn't matter if there is not a space between the initial
and number. It also doesn't matter if there is a tab character between the initial and number, which
would be present if you copied the initial and number from a spreadsheet where intitial is in one column
and number in another.

2. Select whether the railcar is active or inactive, then select the begin and end dates.

3. When you're done, click Refresh.

View Daily Reports

Of course, you will want to share all of this good information. Reports provide an easy to read and well
presented format for this information.
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You will see a list of reports. For a description of each report, follow this link: Daily Reports  Daily
Reports are based on the last reported sighting event for each railcar, so you can begin using them
immediately after the first import of data.  Most of the Daily Reports only require one day's worth of
railcar sightings before they provide meaningful information.

If you selected to received sigthtings that are CLM Format H, an ETA may already be included with
each record. You may wish to supplement these ETA's with ones generated by RMS because ETA's
are not always included on the CLM Format H.   TODO: Link to explanation of Update Trip Plans

Management Reports will be useful a bit later...

Management Reports are mostly based on the Cycle records. It will take several weeks before RMS
will be able to create valid cycle records for your shipments. These reports will become more and more
meaningful after a month or two, when each railcar has had a chance to start and complete a cycle. A
cycle in RMS is a one way trip from origin to destination. A round trip cycle is a loaded cycle and the
return empty cycle put together. 

Several things required to make these reports more helpful:

TODO: Route network - explain Update Trip Plans

TODO: Demurrage / Detention Proprietary and Railroad explain

3 How Do I

3.1 Data Imports

3.1.1 Get sighting data from Steelroads

Follow these step by step instructions to get sighting (CLM) data from your Steelroads account into
RMS.

1. Click the Data Management > Import Properties menu.

2. Click the Sighting data tab and place a check in the Steelroads check box.

3. From the Select file format text box, select CLM Format H.

4. There are 2 option buttons below the Steelroads checkbox, select the second one labeled, "New
events for privates and last event for temps" and click the Save button.
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The window will look like this:

If you do not have a permanent (owned or leased) fleet, go to Step 11.

5. Open another internet browser window and login to your Steelroads account.

6. Click on the Track and Trace link.

7. Click on the Create Equipment Trace link.

8. Copy and paste a list of your private railcars into the text box labeled 1.

Note: You may only put 1,000 or less railcars in a trace list. If you have more than 1,000 private
railcars, you must create multiple trace lists.

Tip: From the RMS Home window, open a Daily Reports > Last Sighting by Railcar report, export it to
CSV, copy the list of railcars from there.

9. Click the Save Trace button. It is recommend to name the trace list RMSONLY and to enter into the
Trace Description: This is for use by RMS only. Do not use!!! If you have more than one
trace list, name them RMSONLY1, RMSONLY2, etc.

10. Select the Private Trace option and click the OK button. You may logout of Steelroads.

11. Click on the Data Management > Reference Values menu, click the Edit link adjacent to the
Steelroads Login label and type in your Steelroads account user name (case sensitive) in the Value
text box; click the Save button.

12. Click the Edit link adjacent to the Steelroads Password label and type in your Steelroads account
password (case sensitive) in the Value text box; click the Save button.

If you do not have a permanet (i.e. owned or leased), go to Step 15.

14. Click the Edit link next to the Steelroads Trace List(s) label and type in the Steelroads trace list(s)
(case sensitive) established for use by RMS only in the Value text box; separate multiple entries by a
semi-colon; click the Save button.

Your entries will look like this:
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15. Your setup is complete. During the next scheduled import, RMS will get the new events for
permanent railcars and the last event for temporary railcars (i.e. free runners or system cars).

Note: The first time RMS gets data from a saved Steelroads trace list, it will get the last 4 days worth of
sightings. If a railcar has not moved (i.e. been reported in a sighting record) in the last 4 days, you will
not see a sighting for that railcar in RMS until the first time it moves since you established the
Steelroads trace list.

It is important that no one or no other system runs the RMSONLY Steelroads trace list. The trace list is
like a mailbox and each time it is run, the mailbox is emptied.

3.2 Email a report automatically

Please refer to the Custom Reports Setting Up Automatic Delivery of Custom Reports help topic.

3.3 Scrub Data

There will be imperfections in the data that comes into RMS. Here are instructions for how to use RMS
to catch these imperfections and correct them.

Invalid cycles

What we want to do here is to catch the cycle records that have recently been completed that RMS
identifies as invalid. Please see the topic Review cycles for a complete discussion on how RMS
determines if a cycle is invalid and how you can fix the problem. Invalid cycles are most often caused
by 1) Incomplete route network information, 2) incomplete sighting data, 3) incorrect sighting data.

1. Incomplete route network information. You will find that most of the invalid cycles are not actually
invalid - it is usually RMS' inability to validate them. To give RMS the ability of validating cycles for you,
it must know about your route network. The route network is stored in the Data Management > OD
Pairs records and these records are comprised of Data Management > Stations records. You can set
RMS to automatically learn your route network by scheduling the Update Trip Plans activity in Data
Management > Scheduler. This process scans shipments for a given period (default is 60 days). It
automatically adds the station records (and industry standard aliases) for the origins, destinations and
all of the stations in between. It adds the OD Pair records as well.

If you already have Update Trip Plans scheduled and are still seeing cycles that are formed correctly,
but RMS is showing as invalid, then it is usually an issue with a station alias that is spelled in an
unexpected way. Sometimes a cycle record will show an origin as NYARD, CO. This is how the
railroad operating system abbreviates North Yard, CO, which is an industry standard abbreviation,
however it is not an abbreviation that RMS is able to create when the shipping instruction shows
DENVER, CO as the origin. In this case, RMS needs your help. When you see that the cycle record
shows an origin of NYARD, CO and you look at the Data Management > Station record of DENVER,
CO, and see that its aliases do not include NYARD, CO, you will need to add that alias.

What if an error is raised that indicates that the station alias may not be added because it already
exists for another station record? In this case, you will need to consolidate the stations. Decide what
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station you wish to keep, then select the other station and remove its aliases and then add those same
aliases to the station that you wish to keep. Delete the station that you no longer wish to keep. An error
may tell you that the station cannot be deleted because it is being used by other records such as OD
Pairs, Trip Plans, Contracts and others. If this is the case, you will need to open each of those records
and replace the station with the station that you wish to keep. Once you have done that, you may
delete the unwanted station record.

2. Incomplete sighting data. From time to time, there may be sightings that are missed due to an
outage of some sort. By reviewing the cycle record and its related sightings, you usually see that the
origin that RMS shows is actually a station that the railcar passed through on the way to its destination.
When you first start using RMS, this can happen because RMS takes the first sighting received for a
railcar to begin a cycle. In this case, you will need to add a sighting with the Released event. Make sure
that the date is the same date or very close to the actual bill of lading date shown on the shipping
instruction.

NOTE: When you make changes to the sightings that exist in a cycle, the cycle record and all following
cycle records will be deleted so that they may be recreated during the next import. When you add
sightings, RMS will not automatically delete the existing cycle. Don't worry, the next time that the
Create Cycles process is run (usually during the next import of data), RMS will notice that there are
sightings with dates that are earlier than the latest sighting in a cycle and it will delete the cycle
automatically.

NOTE: Before you add sightings, check the prior cycle to be sure the missing history doesn't exist
there. See the third cause of invalid cycles below for more explanation.

3. Incorrect sighting data. Occasionally, you may see sightings where the railcar shows the opposite
load/empty status and a much different geographical location on a different railroad quite suddenly.
This is most likely the result of a different railroad adding the railcar mistakenly to another train consist.
In this case, you may delete the sightings. The cycle and all following cycles will be deleted and during
the next import it will be recreated.

NOTE: If you would like to force RMS to recreate the cycles before the next import, you may schedule
a one-time Create Cycles Only (TODO link to instructions). Wait until you are finished correcting the
sighting history for all of the invalid cycles that you wish to work on for the day before doing this since it
may take several minutes to run. It make RMS a bit slower until it completes.

Cycles With No Billing

Another indication that there may be underlying data problems is when RMS shows that there are
cycles with no related shipping instruction. This will also be a method for you to identify data problems
with shipments that are in progress. In order for a cycle to attach to a shipping instruction, the start of
the cycle record (typically the released event) must be within a few days of the bill of lading / waybill
date, and it must have the same load/empty status. Follow these steps to find if there are cycles with
no billing:

1. Click on the Data Mgmt > Cycles menu;
2. Select the Incomplete option button;
3. Select the No Billing option button;
4. Remove the date range;
5. Click on the Quick Filter (pg. 2) tab and select Permanent from the Fleet Status text box;
6. Click OK.

This will display cycles in progress where there is no related shipping instruction. If the cycle is
indicated as Valid, then it is most likely that a shipping instruction (usually waybills are imported directly
from the rail carriers or RMS Data Services) was not received for this shipment. In this case, it is
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recommended to get a copy of the bill of lading and enter the shipping instruction manually, being
careful to enter the bill of lading date/time and number exactly as shown on the bill of lading. If there is
no bill of lading, request a copy of the waybill from the railroad that originated the shipment and enter
the shipping instruction manually, being careful to enter the waybill date and number exactly as shown
on the waybill.

The most common reason for not receiving a waybill is that the name of your company is spelled in a
way that is unexpected. Once you have received a copy of the bill of lading or waybill, notify either the
railroad (EDI department) that originated the shipment of the new spelling or notify
support@railcartracking.com of the same. In the future you will receive the waybills. If you are using
RMS Data Services, the waybill(s) can be re-transmitted upon request if you do not wish to manually
enter them.

Shipping Instructions Not Attached To Cycle

Another way to indentify data problems with shipments that are in progress is to find shipping
instructions that are not attached to a cycle. In order for a shipping instruction to attach to a cycle, its
bill of lading / waybill date, must be within a few days of the start of the cycle record (typically the
released event) and it must have the same load/empty status. Follow these steps to find if there are
shipping instructions with no cycles:

1. Click on the Data Mgmt > Shipping Instructions menu;
2. Select the Not attached to cycle option button;
3. Use a recent date range like the last 7 days or so;
4. Click the Search Shipping Instructions button.

This will display recent shipping instructions where there is no related cycle record. For each record,
look up the history of the railcar on the Home screen to better identify the problem.

If there is no sighting history at all, this most likely means the source of your shipping instructions is
different than the source of sightings and that the sighting source needs to know the spelling of your
company name that is showing on the shipping instruction. The other possible reason for not seeing
sighting history in RMS for temporary railcars (i.e. not owned or leased) is that the shipping instruction
may have been received late and so the first sighting received has an event date that is too distant
from the bill of lading date on the shipping instruction. The solution to this problem is to get the Start of
Trip option set if you are getting sighting data from RMS Data Services. This ensures that all of the
sightings back to the beginning of the current shipment are delivered. Another solution, if you are using
Steelroads as a data source and this is a temporary railcar shipment is to manually enter a sighting
with the Released event and the date/time is the same day as the bill of lading date on the shipping
instruction. On the next import, RMS will know that the sightings received are related and it will accept
them. Of course this is not an issue with railcars that are permanent in RMS - RMS will always accept
sighitngs for permanent railcars.

Sometimes there is complete and accurate sighting history for a railcar, but RMS is still unable attach
the shipping instruction. This is most often due to either a) the railcar was reloaded or b) the loaded
railcar was rejected at destination and sent back to the shipper. In both cases, there is no change in
load/empty status. This prevents RMS from creating a new cycle record that the new shipping
instruction can attach to. Look at the example history below:
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A railcar was shipped to Temple, TX. When it arrived, there was no room for the railcar, so it was
decided to ship it further to Texas City, TX. A new load bill of lading was required, thus a new load
waybill was imported with a bill of lading date of 8/10/2012. However, the load cycle that started on
7/21/2012 looked to be just continuing on to a new destination to RMS. RMS didn't create a new cycle
starting on 8/10/2012 because there was no load/empty change to trigger this to happen. In the Data
Management > Import Properties (Options tab) there is an option to have RMS start a new cycle when
a Released event is encountered regardless of load/empty status. If you have a lot of reloads, this may
be a good option for you to use, but generally it is not recommended because the load/empty change is
the most reliable way to trigger RMS to create cycles. To solve this issue manually, click on the New
button and insert a Release (or Release from Hold if that is what was used for the load event that
started the next cycle) event with a time 5 minutes earlier. Some railroads will actually report an event
like this automatically. This will make RMS separate the two cycles and enable the shipping instruction
dated 8/10/2012 to attach to the cycle with a release date of 8/10/2012. RMS will not delete and
recreate the cycles until the next scheduled import is run.

3.4 Sort data on a data grid

In order to sort the data on a data grid in RMS, follow these steps:

1. Click on the appropriate header (e.g. Event).  This will sort in ascending order.
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2. Click the header again to sort in descending order.

3.5 Copy data from a data grid

You may copy data from most of the data displayed in the RMS application. Follow the steps below to
perform this.

1. Move the cursor to where the red arrow displays on the upper left corner of the data grid shown
below. Hold the left mouse button down and drag to the location of the red arrow in the lower right
corner of the data grid show below.
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2. Open Microsoft Excel or some other application and create a new document or open an existing
document. Place the cursor in the document where you would like the data to display; click the Edit >
Paste menu of the application or click the right button of the mouse and choose Paste.

3.6 Trace railcar locations

To quickly see the latest reported location of one or more railcars, click on the Trace menu.

When the page appears, enter of paste a list of railcars into the text box labeled "Paste railcars here to
search" and then click the Trace button. NOTE: railcar initials and numbers maybe separated by
spaces, zeros or a tab character (would be present if you copied a list of initials and numbers that were
in separate columns in an Excel spreadsheet).
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You may also, instead or in addition to the list of railcars, select a Railcar Pool or Report Group from
the drop down list boxes with the respective labels on the right side of the page. If you select a Railcar
Pool without pasting or entering a list of railcars, then railcars that belong to that particular pool will be
displayed after clicking the Trace button. If a Railcar Pool or Report Group is selected along with a list
of railcars entered or pasted into the text box labeled "Paste railcars here to search", then the results
will display railcars that are BOTH present in the list as well as the Railcar Pool and Report Group. The
example shown below shows how the results display only railcars that are present in the list AND the
Railcar Pool that is selected, which is the HOPEWELL POOL.

Once the results are displayed, you can click on the column titles to sort the results in either ascending
or descending order.
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ETAs
The ETA displayed on the Trace page as well as on Daily Reports is the ETA from the railroad if it is to
final destinatoin (often the railroad will only provide the ETA to interchange if it is not the delivery
carrier). If there is no railroad ETA, then the RMS ETA will be displayed, if it is available. The
RMS ETA is based on historical shipments on the identical route. If neither the railroad nor the RMS
ETA is available, then no ETA is displayed.

Some railroads, such as Union Pacific, provide updated ETA records that provide RMS with updated
ETAs even if the railcar has not moved.

If you would like to see both the railroad and RMS ETA, you will need to create a custom report based
on the Last Sightings dataset where you can add each of these fields to the same report.

If you wish to get more detailed information about a particular railcar such as sighting history for the
last 30 days or to see the details on the waybill for the current shipment, click the railcar initial and
number, which is a hyperlink. A page that is similar to the Home page will open in a separate browser
tab window as shown below. By default, it will display the last 30 days of sighting, cycle, shipping
instruction, problem logs and archived sightings. You can change the date range and then click the
Refresh button to see more or less history.

4 Custom Reports

About Custom Reports

When you like a particular Daily Report or Management Report, but wish that you had the ability to
change what field it is grouped on, sorted by or if you wanted to be able to schedule it for automatic
delivery, then you may want to consider a Custom Report.
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Custom Reports give you the ability to:
· Add/change fields to group the data
· Add/change sorting
· Save a filter to the report
· Schedule the report for automatic delivery

A Custom Report is based on a Dataset.  A dataset is a query that retrieves a set of records that can
be used for various tracking activities. 

For specific information and steps to created a custom report see Creating Custom Reports.

4.1 Creating Custom Reports

To create a custom report, follow these step-by-step instructions:

1. Click the Custom Reports menu; click on the New Custom Report button.

2. The tabs are ordered, from left to right, to represent the steps to take when creating a new report.
Tabs 1 through 4 (Dataset, Fields, Title, Filter),  are used for creating the report, Tabs 5
through 7 (Output, Batch, Schedule) are used to setup automatic delivery.

3. Click on the tab labeled Dataset. Click on the dataset link that provides the data elements that you
are looking for. For a more detailed description of the dataset and its elements (fields), go to
Dataset descriptions.

4. Click on the tab labeled Fields. Click on a field(s), in the Fields list box, that you would like to add to
the report and then click the Select Fields button. NOTE: When the mouse pointer hovers over a
particular field in the Fields list box, a description of the field will pop up helping you decide whether it is
appropriate for your report. Once you have chosen a field, you may do several things to it:

Add a calculation or function to the Chosen Field

If you would like to show the difference between two or more fields (i.e. a calculated field), simply
modify the field name to be an expression like this:

Change the name of the field

Change the entry in the Field Alias text box. This modified name or alias will display on the report
as the title of the field.

Change the size (width) of the field

Change the entry in the Size (inch) text box. Partial inches are allowed by using a decimal.
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Summarize the field

Select a type of summarization from the Summary Type drop down box. The summary types allowed
are: Average (Avg), Count, Max (Maximum), Min (Minimum), Var (Variance), VarP (Variance for the
population), StDev (Standard Deviation), StDevP (Standard Deviation for he population), Sum.

Grouping and sorting the report

You may select fields to group the report by placing a check in the Group By check box. You must
select the sort order with the drop down box to the right of the group by check box. Also, indicate the
sort priority in the Sort Priority text box. For example, if you have three fields sorted, the priority will
be 1 for the sort that you wish to be applied first to the data; 2 for the sort to be applied second and
so on.

Note: if you wish to not have the field display in the detail record as well as display on a group
header (a common thing to desire because the information is then redundant and wastes space on
your report detail line), remove the check in the Detail check box.

Note: if you wish to just sort by a field without a group, then do not place a check in the Group By
check box and do select a sort order from the Sort drop down box and give it a sort priority.

5. Click on the tab labeled Title. Enter a title for the report in the text box labeled Select the Report
Title. You may also choose to exclude the detail records for the report by selecting the Exclude
Detail Records (Classic Summary Style) or Exclude Detail Records (Summary) option
button. This is a useful option if you wish to just see the summary figures like the count of railcars or
the average transit time.

6. Click on the tab labeled Filter. You may use any field in the dataset in a filter. The Quick Filter
will get you started with simple filters. More complex filters may be built using the Advanced Filter
and the most complex filter expressions may be typed directly into the Custom Expression Filter
text box.

Note: Any filters that you add now to the report will be saved and will be a permanent part of that
report. When you run the report from the Custom Reports list window, you select additional filters
and/or remove the saved filters for that single run of the report. The saved filters will remain for the next
time the report is run.

4.2 Creating Specific Custom Reports
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4.2.1 Union Pacific Demurrage

UP has a unique way of assessing demurrage charges. To closely estimate UP demurrage charges,
you will need the Demurrage Tracking UP Month.xlsx spreadsheet. Please request this from the
support team.

In Column B, you will enter the number of railcars that arrived the serving area each day. See
Serving Area Arrivals for instructions on how to create this report.

In Column E, you will enter the number of railcars that were in the serving area each day. See
Railcars in Serving Area for instructions on how to create this report.

In Column H, you will enter the number of railcars that were at industry each day. See
Railcars at Industry for instructions on how to create this report.

In Column I, you will enter the number of spots (i.e. the number of railcars that can be placed) at the
industry.

Demurrage Tracking UP spreadsheet

Once the daily data is entered for the entire month, then the Net Due to UP calculation will show in the
lower right corner. If it is negative, no payment is due.

4.2.1.1 Serving Area Arrivals

To create a report that will show when railcars first arrived at a serving area, which is required to
estimate Union Pacific demurrage, follow these instructions:

1. Click on the Custom Reports menu.
2. Click on the New Custom Report button.
3. On the Dataset tab page, click the First Sighting in RR Serving Area link.
4. Click on the Fields tab and highlight the SAArriveDttm field and click the Select Fields button. In
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the Field Name text box, change the entry to dbo.fnGetDateOnly(SAArriveDttm) and change
the Field Alias entry to SAArriveDate. Remove the check in the Detail checkbox and place a
check in the Group By checkbox; select A->Z sort and enter 1 in the Sort Priority text box.

5. Select the rest of the fields as shown below.

6. Click the Title tab and enter Serving Area Arrivals.
7. Click the Filter tab create a filter as shown below, but use the dates that you need.

8. Click the Save and View Report (All Data) button.

Your report will group the results by date and will show the number of railcars that entered the serving
area each day. This is required for calculating arrival credits for Union Pacific demurrage
estimation. If you do not see any results on your report, that may mean that there have been no
Railroad Demurrage criteria records created with a Serving Area Station setting. Please contact
support to assist you with this.
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4.2.1.2 Railcars in Serving Area

Use this report to determine the number of railcars in a serving area

This report may be used for determining the number of railcars in a serving area on each day of the
month to assist with estimating Union Pacific demurrage charges. Follow these instructions:

1. Click on the Management Reports menu.
2. Click the View Report link next to the Last Sighting History report label.
3. Adjust the filter. When the Quick Filter displays, remove the Event Date filter dates; select LE (if this
is for railcars unloading, choose L, for loading, choose E); select the Location (this will be the station
that represents the serving area and final destination - if the serving area boundary is a different station
than the final destination, you will need to filter for both stations and any in between in the Advanced
filter); click the Advanced Filter tab; select the EventDesc field; select the <> (i.e. does not equal)
Operator; select Placement Actual; select AND for the and/or option; click the Insert link; select the
AnalysisDate field; select the Between Operator; enter the begin date and end date Values; click the
Insert link.

This is what the Quick Filter should look like (your station will be different):



Railcar Management System Help43

© 1997 - 2019  Railcar Tracking Company a Division of Savage Services Corp.

This is what the Advanced Filter should look like:

4. Click the View Report button and when prompted that you are running the report with little filtering,
click the Yes button and your results will look like this:
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4.2.1.3 Railcars at Industry

Use this report to determine the number of railcars at industry

This report may be used for determining the number of railcars at a customer's industry on each day of
the month to assist with estimating Union Pacific demurrage charges. Follow these instructions:

1. Click on the Management Reports menu.

2. Click the View Report link next to the Last Sighting History report label.

3. Adjust the filter. When the Quick Filter displays, remove the Event Date filter dates; select LE (if this
is for railcars unloading, choose L, for loading, choose E); select the Location (this will be the station
that represents the serving area and final destination - if the serving area boundary is a different station
than the final destination, you will need to filter for both stations and any in between in the Advanced
filter); click the Advanced Filter tab; select the EventDesc field; select the = (i.e. does equal) Operator;
select Placement Actual; select AND for the and/or option; click the Insert link; select the AnalysisDate
field; select the Between Operator; enter the begin date and end date Values; click the Insert link.

This is what the Quick Filter should look like (your station will be different):
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This is what the Advanced Filter should look like:

4. Click the View Report button and when prompted that you are running the report with little filtering,
click the Yes button and your results will look like this:

4.3 Setting Up Automatic Delivery of Custom Reports

Follow these step-by-step instructions to prepare your custom reports for automatic delivery.

Note: Daily Reports and Management Reports must be cloned and saved as Custom Reports before
they can be automatically delivered.

1. Click the Custom Reports menu.

2. Edit an existing custom report by clicking on the Edit Report link to the right of the report.
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3. Click on the tab labeled Output". Click on the New Option button; select the type of output (i.e. file
format of the report). You have several choices:

PDF - Adobe Acrobat portable document format. This format is the most readable. It will display your
reports exactly as they appear when viewed in the RMS report viewer. Most computers have the
Adobe Acrobat reader installed. If not, the reader is free and easily downloaded from the Internet.

RTF - Rich text format. Most word processors can open and read these reports. Most formatting will
be preserved, but results may vary. A drawback to this option is that if a field has been set to a 0
width, it will still display in this format, which can make the reports hard to read. If you use this
format, design the report accordingly (i.e. limit the number of fields so the report is readable).

HTML - Hyper text markup language. These may be displayed in a web browser. This format is
useful if reports will be saved to a web server where links on a web site reference the files. These
have a similar limitation to the RTF format.

Excel - Microsoft Excel format. Includes all formatting of the original report including page numbers.

CSV (comma separated values, formerly called Comma Delimitted in prior versions of RMS) -
Comma Separated Values format. All formatting is stripped so that the data is more easily worked
with in Excel or some other business system that can read CSV files. Most computer programs can
easily recognize and import this format making it a good choice for sharing RMS data with other
business systems or data warehouses.

NOTE:  If you choose this option, you will be able to select whether or not you want to exclude
column titles (headers) and/or enclose each field in double quotes. To select these options, simply
check the appropriate box(es). By default, only the field values that contain a comma are enclosed in
double quotes. For example the LastCityState field: "Denver, CO".

TIFF - Image format. Similar to a fax. It will display your reports exactly as they appear when viewed
in the RMS report viewer, however, the quality will be fax-like. These are readable by most Windows-
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based computers without installing additional software.

Text - Plain text.

If you wish to export the report to a computer / network folder, select the folder and filename in the File
path and name text box. This is optional. If you are emailing a report, this is not required. Of course,
you may do both if you wish. Select a File write option:

Overwrite - the file is written on top of any previous instances of the report.

New file with time stamp - the file is written with the name given but that includes a unique time
stamp. This prevents any previous instances of the report from being overwritten.

You may create many (unlimited) output options for a single report.

4. Click on the tab labeled Batch. Reports must be added to a batch in order to be scheduled and run
automatically. Click on the New Batch button and then type the name of the batch in the Batch Name
text box. Select a report to add to the batch by placing a check in the check box to the left of the report
name. Click on the Save Batch button. You have the option of running the batch from this screen
(select the batch from the Batch QuickFind and click the Run Batch button) or you may go to the
next tab/form to schedule the batch.

5. Click on the tab labeled Schedule. Select Output Batch Reports from the Activity text box; choose
the date and time for the first export; choose the Interval to determine how often to run this activity;
make sure that the correct report batch is selected in the Select Batch drop down box. Click the Save
button.

4.4 Tracking Exported Data

Sometimes, data records that are stored in RMS are exported to another business system using the
Comma Separated Values (CSV) file format. It is sometimes important that with each export, all new
and only new records are exported. To facilitate this, RMS can keep a record of the maximum record
timestamp (date/time that a record was created stored in the Imported field). It then checks this
timestamp with each export, exporting only the records that have been created later than the existing
maximum timestamp. Follow these step by step instructions to use this feature.

1. Create a report based on the Shipping Instructions dataset or any other dataset that has a field
named Imported. See Creating Custom Reports for all of the details on how to create a custom report.

2. The Selected Fields for the report must include the expression:   CONVERT(VARCHAR,Imported,121)
with a Field Alias of ImportedTracked. The expression is a function that acts on the Imported field to
get it to display the date and time including milliseconds.
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RMS is "listening" for any report that has a ImportedTrack field name and expects it to be a timestamp.
You can uncheck the Detail check box so its value doesn't display when the report is viewed in the
RMS Report Viewer or exported.

3. Click the Title tab and give the report a title.

4. Click the Filter tab, place a check in the Track Exports? check box. Enter the date and time
(YYYY-MM-DD HH:MM:SS.MS) that will determine which records are included on the exported version
of the report. There is also an option where RMS will export records that were modified after the Track
Exports date and time. To activate this feature, place a check in the check box labeled Export
records that were modified after the date/time shown above.

5. Click the Save and View button. Only records that were imported or modified after the provided
date and time should display.

NOTE: When the report is exported automatically (or by using the Run Batch button), the Track
Exports date and time will be updated to the latest date and  time of the last record exported.

To set up automatic delivery of this report, see Setting Up Automatic Delivery of Custom Reports.

4.5 Faxing Custom Reports

Fax RMS Custom Reports automatically using eFax Plus (you could also do this using other
comparable fax server software). For example, to send a fax to a Chicago fax machine at (312) 555-
1212, you'd use 13125551212@efaxsend.com for the Email Recipient in the Output Options for the
particular custom report (remember, the U.S. country code is "1"). Do not include any local or
international dialing codes (e.g., 0, 011, 001). eFax Plus with a valid subscription ($16.99 per month or
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so - see www.efax.com) is all that is required on the computer that runs the RMS report. eFax also
offers corporate account options.

4.6 Creating a Dataset (Report Framework)

With a little bit of technical expertise, your company can extend the RMS Custom Reports with
datasets that provide answers to specific questions that your company needs. No changes to the RMS
application are required. You will need the assistance of a database administrator or database
programmer that is familiar with creating  Microsoft SQL Server views or user defined functions.

The RMS Report Framework is designed to work with loosely coupled datasets. A dataset that is
based on a view, user defined function, or SQL query that returns a table may be created by you and
then saved in the RMS database in Microsoft SQL Server. The newly created dataset will then appear
as one of the datasets to use in the Custom Reports Editor and Creator in the RMS application. All
reporting capabilities normally available will be available to these datasets. Follow these step-by-step
instructions to create your own dataset.

1. Create a view, user defined function (UDF) or SQL query that returns a table in Microsoft SQL
Server in the RMS database file. The field names must have no spaces. The owner of the object
should be dbo.

2. Open the T_RPT_TEMPLATE table.

Enter the view, UDF name or SQL query in the TemplateName field. All UDF names should be
prefaced by dbo (dbo.myUDFname).
Enter the view, UDF name or SQL query as it should appear to users in the TemplateDesc field. This
whould be a more readable form and can include spaces such as My UDF Name.
Enter NotUsed in the TemplateFields field - it is not used at this time.
Enter VW, FN, SQL in the TemplateType field for views, UDF's, and SQL queries respectively.
Enter an extended description of the view or UDF so that users will know what kind of data it
provides. Example: Retrieves the last sighting for each active railcar.
Enter the Filter Theme (check with RTC Tech Support for guidance or enter NONE) in the FilterTheme
field.

3. Open the T_RPT_TEMPLATE_FIELDS table.

Enter the first field name in the FieldName field.
Enter the Lookup List constant in the LookupList field (you may check with RTC Tech Support for
guidance here or you may leave this field blank).
Enter either Text, Numeric, DateTime, or Boolean (True/False) in the DataType field.
Enter the TemplateID value from the T_RPT_TEMPLATE table in the TemplateID field. This tells RMS
to which dataset these fields are related.

Repeat the above steps for each field.

4.7 Dataset descriptions

These topics contain descriptions of each Custom Report dataset and the fields it contains.
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4.7.1 CLM Format H

This dataset can be used to export data in an industry standard format.

List of fields

CareOf

Company name listed as the care of party by the shipper.  Source: Shipping Instruction or if a match is
made on a Party Alias, Party

CityState

Station city and state where the railcar was reported (i.e. the location of bad order).  Source:  Sighting
or if a match is made on a Station Alias, Station.  Format: Mycity, NA.

CLMFormatH

This is a large record that is concatenated with a fixed length format so that it can be imported by
systems that are compatible with the CLM Format H. Source: Sighting

Consignee

Company name listed as the consignee party by the shipper.  Source: Shipping Instruction or if a
match is made on a Party Alias, Party

Destination

City and state / station where the shipment is to terminate.  Source: Sighting or if a match is made on a
Station Alias, Station.  Format: Mycity, NA

EventDesc

Phrase describing the event last performed on the railcar.  Source: Event Descriptions.  Format:  See
Event Codes in the Glossary

FreightPayer

Company name listed as the party that is paying the freight charges.  Source: Shipping Instruction or if
a match is made on a Party Alias, Party

Imported

Date and time that the shipping instruction was inserted into the RMS database. Source: RMS

Modified

Date / time when the record was last modified. Source: Sighting (RMS)

Origin

City / station where the shipment originated.  Source: Shipping Instruction or if a match is made on a
Station Alias, Station
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Pool

Railcar sub-fleet / pool to which the railcar belongs.  Source: Railcar Pool

RRCreated

Date / time that the railroad created the record. This is used primarily for ETA update records (CLM
sighting code = 3), so that RMS will be sure to record the latest ETA provided by a railroad as it may
get several ETA updates for the same railcar in a single import.  Source: This is taken from the header
of a CLM file sent to RMS from a railroad.

Shipper

Company name listed as the Shipper party by the shipper.  Source: Shipping Instruction or if a match is
made on a Party Alias, Party

4.7.2 Contract Rates

Provides a view with fields from the Contract Rate records entered.

List of fields

AvgTransitTime

Average number of days from the origin release event to the destination. If the Release event is not
available, the highest number of days from another event performed at the same station as the origin
of the Trip Plan record is used. Source: Trip Plan

Commodity

Description of the commodity carried in the railcar.  Source: Standard Commodity (Description of the
STCC).

Consignee

Company name listed as the consignee party by the shipper.  Source: Party

ContractType

One of three choices: Estimate, Letter Quote, Offer. Source: Contract Rate

DeliveringRR

The railroad that is going to deliver the shipments at the final destination.  Source: Contract Rate

Destination

City / station (Format: City, ST) where the shipment is to terminate.  Source: Station

DestinationNumber

Proprietary number (entered on the Station window) for the station where the shipment is to terminate.
Source: Station

EffectiveDate
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Date that the contract rate comes into effect.  Source: Contract Rate

ExpirationDate

Date that the contract rate is no longer applicable.  Source: Contract Rate

IsContractInactive

Indicates whether the contract rate is currently used. Source: Contract Rate  Format: True or False

Mileage

Miles between the Origin and Destination. Source: Contract Rate Format: Numeric

Origin

City / station (Format: City, ST) where the shipment originates.  Source: Station

OriginNumber

Proprietary number (entered on the Station window) for the station where the shipment originates.
Source: Station

OwnerCompany

Company which is bound to the railroad for this particular rate. Source: Party

RailcarRate

The dollar amount to move a single railcar. Source: Contract Rate

Railroad

The rail carrier that is offering the rate.  Source: Contract Rate

Route

The originating railroad (SCAC abbreviation), any interchange stations (Rule 260 abbreviation) and
intermediate rairoads, and terminating railroad.  Source: Contract Rate  Format example: UP CHGO
NS

Shipper

Party that is shipping the freight.  Source: Party

STCC

Standard Transportation Commodity Code.  Source: Commodity (Standard STCC)

TariffAuthority

Contract number.  Source: Contract Rate

TonRate

The dollar amount per ton.  Source: Contract Rate
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4.7.3 Cycles

Provides a view with fields primarily oriented to the Cycle records in RMS.  A cycle is a record created
by RMS that is derived from the sighting (CLM) records that are imported in RMS.  RMS derives these
records so that reports based on this type of information will open in a reasonable amount of time (i.e.
a few seconds to a few minutes).

List of fields

APDate

Actual placement date - the date when the railcar is placed or spotted at the final destination on the
consignee or care of party's property.  Source: Cycle.  Format: mm/dd/yyyy

APDttm

Actual placement date and time - the date and time when the railcar is placed or spotted at the final
destination on the consignee or care of party's property.  Source: Cycle. Format: mm/dd/yyyy hh:mm

BOLDate

Date the bill of lading was created (format: mm/dd/yyyy).  Source: Shipping Instruction

BOLNum

Bill of lading number assigned to the shipment by the shipper.  Source: Shipping Instruction

CareOf

Company name listed as the care of party by the shipper.  Source: Shipping Instruction or if a match is
made on a Party Alias, Party

Commodity

Description of the commodity carried in the railcar.  Source: Shipping Instruction unless it matches an
alias of a proprietary Commodity - in that case, it will display the proprietary Commodity Name.

Consignee

Company name listed as the consignee party by the shipper.  Source: Shipping Instruction or if a
match is made on a Party Alias, Party

ContractNum

Number identifying the contract between the freight payor and the rail carrier.  Source: Shipping
Instruction

CPDate

Constructive placement date - the date when the railroad tried to place or spot the railcar at the final
destination on the consignee or care of party's property, but they couldn't for reasons out of their
control.  Source: Cycle.  Format: mm/dd/yyyy

CPDttm
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Constructive placement date and time - the date and time when the railroad tried to place or spot the
railcar at the final destination on the consignee or care of party's property, but they couldn't for reasons
out of their control.  Source: Cycle.  Format: mm/dd/yyyy hh:mm

CPVSAP

If a railcar is constructively placed (CP) during a trip cycle and then subsequently actually placed (AP),
this is the number of days between the two dates.  Source: Calculated by RMS: APDttm minus
CPDttm.  Format: 00.0

CycleTime

Number of days from the beginning of the cycle (i.e. release date / time)  to the end of the cycle (i.e.
the next release date / time).  Source: Calculated by RMS: RlseEndDttm minus RlseDttm.  Format:
00.0

DailyDemCharge

Dollars per day that will be incurred for each day of DemurrageTime. Source: Demurrage - Railroad

DailyLeaseCost

Dollars per day required to lease a particular railcar. Source: Railcar Lease

DemurrageRR

Delivering railroad that will assess the demurrage charges. This is the railroad that constructively
placed, actually placed the railcar and received the railcar back after loading or unloading. Source:
Cycle

DemurrageTime

Time (in days) of calculated demurrage days based on the Railroad Demurrage criteria. Source:
Calculated by RMS based on criteria entered in Demurrage - Railroad

Destination

City / station where the shipment terminated.  Source: Cycle or if a match is made on a Station Alias,
Station.

DestSPLC

SPLC (standard point location code - a 6 digit number identifying a station) for the destination.  Source:
Station.

HasBilling

True or False indicating whether the cycle has a shipping instruction related / attached to it.  Source:
RMS

IsCarInactive

True of False indicating whether the railcar is inactive. Source: Railcar
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IsComplete

True or False indicating whether the cycle is complete (i.e. the RlseEndDate is not blank/null).  Source:
RMS

IsTransitOnTime

True of False indicating wheter the cycle transit time is less than or equal to the Standard Transit
(Days) that is entered for the matching stored Origin Destination (OD) Pair record.

IsValid

True or False indicating whether the cycle is valid.  RMS considers a cycle valid if its origin and
destination matches a stored Origin Desitnation (OD) Pair record in RMS.  The location where the
railcar is actually placed must also match the location where it is subsequently released.

Label

A one character code indicating that the cycle has been identifyed by a user as:

B - Bad Cannot Repair
S - Special Causes
G - Good (Use is not recommended)

Source: Cycle

LayoverTime

The number of days it takes for the railcar to be unloaded (if this is a load cycle) or loaded (if this is an
empty cycle).  Source: Calculated by RMS: RlseEndDttm minus APDttm.  Format: 00.0

LE

Indicates whether this is a load cycle or an empty cycle.  Source: Cycle.  Format: L for load and E for
empty.

LeaseNum

Railcar lease contract number. Source: Railcar Lease.

LEDesc

Indicates whether this is a load cycle or an empty cycle.  Source: Cycle.  Format: LOAD for load and
EMPTY for empty.

Mileage

Number of miles from the origin to the destination.  Source: OD Pair.  Format: 00.0

NetWeight

Weight of the lading.  Source: Shipping Instruction

OrderInDttm

Date and time that the railcar was ordered in after it was reported as constructively placed. Source:
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Shipping Instruction

Origin

City / station where the cycle originated.  Source: Cycle or if a match is made on a Station Alias,
Station

OriginSPLC

SPLC (standard point location code - a 6 digit number identifying a station) for the origin.  Source:
Station.

Pool

Railcar sub-fleet / pool that the railcar belonged to at the time of this cycle.  Source: Railcar Pool

PoolCurrent

Railcar sub-fleet / pool that the railcar belongs to currently (Provided for backward compatibility).
Source: Railcar Pool

Railcar

Initial and Number of the equipment used for the shipment (XXXX 123456); there is always one space
between the initials and number with no trailing or leading spaces or zeros.  Note: This is not a good
field to use for sorting.  If you wish to sort by the railcar initial and number, it is recommended to use
the fields RailcarInitial and RailcarNumber.  Source:  Cycle

RailcarInitial

Initial of the equipment used for the shipment.  Source:  Cycle

RailcarNumber

Number of the equipment used for the shipment.  Source:  Cycle

ReportGroup

Railcar grouping to which the railcar belongs.  Source: Railcar Report Group

RlseDate

Date the railcar was released to start the cycle. Source: Cycle.  Format: mm/dd/yyyy

RlseDttm

Date and time the railcar was released to start the cycle.  Source: Cycle   Format: mm/dd/yyyy hh:mm.

RlseEndDate

Date the railcar was released to end the cycle.  Source: Cycle.   Format: mm/dd/yyyy 

RlseEndDttm

Date and time the railcar was released to end the cycle.  Source: Cycle  Format: mm/dd/yyyy

RlseRR
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Railroad to which the railcar was released at the start of the cycle.  Source: Cycle

RlseTime

Time the railcar was released to start the cycle.  Source: Cycle.  Format: hh:mm:ss am/pm

Route

Includes SCAC abbreviations of railroads that are involved in the shipment and Rule 260 junction
abbreviations indicating interchange points.  Source:  Shipping Instruction

RTADttm

Requested date and time of arrival.  Source: Shipping Instruction.  Format: mm/dd/yyyy hh:mm

Segment

A combination of the origin and destination.  Source: Calculated by RMS: Origin + ' to ' + Destination.
Format: Anywhere, NS to Somewhere, NA

Shipper

Company name listed as the Shipper party by the shipper.  Source: Shipping Instruction or if a match is
made on a Party Alias, Party

STCC

A seven digit numeric code representing 38 commodity groupings.  Source: Shipping Instruction

STCCDesc

A description related to the seven digit numeric code representing 38 commodity groupings.  Source:
RMS Commodities

TransitStandard

Number of days used as a basis of comparison.  Source: OD Pair.  Format: 00.0

TransitTime

Number of days of transit time.  Source: Calculated by RMS: APDttm minus RlseDttm.  Format: 00.0

WaybillDate

Date the waybill was created.  Source:  Shipping Instruction

WaybillNum

Waybill number assigned to the shipment by the rail carrier.  Source:  Shipping Instruction

4.7.4 Demurrage Proprietary

Provides a view with fields primarily oriented to the measurement of the time that railcars are in
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detention or held at a particular loading or unloading point.  The Cycle record is used as the primary
foundation for this dataset.  Criteria that determines the demurrage charge are entered on the
Proprietary Demurrage/Detention Criteria window. This report is designed for RMS users who own or
lease railcars and want to manage how long other organizations hold on to their railcars for
unloading/loading.

List of fields

AcceptableTime

Days that a railcar is allowed to be held at a certain location.  Source: Detention.  Format: 00.0

BOLDate

Date the bill of lading was created (format: mm/dd/yyyy).  Source: Shipping Instruction

BOLNum

Bill of lading number assigned to the shipment by the shipper.  Source: Shipping Instruction

CareOf

Care of party.  Source: Shipping Instruction.

Commodity

Description of the commodity carried in the railcar.  Source: Shipping Instruction unless it matches an
alias of a proprietary Commodity - in that case, it will display the proprietary Commodity Name.

Consignee

Consignee party.  Source: Shipping Instruction

ContractNum

Number identifying the contract between the freight payor and the rail carrier.  Source: Shipping
Instruction

CycleLabel

A one character code indicating that the cycle has been identifyed by a user as:

B - Bad Cannot Repair
S - Special Causes
G - Good (Use is not recommended)

DailyCharge

Dollar amount charged per day of chargeable detention of a railcar at a certain location.  Source:
Detention.  Format 00.00

Destination

City / station where the shipment terminated.  Source: Cycle or if a match is made on a Station Alias,
Station.

DetentionCharge
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DetentionTime multiplied by DailyCharge.  Source: Calculated by RMS.  Format: 00.00

DetentionTime

The number of days between placement date (either constructive or actual, whichever comes first)
and the following release date minus the AcceptibleTime and FreeTime.  Source: Calculated by RMS.
Format: 00.0

ElapsedTime

The number of days between placement date (either constructive or actual, whichever comes first)
and the following release date.  Source: Calculated by RMS.  Format: 00.0

FreeTime

Specific days of the week and holidays that a railcar is allowed to be held at a certain location.  Source:
Detention.  Format: 00.0

IsCarInactive

Indicates whether the railcar is inactive (in RMS).  Source:  Railcar  Format: True or False

IsCarTemp

Indicates whether the railcar is a Temporary fleet assignment.  Source: Railcar.  Format: True or False

IsComplete

Indicates whether the cycle is complete.  Source: Cycle.  Format:  True or False

NetWeight

Weight of the lading.  Source: Shipping Instruction

Origin

City / station where the cycle originated.  Source: Cycle or if a match is made on a Station Alias,
Station

PlacedDate

Actual or constructive placement date, whichever came first.  Source: Cycle.  Format: mm/dd/yyyy

Pool

Railcar sub-fleet / pool that the railcar belonged to at the time of this cycle.  Source: Railcar Pool

PoolCurrent

Railcar sub-fleet / pool that the railcar belongs to currently (Provided for backward compatibility).
Source: Railcar Pool

Railcar

Initial and Number of the equipment used for the shipment (XXXX 123456); there is always one space
between the initials and number with no trailing or leading spaces or zeros.  Note: This is not a good
field to use for sorting.  If you wish to sort by the railcar initial and number, it is recommended to use
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the fields RailcarInitial and RailcarNumber.  Source:  Cycle

RailcarInitial

Initial of the equipment used for the shipment.  Source:  Cycle

RailcarNumber

Number of the equipment used for the shipment.  Source:  Cycle

ReportGroup

Railcar grouping to which the railcar belongs.  Source: Railcar Report Group

ResponsibleParty

Care of party, if there is one, otherwise, the consignee.  Source: Shipping Instruction.

RlseDate

Date the railcar was released to start the cycle. Source: Cycle.  Format: mm/dd/yyyy

RlseYrMonth

A combination of the year and month that the shipment was released to end the detention time.
Source: Cycle.  Format: yyyy/mm

Route

Includes SCAC abbreviations of railroads that are involved in the shipment and Rule 260 junction
abbreviations indicating interchange points.  Source:  Shipping Instruction

RTADttm

Requested date and time of arrival.  Source: Shipping Instruction.  Format: mm/dd/yyyy hh:mm

ShipDate

Same as RlseDate.  Source: Cycle.  Format: mm/dd/yyyy

Shipper

Company name listed as the Shipper party by the shipper.  Source: Shipping Instruction or if a match is
made on a Party Alias, Party

STCC

A seven digit numeric code representing 38 commodity groupings.  Source: Shipping Instruction

STCCDesc

A description related to the seven digit numeric code representing 38 commodity groupings.  Source:
RMS Commodities

WaybillDate

Date the waybill was created.  Source:  Shipping Instruction
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WaybillNum

Waybill number assigned to the shipment by the rail carrier.  Source:  Shipping Instruction

4.7.5 Demurrage Proprietary by Month

Provides a view with fields primarily oriented to the measurement of the time that railcars are in
demurrage / detention or held at a particular loading or unloading point.  The Cycle record is used as
the primary foundation for this dataset.  Criteria that determines the demurrage charge are entered on
the Proprietary Demurrage/Detention Criteria window. This report is designed for RMS users who own
or lease railcars and want to manage how long other organizations hold on to their railcars for
unloading/loading. This dataset differs from the Demurrage Proprietary dataset in that is calculates
demurrage by a specific month provided by the user at run time. For example, if the user provides a
date of 10/1/2018 as the PeriodBeginDate, then RMS will calculate and display only demurrage that
was incurred in the month of October, 2018. If there was a railcar that incurred some demurrage in
September, 2018 and wasn't released empty until October 15, 2018, then the amound of demurrage
that this dataset returns is from 10/1/2018 through 10/15/2019. It is assumed that the user ran this
dataset-based report for September 1, 2018 last month and any demurrage charges in September
were displayed on that report.

List of fields

AcceptableTime

Days that a railcar is allowed to be held at a certain location.  Source: Detention.  Format: 00.0

BillingMonth

Number that represents the month that the demurrage charges were accrued. Source: Demurrage
Proprietary

BillingYear

Number that represents the year that the demurrage charges were accrued. Source: Demurrage
Proprietary

BOLDate

Date the bill of lading was created (format: mm/dd/yyyy).  Source: Shipping Instruction

CycleId

Unique identifier for the cycle record. Note: this is an identifier that is created by and used by RMS.
Source: Cycle

DailyCharge

Dollar amount charged per day of chargeable demurrage of a railcar at a certain location. Source:
Demurrage Proprietary. Format 00.00

DemurrageCharge

DemurrageTime multiplied by DailyCharge. Source: Calculated by RMS. Format: 00.00
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DemurrageEndDate

Date that represents the last day that demurrage charges were accrued. It is either the date of release
or the end of the period. Source: Demurrage Proprietary  Format: YYYY-MM-DD

DemurrageTime

The number of days between placement date (either constructive or actual, whichever comes first) and
the following release date minus the AcceptibleTime and FreeTime. Source: Calculated by RMS.
Format: 00.00

Destination

City / station (Format: City, ST) where the shipment is to terminate. Source: Station, Cycle

FreeTime

Specific days of the week and holidays that a railcar is allowed to be held at a certain location. This is
the number of free days in the period. Source: Demurrage Proprietary. Format: 00.00

PeriodBeginDate

Date that represents the first day of the month that the demurrage charges were accrued. Source:
Demurrage Proprietary  Format: YYYY-MM-DD

PlacedDate

Actual or constructive placement date, whichever came first. Source: Cycle. Format: mm/dd/yyyy

PlacedDttm

Actual or constructive placement date/time, whichever came first. Source: Cycle. Format: mm/dd/yyyy

Railcar

Initial and Number of the equipment used for the shipment (XXXX 123456); there is always one space
between the initials and number with no trailing or leading spaces or zeros.  Note: This is not a good
field to use for sorting.  If you wish to sort by the railcar initial and number, it is recommended to use
the fields RailcarInitial and RailcarNumber.  Source:  Cycle

RailcarId

Unique identifier for the equipment used for the shipment. Note: This is an identifier that is created by
and used by RMS.  Source: Railcar

ResponsibleParty

Care of party, if there is one, otherwise, the Consignee. Source: Shipping Instruction.

UsedAcceptableTime

Days that a railcar is allowed to be held at a certain location that were used during the period. Source:
Demurrage Proprietary. Format: 00.00
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4.7.6 Demurrage Railroad

Provides a view with fields primarily oriented to the measurement of the time that railcars are incurring
private railcar storage charges and demurrage.  The Cycle record is used as the primary foundation for
this dataset.  Criteria that determines the demurrage charge are entered on the
Railroad Demurrage/Detention window. This dataset is designed for RMS users who want reports that
will help them audit and/or accrue demurrage charges assessed by the railroads.

List of fields

APDate

Actual placement date - the date when the railcar is placed or spotted at the final destination on the
consignee or care of party's property.  Source: Cycle.  Format: YYYY/MM/DD

APDttm

Actual placement date and time - the date and time when the railcar is placed or spotted at the final
destination on the consignee or care of party's property.  Source: Cycle. Format: YYYY/MM/DD
HH:MM

APRR

Railroad that performed the actual placement event. Source: Cycle. Format: 4 character abbreviation
SCAC.

BOLDate

Date the bill of lading was created (format: YYYY/MM/DD).  Source: Shipping Instruction

BOLNum

Bill of lading number assigned to the shipment by the shipper.  Source: Shipping Instruction

CareOf

Company name listed as the care of party by the shipper.  Source: Shipping Instruction or if a match is
made on a Party Alias, Party

Commodity

Description of the commodity carried in the railcar.  Source: Shipping Instruction unless it matches an
alias of a proprietary Commodity - in that case, it will display the proprietary Commodity Name.

Consignee

Company name listed as the consignee party by the shipper.  Source: Shipping Instruction or if a
match is made on a Party Alias, Party

CPDate

Constructive placement date - the date when the railroad tried to place or spot the railcar at the final
destination on the consignee or care of party's property, but they couldn't for reasons out of their
control.  Source: Cycle.  Format: YYYY/MM/DD.
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CPDttm

Constructive placement date and time - the date and time when the railroad tried to place or spot the
railcar at the final destination on the consignee or care of party's property, but they couldn't for reasons
out of their control.  Source: Cycle.  Format: YYYY/MM/DD HH:MM.

CPRR

Railroad that performed the actual placement event. Source: Cycle. Format: 4 character abbreviation
SCAC.

CPVSAP

If a railcar is constructively placed (CP) during a trip cycle and then subsequently actually placed (AP),
this is the number of days between the two dates.  Source: Calculated by RMS: APDttm minus
CPDttm.  Format: 00.0

CycleTime

Number of days from the beginning of the cycle (i.e. release date / time)  to the end of the cycle (i.e.
the next release date / time).  Source: Calculated by RMS: RlseEndDttm minus RlseDttm.  Format:
00.0

DailyDemCharge

Dollars per day that will be incurred for each day of DemurrageTime. Source: Demurrage - Railroad

DemActivity

Indicates whether the railcar is getting loaded or unloaded. Source: Demurrage - Railroad. Format:
LOADING, UNLOADING

DemStartDttm

The date and time that demurrage charges began to accrue. Source: Demurrage - Railroad
determines the time of day, and the number of allowed days before the charges begin. Format:
YYYY/MM/DD HH:MM

DemStatus

Indicates whether the railcar is incurring demurrage charges. Source: Calculation. Format: IS
INCURRING, HAS INCURRED, NONE INCURRED, NO RR INFO, WILL INCUR

DemurrageCharge

Time (in days) of calculated demurrage days based on the Railroad Demurrage criteria multiplied by
the daily charge for the particular situation. Source: Calculated by RMS based on criteria entered in
Demurrage - Railroad

DemurrageRR

Delivering railroad that will assess the demurrage charges. This is the railroad that constructively
placed, actually placed the railcar and received the railcar back after loading or unloading. Source:
Cycle

DemurrageTime
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Time (in days) of calculated demurrage days based on the Railroad Demurrage criteria. Source:
Calculated by RMS based on criteria entered in Demurrage - Railroad

Destination

City / station where the shipment terminated.  Source: Cycle or if a match is made on a Station Alias,
Station.

DestSPLC

SPLC (standard point location code - a 6 digit number identifying a station) for the destination.  Source:
Station.

FreeCreditTime

The number of days (free or credited) provided by the railroad where no charge is assessed. Source:
Calculated by RMS based on criteria entered in Demurrage - Railroad

HasBilling

True or False indicating whether the cycle has a shipping instruction related / attached to it.  Source:
RMS

IsCarInactive

True or False indicating whether the railcar is inactive. Source: Railcar

IsCarPlaced

True or False indicating whether the railcar has been placed. Source: calculated by RMS when the
railcar has encountered a constructive placement or actual placement event.

IsCarTemp

Indicates whether the railcar is a Temporary fleet assignment.  Source: Railcar.  Format: True or False

IsComplete

True or False indicating whether the cycle is complete (i.e. the RlseEndDate is not blank/null).  Source:
RMS

IsValid

True or False indicating whether the cycle is valid.  RMS considers a cycle valid if its origin and
destination matches a stored Origin Desitnation (OD) Pair record in RMS.  The location where the
railcar is actually placed must also match the location where it is subsequently released.

Label

A one character code indicating that the cycle has been identifyed by a user as:

B - Bad Cannot Repair
S - Special Causes
G - Good (Use is not recommended)

Source: Cycle
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LayoverTime

The number of days it takes for the railcar to be unloaded (if this is a load cycle) or loaded (if this is an
empty cycle).  Source: Calculated by RMS: RlseEndDttm minus APDttm.  Format: 00.0

LE

Indicates whether this is a load cycle or an empty cycle.  Source: Cycle.  Format: L for load and E for
empty.

LEDesc

Indicates whether this is a load cycle or an empty cycle.  Source: Cycle.  Format: LOAD for load and
EMPTY for empty.

OrderInDttm

Date and time that the railcar was ordered in after it was reported as constructively placed. Source:
Shipping Instruction Format: YYYY/MM/DD HH:MM

Origin

City / station where the cycle originated.  Source: Cycle or if a match is made on a Station Alias,
Station

OriginSPLC

SPLC (standard point location code - a 6 digit number identifying a station) for the origin.  Source:
Station.

PlacedDate

Actual or constructive placement date, whichever came first.  Source: Cycle.  Format: YYYY/MM/DD

PlacedRR

Railroad that performed the constructive or actual placement event. Source: Cycle. Format: 4
character abbreviation SCAC.

Railcar

Initial and Number of the equipment used for the shipment (XXXX 123456); there is always one space
between the initials and number with no trailing or leading spaces or zeros.  Note: This is not a good
field to use for sorting.  If you wish to sort by the railcar initial and number, it is recommended to use
the fields RailcarInitial and RailcarNumber.  Source:  Cycle

RailcarInitial

Initial of the equipment used for the shipment.  Source:  Cycle

RailcarNumber

Number of the equipment used for the shipment.  Source:  Cycle

ReportGroup

Railcar grouping to which the railcar belongs.  Source: Railcar Report Group
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RlseDate

Date the railcar was released to start the cycle. Source: Cycle.  Format: YYYY/MM/DD

RlseDttm

Date and time the railcar was released to start the cycle.  Source: Cycle   Format: YYYY/MM/DD
HH:MM.

RlseEndDate

Date the railcar was released to end the cycle.  Source: Cycle.   Format: YYYY/MM/DD 

RlseEndDttm

Date and time the railcar was released to end the cycle.  Source: Cycle  Format: YYYY/MM/DD HH:MM

RlseEndLE

Load / empty status of the railcar when it was released to end the demurrage. Source: Cycle  Format: L
or E

RlseEndRR

Railroad to which the railcar was released at the end of the cycle.  Source: Cycle

RlseRR

Railroad to which the railcar was released at the start of the cycle.  Source: Cycle

RlseTime

Time the railcar was released to start the cycle.  Source: Cycle.  Format: HH:MM:SS am/pm

Route

Includes SCAC abbreviations of railroads that are involved in the shipment and Rule 260 junction
abbreviations indicating interchange points.  Source:  Shipping Instruction

SAArriveDate

The date when the railcar was first entered the serving area. Source: Derived by RMS by comparing
the Sighting record to Railroad Demurrage record Serving Area entry (not available in the UI yet, must
be entered by support).  Format: YYYY/MM/DD.

Segment

A combination of the origin and destination.  Source: Calculated by RMS: Origin + ' to ' + Destination.
Format: Anywhere, NS to Somewhere, NA

Shipper

Company name listed as the Shipper party by the shipper.  Source: Shipping Instruction or if a match is
made on a Party Alias, Party

STCC
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A seven digit numeric code representing 38 commodity groupings.  Source: Shipping Instruction

STCCDesc

A description related to the seven digit numeric code representing 38 commodity groupings.  Source:
RMS Commodities

TransitTime

Number of days of transit time.  Source: Calculated by RMS: APDttm minus RlseDttm.  Format: 00.0

UntilDemTime

Number of days until the railcar will incur demurrage charges. Source: Calculated based on the
Demurrage - Railroad criteria. Format: 0.00

WaybillDate

Date the waybill was created.  Source:  Shipping Instruction

WaybillNum

Waybill number assigned to the shipment by the rail carrier.  Source:  Shipping Instruction

4.7.7 Duration of Bad Orders

Provides a view with fields primarily oriented to the measurement of the time between when a railcar is
reported in Bad Order status and when it is released from bad order status.  The dataset is based
mostly on the Sighting records in RMS.

List of fields

BadOrderDate

Date that the railcar was placed in bad order status.  Source: Sighting.  Format: mm/dd/yyyy

BadOrderDttm

Date and time that the railcar was reported as in bad order status.  Source: Sighting.  Format:
mm/dd/yyyy hh:mm

BadOrderRlseDate

Date that the railcar was released from bad order status.  Source: Sighting.  Format: mm/dd/yyyy

BadOrderRlseDttm

Date and time that the railcar was released from bad order status.  Source: Sighting.  Format:
mm/dd/yyyy

BadOrderRlseTime

Time that the railcar was released from bad order status.  Source: Sighting.  Format: hh:mm:ss am/pm

BadOrderTime
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Time that the railcar was reported as in bad order status.  Source: Sighting.  Format: hh:mm:ss am/pm

City

Station city where the railcar was last reported (i.e. the location of bad order).  Source:  Sighting or if a
match is made on a Station Alias, Station

CityState

Station city and state where the railcar was last reported (i.e. the location of bad order).  Source:
Sighting or if a match is made on a Station Alias, Station.  Format: Mycity, NA.

DestCity

Station city where the railcar is destined.  Source:  Sighting or if a match is made on a Station Alias,
Station.

Destination

Station city and state where the railcar is destined.  Source:  Sighting or if a match is made on a Station
Alias, Station.  Format: Mycity, NA.

DestState

Two character state abbreviation where the railcar is destined.  Source:  Sighting or if a match is made
on a Station Alias, Station.

ElapsedTime

Bad order release date and time minus the bad order date and time.  Source: Calculated by RMS.
Format: 00.0

IsCarTemp

Indicates whether the railcar is a Temporary fleet assignment.  Source: Railcar.  Format: True or False

LE

Indicates whether this is a load cycle or an empty cycle.  Source: Cycle.  Format: L for load and E for
empty.

LEDesc

Indicates whether this is a load cycle or an empty cycle.  Source: Cycle.  Format: LOAD for load and
EMPTY for empty.

Pool

Railcar sub-fleet / pool that the railcar belonged to at the time of this cycle.  Source: Railcar Pool

PoolCurrent

Railcar sub-fleet / pool that the railcar belongs to currently (Provided for backward compatibility).
Source: Railcar Pool

Railcar
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Initial and Number of the equipment used for the shipment (XXXX 123456); there is always one space
between the initials and number with no trailing or leading spaces or zeros.  Note: This is not a good
field to use for sorting.  If you wish to sort by the railcar initial and number, it is recommended to use
the fields RailcarInitial and RailcarNumber.  Source:  Cycle

RailcarInitial

Initial of the equipment used for the shipment.  Source:  Cycle

RailcarNumber

Number of the equipment used for the shipment.  Source:  Cycle

Railroad

SCAC railroad abbreviation for the railroad which last reported the location of the railcar.  Source:
Sighting

State

Two character state abbreviation where the railcar was last reported (i.e. the location of bad order).
Source:  Sighting or if a match is made on a Station Alias, Station

TrainID

Identifier of the train that the railcar is in.  Source: Sighting.

4.7.8 First Sighting in RR Serving Area

Provides a view with fields related to where and when the railcar was first reported in a serving area.
The dataset is based mostly on the Sighting records in RMS, but records will only display when the
Sighting Station City and State match the Serving Area City and State chosen for a particular Railroad
Demurrage record. The Sighting Load/Empty and Sighting Destination must match the Railroad
Demurrage Load/Empty and Station entries as well.

NOTE: To use this dataset to create a report that will show when railcars first arrived at a serving area,
which is required to estimate Union Pacific demurrage, go here.

List of fields

LE

Indicates whether the shipment is for a railcar that is empty (E) or loaded (L).  Source: Sighting
Format: L or E (if unknown U)

Railcar

Initial and Number of the equipment used for the shipment; there is always one space between the
initials and number with no trailing or leading spaces or zeros.  Note: This is not a good field to use for
sorting.  If you wish to sort by the railcar initial and number, it is recommended to use the fields
RailcarInitial and RailcarNumber.  Source:  Sighting  Format: Alpha numeric KEYX 123456

RailcarInitial
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Initial of the equipment used for the shipment.  Source:  Sighting  Format: Alpha up to 4 characters

RailcarNumber

Number of the equipment used for the shipment.  Source:  Sighting  Format: Numeric up to 6 numbers
with no decimals

Railroad

SCAC railroad abbreviation for the railroad which last reported the location of the railcar.  Source:
Sighting  Format: Alpha up to 4 characters

SAArriveDttm

Date and time that the railcar was first reported in the serving area. Source: Sighting. Format:
Date/Time YYYY/MM/DD HH:MM

SACityState

Serving Area Station city and state where the railcar was reported.  Source:  Sighting.  Format: Alpha
Numeric Mycity, NA.

4.7.9 Last Sightings

Provides a view with fields primarily oriented to where the railcar was last reported.  The dataset is
based mostly on the Sighting records in RMS, but also contains a lot of information from the Shipping
Instruction.

List of fields

AARType

Code indicating the type of railcar.  Association of American Railroads (AAR) standard.  Source:
Railcar

BOLDate

Date the bill of lading was created (format: mm/dd/yyyy).  Source: Shipping Instruction

BOLNum

Bill of lading number assigned to the shipment by the shipper.  Source: Shipping Instruction

CareOf

Company name listed as the care of party by the shipper.  Source: Shipping Instruction or if a match is
made on a Party Alias, Party

Comments

Up to 4 characters that may be entered by the user when inserting or updating a sighting record.
Source: Sighting

Commodity
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Description of the commodity carried in the railcar.  Source: Shipping Instruction unless it matches an
alias of a proprietary Commodity - in that case, it will display the proprietary Commodity Name.

CommodityLd

Description of the commodity carried in the railcar from the last load shipment.  Source: Shipping
Instruction unless it matches an alias of a proprietary Commodity - in that case, it will display the
proprietary Commodity Name.

Consignee

Company name listed as the consignee party by the shipper.  Source: Shipping Instruction or if a
match is made on a Party Alias, Party

ContractNum

Number identifying the contract between the freight payor and the rail carrier.  Source: Shipping
Instruction

DaysFromDest

Number of days until the railcar is estimated to arrive at the final destination:  Source: Trip Plan.
Format: 00.0

DaysFromOriginAvg

Number of days, on average, that it takes a railcar to get to this particular station location and event.
Source: Calculated using Trip Plan.  Format 00.0

NOTE: This value is calculated by subtracting the DaysFromDest for the particular Trip Plan Event for
the latest location of the railcar from the DaysFromDest for the Released Trip Plan Event for the
particular Trip Plan that the railcar is moving on.

DaysFromOriginPlan

Number of days, according to plan, that it takes a railcar to get to this particular station location and
event.  Source: Trip Plan.  Format 00.0

NOTE: This value comes from the user entry of the Trip Day / Time fields on the Trip Plan Event.

DestBill

City and state / station where the shipment is to terminate.  Source: Shipping Instruction or if a match is
made on a Station Alias, Station.  Format: Mycity, NA

DestCity

City / station where the shipment is to terminate.  Source: Shipping Instruction or if a match is made on
a Station Alias, Station; if there is no shipping instruction available, then it is from the Sighting or if a
match is made on a Station Alias, Station.

DestCityCLM

City / station where the shipment is to terminate.  Source: Sighting or if a match is made on a Station
Alias, Station.

DestCLM
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City and state / station where the shipment is to terminate.  Source: Sighting or if a match is made on a
Station Alias, Station.  Format:  Mycity, NA

Destination

City and state / station where the shipment is to terminate.  Source: Shipping Instruction or if a match is
made on a Station Alias, Station; if there is no shipping instruction available, then it is from the Sighting
or if a match is made on a Station Alias, Station.  Format: Mycity, NA

DestState

Two character state abbreviation where the shipment is to terminate.  Source: Shipping Instruction or if
a match is made on a Station Alias, Station; if there is no shipping instruction available, then it is from
the Sighting or if a match is made on a Station Alias, Station.

DestStateCLM

Two character state abbreviation where the shipment is to terminate.  Source: Sighting or if a match is
made on a Station Alias, Station.

ElapsedTime

The number of days between EventDttm (event date and time) and the date and time the report was
run.  Source: Calculated by RMS.  Format: 00.0

ElapsedTimeSinceRlse

The number of days between RlseDttm (Release date and time that begins the currrent Cycle that the
railcar is in) and the date and time the report was run.  Source: Calculated by RMS.  Format: 00.0

ETADttm

Date and time that the railcar is estimated to be actually palced at destination calculated by RMS.  If
this ETA is not available, then the ETA provided by the railroad is used (ETARRDttm).  Source:
Calculated by RMS or Sighting.  Format: mm/dd/yyyy hh:mm

ETA2Dttm

Date and time that the railcar is estimated to be actually placed at destination according to the railroad.
If this ETA is not available, then the ETA as estimated by RMS is displayed.  Source: Sighting or
Calculated by RMS.  Format: mm/dd/yyyy hh:mm

ETA2OriginalDttm

First, earliest, ETA provided by a railroad for the trip cycle. If one is not available, then the first ETA
from RMS is displayed.  Source: Sighting for railroad ETA; Trip Plan for RMS ETA

ETA2OriginalSource

dentifies the ETA source.  Source: It will display RR if the ETA was provided by the railroad via the
Sighting record; RMS if the ETA was calculated using Trip Plans and RMS' Enhanced ETA feature.

ETAOriginalDttm

First ETA provided by RMS from the Trip Cycle, if one is not available, then the first ETA from a
railroad is displayed.  Source: Trip Plan for RMS ETA; Sighting for railroad ETA
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ETAOriginalSource

Identifies the ETA source.  Source: It will display RR if the ETA was provided by the railroad via the
Sighting record; RMS if the ETA was calculated using Trip Plans and RMS' Enhanced ETA feature.

ETARMSOriginalDttm

First ETA provided by RMS for the trip cycle.  Source: Trip Plan

ETARRCity

City name for which the ETA is provided by the railroad.  Source: Sighting (Note: CLM Format H is the
sighting format that will provide this).

ETARRCityState

City and State for which the ETA is provided by the railroad.  Source: Sighting (Note: CLM Format H is
the sighting format that will provide this). Format: Mycity, ST

ETARRDttm

Date and time that the railcar is estimated to arrive at the final destination according to the railroad.
Source: Sighting (Note: CLM Format H is the sighting format that will provide this).  Format:
mm/dd/yyyy hh:mm

ETARREvent

Sighting event code for which the ETA is provided by the railroad.  Source: Sighting (Note: CLM
Format H is the sighting format that will provide this). This event code is usually either J, which means
Interchange Delivery or Z, which means Placement Actual. Format: J = interchange delivery; D =
arrival final destination; Z = placement actual

ETARREventDesc

Sighting event description for which the ETA is provided by the railroad.  Source: Sighting (Note: CLM
Format H is the sighting format that will provide this). This event is usually either Interchange Delivery
or Placement Actual.

ETARROriginalDttm

First ETA provided by a railroad for the trip cycle.  Source: Sighting

ETARRState

State name for which the ETA is provided by the railroad.  Source: Sighting (Note: CLM Format H is
the sighting format that will provide this).

ETARRType

If sighting data is gotten from Steelroads/Railinc, and the ETA is provided by the same, this field may
have a value of P, which means Predictive, which means that the ETA has been estimated based on
similar historical transit moves. This also means that the railroad did not provide an ETA to
Steelroads/Railinc.  Source: Sighting (Note: CLM Format H is the sighting format that will provide this).

ETASource

Identifies the ETA source.  Source: RMS.  Format: RMS - if the ETA was calculated using Trip Plans
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and RMS' Enhanced ETA feature; RR - if the ETA was provided by the railroad via the Sighting record.

Event

One character code identifying the event last performed on the railcar.  Source: Sighting.  Format:  See
Event Codes in the Glossary

EventDate

When the event last performed on the railcar happened.  Source:  Sighting.  Format:  mm/dd/yyyy

EventDesc

Phrase describing the event last performed on the railcar.  Source: Event Descriptions.  Format:  See
Event Codes in the Glossary

EventDttm

When the event last performed on the railcar happened.  Source:  Sighting.  Format:  mm/dd/yyyy
hh:mm

EventTime

When the event last performed on the railcar happened.  Source:  Sighting.  Format:  hh:mm:ss am/pm

IsCarTemp

Indicates whether the railcar is a Temporary fleet assignment.  Source: Railcar.  Format: True or False

LastCity

Station city where the railcar was last reported (i.e. the location of bad order).  Source:  Sighting or if a
match is made on a Station Alias, Station.  Format: Mycity.

LastCityState

Station city and state where the railcar was last reported (i.e. the location of bad order).  Source:
Sighting or if a match is made on a Station Alias, Station.  Format: Mycity, NA.

LastState

Station state where the railcar was last reported (i.e. the location of bad order).  Source:  Sighting or if
a match is made on a Station Alias, Station.  Format: NA.

LE

Indicates whether the shipment is for a railcar that is empty (E) or loaded (L).  Source: Sighting

LeaseNum

Railcar lease contract number. Source: Railcar Lease.

LEDesc

Indicates whether the shipment is for a railcar that is empty (EMPTY) or loaded (LOAD).  Source:
Shipping Instruction
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NetWeight

Weight of the lading.  Source: Shipping Instruction

NoSighting

Indicates if there is no sighting information for a particular railcar.  Source: RMS.  Format: 1 for yes, 0
for no.  1 and 0 were used so that by summarizing the field with the Sum function, a count of railcars
without sightings could be displayed.

Origin

City / station where the shipment originated.  Source: Shipping Instruction or if a match is made on a
Station Alias, Station

Origin Cycle

City / station where the cycle originated.  Source: Cycle or if a match is made on a Station Alias,
Station

PONUm

Displays the purchase order number that was entered on the bill of lading.  Source: Shipping
Instruction

Pool

Railcar sub-fleet / pool to which the railcar belongs.  Source: Railcar Pool

Railcar

Initial and Number of the equipment used for the shipment (XXXX 123456); there is always one space
between the initials and number with no trailing or leading spaces or zeros.  Note: This is not a good
field to use for sorting.  If you wish to sort by the railcar initial and number, it is recommended to use
the fields RailcarInitial and RailcarNumber.  Source:  Shipping Instruction

RailcarInitial

Initial of the equipment used for the shipment.  Source:  Shipping Instruction

RailcarNumber

Number of the equipment used for the shipment.  Source:  Shipping Instruction

Railroad

SCAC railroad abbreviation for the railroad which last reported the location of the railcar.  Source:
Sighting

ReportGroup

Railcar grouping to which the railcar belongs.  Source: Railcar Report Group

RlseDate

Date the railcar was released to start the cycle. Source: Cycle.  Format: mm/dd/yyyy
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RlseDttm

Date and time the railcar was released to start the cycle.  Source: Cycle   Format: mm/dd/yyyy hh:mm.

RlseTime

Time the railcar was released to start the cycle.  Source: Cycle.  Format: hh:mm:ss am/pm

Route

Includes SCAC abbreviations of railroads that are involved in the shipment and Rule 260 junction
abbreviations indicating interchange points.  Source:  Shipping Instruction

RTADttm

Requested date and time of arrival.  Source: Shipping Instruction.  Format: mm/dd/yyyy hh:mm

ShellCapacity

Capacity of the tank car shell.  Source:  Railcar.  Format: 0

ShipmentDesc

User maintained field of up to 30 alpha numeric characters.  Source: Shipping Instruction.

ShipmentDescLd

User maintained field of up to 30 alpha numeric characters from the last loaded shipping instruction.
Source: Shipping Instruction.

ShipmentID

User maintained field of up to 6 alpha numeric characters.  Source: Shipping Instruction.

Shipper

Company name listed as the Shipper party by the shipper.  Source: Shipping Instruction or if a match is
made on a Party Alias, Party

SIUserField1

User maintained field of up to 50 alpha numeric characters. Source: Shipping Instruction.

SIUserField2

User maintained field of up to 50 alpha numeric characters. Source: Shipping Instruction.

SIUserField3

User maintained field of up to 4000 alpha numeric characters. Source: Shipping Instruction.

STCC

A seven digit numeric code representing 38 commodity groupings.  Source: Shipping Instruction

STCCDesc
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A description related to the seven digit numeric code representing 38 commodity groupings.  Source:
RMS Commodities

TrainID

Identifier of the train that the railcar is in.  Source: Sighting.

TransitStatus

If the EventDesc is Placement Constructive, Placement Actual, Arrival at Final Destination or the
LastCityState = Destination, then it will display "At Destination", otherwise, "In Transit".  Source: RMS.

TransitStatus2

If the EventDesc is Placement Constructive, Placement Actual or the LastCityState = Destination, then
it will display "At Destination", otherwise, "In Transit".  Source: RMS.

WaybillDate

Date the waybill was created.  Source:  Shipping Instruction

WaybillNum

Waybill number assigned to the shipment by the rail carrier.  Source:  Shipping Instruction

4.7.10 Last Sightings History

This dataset will be helpful if you want to see the latest location of railcars on any given day for up to
the last 45 days. NOTE: Reports based on this dataset can take a long time to run. If a Last Sighting by
Railcar report takes 5 seconds to run, a report based on this dataset with a filter that will display the
last 30 days of last sightings, will take approximately 30 * 5 seconds = 150 seconds or 2.5 minutes
since it is performing an individual query for each AnalysisDate. If the date range is 1/1/2016 to
1/31/2016 then the first AnalysisDate would be 1/1/2016 and the system will query the database to
determine which railcars were active on that day and their latest reported sighting before 11:59pm of
the AnalysisDate. The dataset is based mostly on the Sighting records in RMS.

List of fields

AnalysisDate

Date of railcar fleet "snapshot".  Source: RMS.  Format: YYYY/MM/DD

City

Station city where the railcar was reported (i.e. the location of bad order).  Source:  Sighting or if a
match is made on a Station Alias, Station.  Format: Mycity.

CityState

Station city and state where the railcar was reported (i.e. the location of bad order).  Source:  Sighting
or if a match is made on a Station Alias, Station.  Format: Mycity, NA.

Comments

Up to 4 characters that may be entered by the user when inserting or updating a sighting record.



Railcar Management System Help79

© 1997 - 2019  Railcar Tracking Company a Division of Savage Services Corp.

Source: Sighting

DestCity

City / station where the shipment is to terminate.  Source: Sighting or if a match is made on a Station
Alias, Station.

Destination

City and state / station where the shipment is to terminate.  Source: Sighting or if a match is made on a
Station Alias, Station.  Format: Mycity, NA

DestState

Two character state abbreviation where the shipment is to terminate.  Source: Sighting or if a match is
made on a Station Alias, Station.

ETACity

Station city where the railcar is estimated to arrive.  Source:  Sighting or if a match is made on a
Station Alias, Station.  Format: Mycity.

ETAEvent

Single character event code indicating the event that will happen when the railcar arrives. Usually Z
(Placement Actual) or J (Interchange Delivery). Source: Sighting  Format: Z

ETARRDttm

Date and time that the railcar is estimated to arrive at the final destination according to the railroad.
Source: Sighting (Note: CLM Format H is the sighting format that will provide this).  Format:
mm/dd/yyyy hh:mm

ETAState

Station state where the railcar is estimated to arrive.  Source:  Sighting or if a match is made on a
Station Alias, Station.  Format: NA

ETAType

Single character code of P (predictive) or blank. P would indicate that the ETA that is provided is based
on historical transit time.

Event

One character code identifying the event last performed on the railcar.  Source: Sighting.  Format:  See
Event Codes in the Glossary

EventDate

When the event last performed on the railcar happened.  Source:  Sighting.  Format:  mm/dd/yyyy

EventDesc

Phrase describing the event last performed on the railcar.  Source: Event Descriptions.  Format:  See
Event Codes in the Glossary
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EventDttm

When the event last performed on the railcar happened.  Source:  Sighting.  Format:  mm/dd/yyyy
hh:mm

EventTime

When the event last performed on the railcar happened.  Source:  Sighting.  Format:  hh:mm:ss am/pm

IsCarTemp

Indicates whether the railcar is a Temporary fleet assignment.  Source: Railcar.  Format: True or False

LE

Indicates whether the shipment is for a railcar that is empty (E) or loaded (L).  Source: Shipping
Instruction

LEDesc

Indicates whether the shipment is for a railcar that is empty (EMPTY) or loaded (LOAD).  Source:
Shipping Instruction

Modified

Date / time when the record was last modified. Source: Sighting (RMS)

Pool

Railcar sub-fleet / pool to which the railcar belongs.  Source: Railcar Pool

Railcar

Initial and Number of the equipment used for the shipment (XXXX 123456); there is always one space
between the initials and number with no trailing or leading spaces or zeros.  Note: This is not a good
field to use for sorting.  If you wish to sort by the railcar initial and number, it is recommended to use
the fields RailcarInitial and RailcarNumber.  Source:  Shipping Instruction

RailcarInitial

Initial of the equipment used for the shipment.  Source:  Shipping Instruction

RailcarNumber

Number of the equipment used for the shipment.  Source:  Shipping Instruction

Railroad

SCAC railroad abbreviation for the railroad which last reported the location of the railcar.  Source:
Sighting

SightingID

Unique identifier of sighting record.  Used mostly by RMS.  Source:  Sighting (RMS).  Format: 00

Source
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Three character abbreviation indicating the source of the sighting record.  Source:  Sighting (RMS).

State

Two character state abbreviation where the railcar was reported.  Source: Sighting or if a match is
made on a Station Alias, Station.

TrainID

Identifier of the train that the railcar is in. If the railcar is in bad order status (i.e. Event = B), then this
field will show a one character code (see Bad Order codes in the Glossary) indicating the type of repair
required.  Source: Sighting.

4.7.11 Last Sightings with Inventory

NOTE: At this time, this dataset is not recommended for use with any reports other than the Daily
Reports > Inbound Inventory report.

Provides a view with fields primarily oriented to where the railcar was last reported with some additional
fields that provide the data required to better schedule railcar shipments.

List of fields

AvgCarsEmpDaily

Average railcars emptied over a manually inputted time period. This is the number railcars released
empty where the release date is between Date Range #2, which is set in T_PROGRAM_REFERENCE
where REFERENCE_LABEL = DateRange2LastNDays (the begin date will be system date -
DateRange2LastNDays and the end date will be the system date). NOTE: Date Range #2 cannot be
set in the user interface at this time. Contact support to set this value.

However, if there is an entry in the Avg. Cars Emptied Daily for the Station, then it is used instead of
the query results mentioned above.

AvgCarsLDDaily

Average railcars loaded over a manually inputted time period. This is the number railcars released load
where the release date is between Date Range #2, which is set in T_PROGRAM_REFERENCE where
REFERENCE_LABEL = DateRange2LastNDays (the begin date will be system date -
DateRange2LastNDays and the end date will be the system date). NOTE: Date Range #2 cannot be
set in the user interface at this time. Contact support to set this value.

However, if there is an entry in the Avg. Cars Loaded Daily for the Station, then it is used instead of the
query results mentioned above.

AvgTransitTime

Average transit time over a manually inputted time period. This is the average transit time for
load/empty trip cycles to the station. The date range is determined by
T_PROGRAM_REFERENCE.REFERENCE_VALUE where
T_PROGRAM_REFERENCE.REFERENCE_LABEL= DateRange1LastNDays. The begin date will be
system date - DateRange1LastNDays and the end date will be the system date. NOTE: Date Rage #1
cannot be set in the user interface at this time. Contact support to set this value.

CareOf
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Company name listed as the care of party by the shipper.  Source: Shipping Instruction or if a match is
made on a Party Alias, Party

City

Station city where the railcar was last reported (i.e. the location of bad order).  Source:  Sighting or if a
match is made on a Station Alias, Station.  Format: Mycity.

CityState

Station city and state where the railcar was last reported (i.e. the location of bad order).  Source:
Sighting or if a match is made on a Station Alias, Station.  Format: Mycity, NA.

Comments

Up to 4 characters that may be entered by the user when inserting or updating a sighting record.
Source: Sighting

Consignee

Company name listed as the consignee party by the shipper.  Source: Shipping Instruction or if a
match is made on a Party Alias, Party

CountCarsDaily

This field is not used at this time.

DestCity

City / station where the shipment is to terminate.  Source: Shipping Instruction or if a match is made on
a Station Alias, Station; if there is no shipping instruction available, then it is from the Sighting or if a
match is made on a Station Alias, Station.

Destination

City and state / station where the shipment is to terminate.  Source: Shipping Instruction or if a match is
made on a Station Alias, Station; if there is no shipping instruction available, then it is from the Sighting
or if a match is made on a Station Alias, Station.  Format: Mycity, NA

DestinationLE

Indicates whether the shipment is for a railcar that is empty (E) or loaded (L).  For example, if the
shipment is loaded, then the Destination LE would be L. The AvgCarsEmpDaily at the destination
determine the number of loads that are needed at destination and in transit. Source: Sighting

DestState

Two character state abbreviation where the shipment is to terminate.  Source: Shipping Instruction or if
a match is made on a Station Alias, Station; if there is no shipping instruction available, then it is from
the Sighting or if a match is made on a Station Alias, Station.

ElapsedTime

The number of days between EventDttm (event date and time) and the date and time the report was
run.  Source: Calculated by RMS.  Format: 00.0

ElapsedTimeSinceRlse
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The number of days between RlseDttm (Release date and time that begins the currrent Cycle that the
railcar is in) and the date and time the report was run.  Source: Calculated by RMS.  Format: 00.0

ETADttm

Date and time that the railcar is estimated to arrive at the final destination.  EventDttm plus
DaysFromDest or if DaysFromDest from the Trip Plan is not available, the ETA provided by the railroad
is used (ETARRDttm).  Source: Calculated by RMS.  Format: mm/dd/yyyy hh:mm

Event

One character code identifying the event last performed on the railcar.  Source: Sighting.  Format:  See
Event Codes in the Glossary

EventDate

When the event last performed on the railcar happened.  Source:  Sighting.  Format:  mm/dd/yyyy

EventDesc

Phrase describing the event last performed on the railcar.  Source: Event Descriptions.  Format:  See
Event Codes in the Glossary

EventDttm

When the event last performed on the railcar happened.  Source:  Sighting.  Format:  mm/dd/yyyy
hh:mm

EventTime

When the event last performed on the railcar happened.  Source:  Sighting.  Format:  hh:mm:ss am/pm

IsCarTemp

Indicates whether the railcar is a Temporary fleet assignment.  Source: Railcar.  Format: True or False

LastCityState

Station city and state where the railcar was last reported (i.e. the location of bad order).  Source:
Sighting or if a match is made on a Station Alias, Station.  Format: Mycity, NA.

LE

Indicates whether the shipment is for a railcar that is empty (E) or loaded (L).  Source: Sighting

LEDesc

Indicates whether the shipment is for a railcar that is empty (EMPTY) or loaded (LOAD).  Source:
Shipping Instruction

Origin

City / station where the shipment originated.  Source: Shipping Instruction or if a match is made on a
Station Alias, Station

Pool
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Railcar sub-fleet / pool to which the railcar belongs.  Source: Railcar Pool

Railcar

Initial and Number of the equipment used for the shipment (XXXX 123456); there is always one space
between the initials and number with no trailing or leading spaces or zeros.  Note: This is not a good
field to use for sorting.  If you wish to sort by the railcar initial and number, it is recommended to use
the fields RailcarInitial and RailcarNumber.  Source:  Shipping Instruction

RailcarInitial

Initial of the equipment used for the shipment.  Source:  Shipping Instruction

RailcarNumber

Number of the equipment used for the shipment.  Source:  Shipping Instruction

Railroad

SCAC railroad abbreviation for the railroad which last reported the location of the railcar.  Source:
Sighting

ReportGroup

RlseDttm

Date and time the railcar was released to start the cycle.  Source: Cycle   Format: mm/dd/yyyy hh:mm.

Shipper

Company name listed as the Shipper party by the shipper.  Source: Shipping Instruction or if a match is
made on a Party Alias, Party

Source

City / station where the shipment originated.  Source: Shipping Instruction or Cycle - if a match is made
on a Station Alias, Station

State

Two character state abbreviation where the railcar was reported.  Source: Sighting or if a match is
made on a Station Alias, Station.

StationNum

Proprietary number / code for the destination station. Source: Station

TrainID

Identifier of the train that the railcar is in.  Source: Sighting.

TransitStatus

If the EventDesc is Placement Constructive, Placement Actual, Arrival at Final Destination or the
LastCityState = Destination, then it will display "At Destination", otherwise, "In Transit".  Source: RMS.
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TransitTime

Average transit time over a manually inputted time period. This is the average transit time for railcars
terminating at this station location regardless of origin. The date range is determined by
T_PROGRAM_REFERENCE.REFERENCE_VALUE where
T_PROGRAM_REFERENCE.REFERENCE_LABEL= DateRange1LastNDays. The begin date will be
system date - DateRange1LastNDays and the end date will be the system date. NOTE: Date Rage #1
cannot be set in the user interface at this time. Contact support to set this value.

4.7.12 Last Sightings with Last Loaded Shipping Instruction

Provides a view with fields primarily oriented to where the railcar was last reported.  The dataset is
based mostly on the Sighting records in RMS, but also contains a lot of information from the Shipping
Instruction.  This view is contains most of the fields from the Last Sightings dataset plus key
information from the last loaded Shipping Instruction.

List of fields

AARType

Code indicating the type of railcar.  Association of American Railroads (AAR) standard.  Source:
Railcar

BOLDate

Date the bill of lading was created (format: mm/dd/yyyy).  Source: Shipping Instruction

BOLDateLd

Date the last loaded bill of lading was created (format: mm/dd/yyyy).  Source: Shipping Instruction

BOLNum

Bill of lading number assigned to the shipping instruction by the shipper.  Source: Shipping Instruction

BOLNumLd

Bill of lading number assigned to the last loaded shipping instruction by the shipper.  Source: Shipping
Instruction

CareOf

Company name listed as the care of party by the shipper.  Source: Shipping Instruction or if a match is
made on a Party Alias, Party

CareOfLd

Company name listed as the care of party by the shipper on the last loaded shipping instruction. 
Source: Shipping Instruction or if a match is made on a Party Alias, Party

Comments

Up to 4 characters that may be entered by the user when inserting or updating a sighting record.
Source: Sighting

Commodity
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Description of the commodity carried in the railcar.  Source: Shipping Instruction unless it matches an
alias of a proprietary Commodity - in that case, it will display the proprietary Commodity Name.

CommodityLd

Description of the commodity carried in the railcar during its last loaded shipment.  Source: Shipping
Instruction

Consignee

Company name listed as the consignee party by the shipper.  Source: Shipping Instruction or if a
match is made on a Party Alias, Party

ConsigneeLd

Company name listed as the consignee party by the shipper during its last loaded shipment.  Source:
Shipping Instruction or if a match is made on a Party Alias, Party

ContractNum

Number identifying the contract between the freight payor and the rail carrier.  Source: Shipping
Instruction

ContractNumLd

Number identifying the contract between the freight payor and the rail carrier for the last loaded
shipment.  Source: Shipping Instruction

DaysFromDest

Number of days until the railcar is estimated to arrive at the final destination:  Source: Trip Plan.
Format: 00.0

DestBill

City and state / station where the shipment is to terminate.  Source: Shipping Instruction or if a match is
made on a Station Alias, Station.  Format: Mycity, NA

DestBillLd

City and state / station where the shipment is to terminate for the last loaded shipment.  Source:
Shipping Instruction or if a match is made on a Station Alias, Station.  Format: Mycity, NA

DestCity

City / station where the shipment is to terminate.  Source: Shipping Instruction or if a match is made on
a Station Alias, Station; if there is no shipping instruction available, then it is from the Sighting or if a
match is made on a Station Alias, Station.

DestCityCLM

City / station where the shipment is to terminate.  Source: Sighting or if a match is made on a Station
Alias, Station.

DestCLM

City and state / station where the shipment is to terminate.  Source: Sighting or if a match is made on a
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Station Alias, Station.  Format:  Mycity, NA

Destination

City and state / station where the shipment is to terminate.  Source: Shipping Instruction or if a match is
made on a Station Alias, Station; if there is no shipping instruction available, then it is from the Sighting
or if a match is made on a Station Alias, Station.  Format: Mycity, NA

DestState

Two character state abbreviation where the shipment is to terminate.  Source: Shipping Instruction or if
a match is made on a Station Alias, Station; if there is no shipping instruction available, then it is from
the Sighting or if a match is made on a Station Alias, Station.

DestStateCLM

Two character state abbreviation where the shipment is to terminate.  Source: Sighting or if a match is
made on a Station Alias, Station.

ElapsedTime

The number of days between EventDttm (event date and time) and the date and time the report was
run.  Source: Calculated by RMS.  Format: 00.0

ElapsedTimeSinceRlse

The number of days between RlseDttm (Release date and time that begins the currrent Cycle that the
railcar is in) and the date and time the report was run.  Source: Calculated by RMS.  Format: 00.0

ETADttm

Date and time that the railcar is estimated to arrive at the final destination.  EventDttm plus
DaysFromDest or if DaysFromDest from the Trip Plan is not available, the ETA provided by the railroad
is used (ETARRDttm).  Source: Calculated by RMS.  Format: mm/dd/yyyy hh:mm

ETARRDttm

Date and time that the railcar is estimated to arrive at the final destination according to the railroad.
Source: Sighting (Note: CLM Format H is the sighting format that will provide this).  Format:
mm/dd/yyyy hh:mm

ETASource

Identifies the ETA source.  Source: RMS.  Format: RMS - if the ETA was calculated using Trip Plans
and RMS' Enhanced ETA feature; RR - if the ETA was provided by the railroad via the Sighting record.

Event

One character code identifying the event last performed on the railcar.  Source: Sighting.  Format:  See
Event Codes in the Glossary

EventDate

When the event last performed on the railcar happened.  Source:  Sighting.  Format:  mm/dd/yyyy

EventDesc
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Phrase describing the event last performed on the railcar.  Source: Event Descriptions.  Format:  See
Event Codes in the Glossary

EventDttm

When the event last performed on the railcar happened.  Source:  Sighting.  Format:  mm/dd/yyyy
hh:mm

EventTime

When the event last performed on the railcar happened.  Source:  Sighting.  Format:  hh:mm:ss am/pm

IsCarTemp

Indicates whether the railcar is a Temporary fleet assignment.  Source: Railcar.  Format: True or False

LastCity

Station city where the railcar was last reported (i.e. the location of bad order).  Source:  Sighting or if a
match is made on a Station Alias, Station.  Format: Mycity.

LastCityState

Station city and state where the railcar was last reported (i.e. the location of bad order).  Source:
Sighting or if a match is made on a Station Alias, Station.  Format: Mycity, NA.

LastState

Station state where the railcar was last reported (i.e. the location of bad order).  Source:  Sighting or if
a match is made on a Station Alias, Station.  Format: NA.

LE

Indicates whether the shipment is for a railcar that is empty (E) or loaded (L).  Source: Shipping
Instruction

LEDesc

Indicates whether the shipment is for a railcar that is empty (EMPTY) or loaded (LOAD).  Source:
Shipping Instruction

NetWeight

Weight of the lading.  Source: Shipping Instruction

NetWeightLd

Weight of the lading for the last loaded shipment.  Source: Shipping Instruction

NoSighting

Indicates if there is no sighting information for a particular railcar.  Source: RMS.  Format: 1 for yes, 0
for no.  1 and 0 were used so that by summarizing the field with the Sum function, a count of railcars
without sightings could be displayed.

Origin
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City / station where the shipment originated.  Source: Shipping Instruction or if a match is made on a
Station Alias, Station

OriginBillLd

City / station where the shipment originated for the last loaded shipment.  Source: Shipping Instruction
or if a match is made on a Station Alias, Station

Origin Cycle

City / station where the cycle originated.  Source: Cycle or if a match is made on a Station Alias,
Station

Pool

Railcar sub-fleet / pool to which the railcar belongs.  Source: Railcar Pool

Railcar

Initial and Number of the equipment used for the shipment (XXXX 123456); there is always one space
between the initials and number with no trailing or leading spaces or zeros.  Note: This is not a good
field to use for sorting.  If you wish to sort by the railcar initial and number, it is recommended to use
the fields RailcarInitial and RailcarNumber.  Source:  Shipping Instruction

RailcarInitial

Initial of the equipment used for the shipment.  Source:  Shipping Instruction

RailcarNumber

Number of the equipment used for the shipment.  Source:  Shipping Instruction

Railroad

SCAC railroad abbreviation for the railroad which last reported the location of the railcar.  Source:
Sighting

RlseDate

Date the railcar was released to start the cycle. Source: Cycle.  Format: mm/dd/yyyy

RlseDttm

Date and time the railcar was released to start the cycle.  Source: Cycle   Format: mm/dd/yyyy hh:mm.

RlseTime

Time the railcar was released to start the cycle.  Source: Cycle.  Format: hh:mm:ss am/pm

Route

Includes SCAC abbreviations of railroads that are involved in the shipment and Rule 260 junction
abbreviations indicating interchange points.  Source:  Shipping Instruction

RouteLd

Includes SCAC abbreviations of railroads that are involved in the last loaded shipment and Rule 260
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junction abbreviations indicating interchange points.  Source:  Shipping Instruction

RTADttm

Requested date and time of arrival.  Source: Shipping Instruction.  Format: mm/dd/yyyy hh:mm

RTADttmLd

Requested date and time of arrival for the last loaded shipment.  Source: Shipping Instruction.  Format:
mm/dd/yyyy hh:mm

ShellCapacity

Capacity of the tank car shell.  Source:  Railcar.  Format: 0

Shipper

Company name listed as the Shipper party by the shipper.  Source: Shipping Instruction or if a match is
made on a Party Alias, Party

ShipperLd

Company name listed as the Shipper party by the shipper for the last loaded shipment.  Source:
Shipping Instruction or if a match is made on a Party Alias, Party

STCC

A seven digit numeric code representing 38 commodity groupings.  Source: Shipping Instruction

STCCLd

A seven digit numeric code representing 38 commodity groupings - for the last loaded shipment.
Source: Shipping Instruction

TrainID

Identifier of the train that the railcar is in.  Source: Sighting.

TransitStatus

If the EventDesc is Placement Constructive, Placement Actual, Arrival at Final Destination or the
LastCityState = Destination, then it will display "At Destination", otherwise, "In Transit".  Source: RMS.

TransitStatus2

If the EventDesc is Placement Constructive, Placement Actual or the LastCityState = Destination, then
it will display "At Destination", otherwise, "In Transit".  Source: RMS.

WaybillDate

Date the waybill was created.  Source:  Shipping Instruction

WaybillDateLd

Date the waybill for the last loaded shipment was created.  Source:  Shipping Instruction

WaybillNum
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Waybill number assigned to the shipment by the rail carrier.  Source:  Shipping Instruction

WaybillNumLd

Waybill number assigned to the last loaded shipment by the rail carrier.  Source:  Shipping Instruction

4.7.13 Last Sightings with Pool Trip Plan

Provides a view with fields primarily oriented to where the railcar was last reported.  The dataset is
based mostly on the Sighting records in RMS, but also contains a lot of information from the Shipping
Instruction.

List of fields

AARType

Code indicating the type of railcar.  Association of American Railroads (AAR) standard.  Source:
Railcar

Comments

Up to 4 characters that may be entered by the user when inserting or updating a sighting record.
Source: Sighting

DestCity

City / station where the shipment is to terminate.  Source: Shipping Instruction or if a match is made on
a Station Alias, Station; if there is no shipping instruction available, then it is from the Sighting or if a
match is made on a Station Alias, Station.

Destination

City and state / station where the shipment is to terminate.  Source: Shipping Instruction or if a match is
made on a Station Alias, Station; if there is no shipping instruction available, then it is from the Sighting
or if a match is made on a Station Alias, Station.  Format: Mycity, NA

DestState

Two character state abbreviation where the shipment is to terminate.  Source: Shipping Instruction or if
a match is made on a Station Alias, Station; if there is no shipping instruction available, then it is from
the Sighting or if a match is made on a Station Alias, Station.

ElapsedTime

The number of days between EventDttm (event date and time) and the date and time the report was
run.  Source: Calculated by RMS.  Format: 00.0

ETARRDttm

Date and time that the railcar is estimated to arrive at the final destination according to the railroad.
Source: Sighting (Note: CLM Format H is the sighting format that will provide this).  Format:
mm/dd/yyyy hh:mm

Event
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One character code identifying the event last performed on the railcar.  Source: Sighting.  Format:  See
Event Codes in the Glossary

EventDate

When the event last performed on the railcar happened.  Source:  Sighting.  Format:  mm/dd/yyyy

EventDesc

Phrase describing the event last performed on the railcar.  Source: Event Descriptions.  Format:  See
Event Codes in the Glossary

EventDttm

When the event last performed on the railcar happened.  Source:  Sighting.  Format:  mm/dd/yyyy
hh:mm

EventTime

When the event last performed on the railcar happened.  Source:  Sighting.  Format:  hh:mm:ss am/pm

IsCarTemp

Indicates whether the railcar is a Temporary fleet assignment.  Source: Railcar.  Format: True or False

LastCity

Station city where the railcar was last reported (i.e. the location of bad order).  Source:  Sighting or if a
match is made on a Station Alias, Station.  Format: Mycity

LastCityState

Station city and state where the railcar was last reported (i.e. the location of bad order).  Source:
Sighting or if a match is made on a Station Alias, Station.  Format: Mycity, NA.

LastState

Station state where the railcar was last reported (i.e. the location of bad order).  Source:  Sighting or if
a match is made on a Station Alias, Station.  Format: NA.

LE

Indicates whether the shipment is for a railcar that is empty (E) or loaded (L).  Source: Shipping
Instruction

LEDesc

Indicates whether the shipment is for a railcar that is empty (EMPTY) or loaded (LOAD).  Source:
Shipping Instruction

NoSighting

Indicates if there is no sighting information for a particular railcar.  Source: RMS.  Format: 1 for yes, 0
for no.  1 and 0 were used so that by summarizing the field with the Sum function, a count of railcars
without sightings could be displayed.

Pool
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Railcar sub-fleet / pool to which the railcar belongs.  Source: Railcar Pool

Railcar

Initial and Number of the equipment used for the shipment (XXXX 123456); there is always one space
between the initials and number with no trailing or leading spaces or zeros.  Note: This is not a good
field to use for sorting.  If you wish to sort by the railcar initial and number, it is recommended to use
the fields RailcarInitial and RailcarNumber.  Source:  Shipping Instruction

RailcarInitial

Initial of the equipment used for the shipment.  Source:  Shipping Instruction

RailcarNumber

Number of the equipment used for the shipment.  Source:  Shipping Instruction

Railroad

SCAC railroad abbreviation for the railroad which last reported the location of the railcar.  Source:
Sighting

TimeToDest

Number of days before arriving at destination.  Source: calculated by RMS.  Format: 00.0

TrainID

Identifier of train in which the railcar is included.  Source: Sighting.

4.7.14 Problem Logs

Provides a view with fields from the Problem Log records entered.

List of fields

ActionTaken

A short description of what was done by the person listed in the CompanyContact field. Source:
Problem Log

CompanyContact

Person who created out the problem log.  Source: Problem Log

Description

Long description of the problem.  Source: Problem Log

Destination
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The station where the railcar is to terminate for its trip when the problem occured. This entry will stay
with the problem record and will not change. Source: Station  Format: Mycity, NA.

LastCityState

Station city and state where the railcar was last reported.  Source:  Sighting or if a match is made on a
Station Alias, Station.  Format: Mycity, NA.

LastDestination

City / station where the shipment will terminate for its current trip.  Source: Shipping Instruction of
latest/current shipment or if a match is made on a Station Alias, Station.

LastEventDttm

When the event last performed on the railcar happened.  Source:  Sighting.  Format:  mm/dd/yyyy
hh:mm

LastLE

Indicates whether the railcar is currently empty (E) or loaded (L).  Source: Sighting

LastOrigin

City / station where the shipment originated for its current trip.  Source: Shipping Instruction of
latest/current shipment or if a match is made on a Station Alias, Station.

Location

Short description of the specific location of the problem. This could be a track number, station name
and anything. Source: Problem Log

Origin

The station where the railcar originated. This entry will stay with the problem record and will not
change. Source: Problem Log  Format: Mycity, NA

Pool

Railcar sub-fleet / pool that the railcar belonged to at the time of this problem.  Source: Railcar Pool

PoolCurrent

Railcar sub-fleet / pool that the railcar belongs to currently.  Source: Railcar Pool

ProblemDate

Date that the problem occurred.  Source: Problem Log  Format: mm/dd/yyyy

ProblemDttm

Date and time that the problem occurred. Source: Problem Log  Format: mm/dd/yyyy hh:mm

ProblemTime

Time that the problem occurred. Source: Problem Log  Format: hh:mm
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Railcar

Railcar initial, a space, railcar number with no leading zeros.  Source: Problem Log / Railcar.  Format:
KEYX 23456

RailcarInitial

Source: Problem Log / Railcar.  Format: KEYX

RailcarNumber

Source: Problem Log / Railcar.  Format: 23456

Railroad

Rail carrier to which this problem is being addressed.  Source: Problem Log / Railroad

RailroadContact

Rail carrier contact.  Source: Problem Log

ReportGroup

Railcar grouping to which the railcar belongs.  Source: Railcar Report Group

Resolution

Long description of the solution to the problem.  Source: Problem Log

ResolutionDate

Date that the problem was solved.  Source: Problem Log  Format: mm/dd/yyyy

RRContactPhone

Telephone number of the railroad contact.  Source: Problem Log

4.7.15 Railcar Utilization

Provides a view with fields primarily oriented to how railcars were utilized over a period of time.  The
dataset is based mostly on the Sighting records in RMS, but also gets shipment counts from Shipping
Instructions or Cycles.

List of fields

AnalysisDate

Date of railcar fleet "snapshot".  Source: RMS.  Format: mm/dd/yyyy

Note: By default, RMS takes a snapshot of your fleet every 7 days.  This is done so that the report will
complete in a reasonable time and will not negatively impact other applications on the network.  If you
wish, you may change this number by clicking on the Reports | Properties menu; click on he Railcar
Utilization tab; change the entry in the Analysis Interval (Days) text box.  Click the Ok button to save
changes.
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DailyRailcars

Number of railcars, on average, that are active during the particular period.  Source: Calculated by
RMS.  Format: 00.0

DailyRailcarsPercentage

Percentage of the total fleet or group of railcars that are active during the particular period.  Source:
Calculated by RMS.  Format 00.00%

DailyShellCapacity

Average shell capacity for all of the active railcars for the particular period.  Source: Railcar, Calculated
by RMS.  Format: 00

ExtLEStatus

Extended load/empty status.  Source: Calculated by RMS.  Format: There are three categories:

Empty at Plant/Loading
Empty in Transit
Load

LEStatus

Load/emtpy status.  Source: Sighting.  Format: L = load E = empty

Pool

Railcar pool that the railcar belonged to during each "snapshot".  Source: RMS Event Log (keeps track
of when railcars are added/removed from a pool)

Railcar

Initial and Number of the equipment used for the shipment (XXXX 123456); there is always one space
between the initials and number with no trailing or leading spaces or zeros.  Note: This is not a good
field to use for sorting.  If you wish to sort by the railcar initial and number, it is recommended to use
the fields RailcarInitial and RailcarNumber.  Source:  Shipping Instruction

RailcarInitial

Initial of the equipment used for the shipment.  Source:  Shipping Instruction

RailcarNumber

Number of the equipment used for the shipment.  Source:  Shipping Instruction

RecordCount

Number of records returned

ShellCapacity

Shell capacity for each particular railcar.  Source:  Railcar  Format: 00

ShipmentCount
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Count of shipments for the period.  Source: Shipping Instructions.  Format: 00

Note: The default behavior is that RMS counts the number of shipments for a period based on the bill
of lading date.  In other words, this would be summarizing the number of shipments that started during
a given period.  You may also have RMS count the number of shipments by when the shipment ended
(the release event date/time that ends the cycle) by clicking on the Reports | Properties menu; click on
the Railcar Utilization tab and select the Based on Cycle Completion Date option button.  Click the Ok
button to save the changes.

ShipmentsPerRailcar

ShipmentCount divided by DailyRailcars.  Source: Calculated by RMS.  Format. 00.0

ShipmentsPerRecord

ShipmentCount divided by RecordCount.  Source: Calculated by RMS.  Format: 00.0

4.7.16 RMS Events

Provides a view with fields primarily oriented to events tracked by RMS for railcars; not to be confused
with sightings (CLM).  RMS events are when a railcar is activated, reactivated, added to a pool, or
removed from a pool.  The dataset is based mostly on the RMS Events in RMS.

List of fields

EventDate

Date of event.  Source: RMS Event.  Format: mm/dd/yyyy

EventDesc

Description of event.  Source:  RMS Event.  Format:  There are 4 options:

Assign railcar to pool
Remove railcar from pool
Activate railcar
Deactivate railcar

EventDttm

Date and time of event.  Source: RMS Event.  Format: mm/dd/yyyy hh:mm

EventTime

Time of event.  Source:  RMS Event.  Format: hh:mm

Pool

Railcar sub-fleet / pool to which the railcar belongs.  Source: Railcar

Railcar

Initial and Number of the equipment used for the shipment (XXXX 123456); there is always one space
between the initials and number with no trailing or leading spaces or zeros.  Note: This is not a good
field to use for sorting.  If you wish to sort by the railcar initial and number, it is recommended to use
the fields RailcarInitial and RailcarNumber.  Source:  Shipping Instruction
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RailcarInitial

Initial of the equipment used for the shipment.  Source:  Shipping Instruction

RailcarNumber

Number of the equipment used for the shipment.  Source:  Shipping Instruction

4.7.17 RMS Statistics

Retireves various statistics that are useful for monitoring RMS functions.

List of fields

Label

This will contain a description of the measurement. Measurements available are:

· Active Railcars - the number of railcars that are active currently
· Active Railcars from Prior Month - the number of railcars tht are currently active and that had

significant activity in the prior month
· Data file size (MB) - the size, in megabytes, of the main data file
· Log file size (MB) - the size, in megabytes, of the log file
· New sightings - the number of sighting records that have been imported so far today
· New waybills - the number of waybill records that have been imported so far today
· Sighting per railcar ratio - the number of sighting records imported for today divided by the number

of active railcars

Value

This will contain the value of the measurement.

The report will look like this:
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4.7.18 Round Trip Cycles

Provides a view with fields primarily oriented to the Cycle records in RMS.  However, this view links the
loaded cycle with its following empty cycle to show a complete round trip.  A cycle is a record created
by RMS that is derived from the sighting (CLM) records that are imported in RMS.  RMS derives these
records so that reports based on this type of information will open in a reasonable amount of time (i.e.
a few seconds to a few minutes).

List of fields

BOLDateLd

Date the load bill of lading was created (format: mm/dd/yyyy).  Source: Shipping Instruction

BOLDateMty

Date the empty bill of lading was created (format: mm/dd/yyyy).  Source: Shipping Instruction

BOLNumLd

Bill of lading number assigned to the load shipment by the shipper.  Source: Shipping Instruction

BOLNumMty

Bill of lading number assigned to the empty shipment by the shipper.  Source: Shipping Instruction

CareOfLd

Company name listed as the care of party by the shipper for the load shipment.  Source: Shipping
Instruction or if a match is made on a Party Alias, Party

CareOfMty

Company name listed as the care of party by the shipper for the empty shipment.  Source: Shipping
Instruction or if a match is made on a Party Alias, Party

CommodityLd

Description of the commodity carried in the railcar.  Source: Shipping Instruction unless it matches an
alias of a proprietary Commodity - in that case, it will display the proprietary Commodity Name.

ConsigneeLd

Company name listed as the consignee party by the shipper for the load shipment.  Source: Shipping
Instruction or if a match is made on a Party Alias, Party

ConsigneeMty

Company name listed as the consignee party by the shipper for the empty shipment.  Source: Shipping
Instruction or if a match is made on a Party Alias, Party

ContractNumLd

Number identifying the contract between the freight payor and the rail carrier for the load shipment. 
Source: Shipping Instruction



Custom Reports 100

© 1997 - 2019  Railcar Tracking Company a Division of Savage Services Corp.

ContractNumMty

Number identifying the contract between the freight payor and the rail carrier for the empty shipment. 
Source: Shipping Instruction

CPVSAPLd

If a railcar is constructively placed (CP) during a load trip cycle and then subsequently actually placed
(AP), this is the number of days between the two dates.  Source: Calculated by RMS: APDttm minus
CPDttm.  Format: 00.0

CPVSAPMty

If a railcar is constructively placed (CP) during an empty trip cycle and then subsequently actually
placed (AP), this is the number of days between the two dates.  Source: Calculated by RMS: APDttm
minus CPDttm.  Format: 00.0

DailyLeaseCost

Dollars per day required to lease a particular railcar.

DestLd

City / station where the shipment terminated for the load cycle.  Source: Cycle or if a match is made on
a Station Alias, Station.

DestMty

City / station where the shipment terminated for the empty cycle.  Source: Cycle or if a match is made
on a Station Alias, Station.

DestSPLCLd

SPLC (standard point location code - a 6 digit number identifying a station) for the load destination.
Source: Station.

DestSPLCMty

SPLC (standard point location code - a 6 digit number identifying a station) for the empty destination.
Source: Station.

HasBillingLd

True or False indicating whether the load cycle has a shipping instruction related / attached to it.
Source: RMS

HasBillingMty

True or False indicating whether the empty cycle has a shipping instruction related / attached to it.
Source: RMS

IsCompleteLd

True or False indicating whether the load cycle is complete (i.e. the RlseEndDate is not blank/null).
Source: RMS

IsCompleteMty
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True or False indicating whether the empty cycle is complete (i.e. the RlseEndDate is not blank/null).
Source: RMS

IsTransitOnTimeLd

True of False indicating wheter the load cycle transit time is less than or equal to the Standard Transit
(Days) that is entered for the matching stored Origin Destination (OD) Pair record.

IsTransitOnTimeMty

True of False indicating wheter the empty cycle transit time is less than or equal to the Standard
Transit (Days) that is entered for the matching stored Origin Destination (OD) Pair record.

IsValidLd

True or False indicating whether the load cycle is valid.  RMS considers a cycle valid if its origin and
destination matches a stored Origin Desitnation (OD) Pair record in RMS.  The location where the
railcar is actually placed must also match the location where it is subsequently released.

IsValidLd

True or False indicating whether the empty cycle is valid.  RMS considers a cycle valid if its origin and
destination matches a stored Origin Desitnation (OD) Pair record in RMS.  The location where the
railcar is actually placed must also match the location where it is subsequently released.

LabelLd

A one character code indicating that the load cycle has been identifyed by a user as:

B - Bad Cannot Repair
S - Special Causes
G - Good (Use is not recommended)

Source: Cycle

LabelMty

A one character code indicating that the empty cycle has been identifyed by a user as:

B - Bad Cannot Repair
S - Special Causes
G - Good (Use is not recommended)

Source: Cycle

LoadTime

The number of days it takes for the railcar to be loaded.  Source: Calculated by RMS:
RTCycleEndDttm minus APDttmMty (this field is not available).  Format: 00.0

MileageLd

Number of miles from the load origin to the load destination.  Source: OD Pair.  Format: 00.0

MileageMty

Number of miles from the empty origin to the empty destination.  Source: OD Pair.  Format: 00.0
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NetWeightLd

Weight of the lading.  Source: Shipping Instruction

OriginLd

City / station where the load cycle originated.  Source: Cycle or if a match is made on a Station Alias,
Station

OriginMty

City / station where the empty cycle originated.  Source: Cycle or if a match is made on a Station Alias,
Station

OriginSPLCLd

SPLC (standard point location code - a 6 digit number identifying a station) for the load origin.  Source:
Station.

OriginSPLCMty

SPLC (standard point location code - a 6 digit number identifying a station) for the empty origin.
Source: Station.

PoolCurrent

Railcar sub-fleet / pool that the railcar belongs to currently (Provided for backward compatibility).
Source: Railcar (Railcar Pool)

PoolLd

Railcar sub-fleet / pool that the railcar belonged to at the time of the load cycle.  Source: Railcar Pool

PoolMty

Railcar sub-fleet / pool that the railcar belonged to at the time of the empty cycle.  Source: Railcar Pool

Railcar

Initial and Number of the equipment used for the shipment (XXXX 123456); there is always one space
between the initials and number with no trailing or leading spaces or zeros.  Note: This is not a good
field to use for sorting.  If you wish to sort by the railcar initial and number, it is recommended to use
the fields RailcarInitial and RailcarNumber.  Source:  Cycle

RailcarInitial

Initial of the equipment used for the shipment.  Source:  Cycle

RailcarNumber

Number of the equipment used for the shipment.  Source:  Cycle

ReportGroup

Railcar grouping to which the railcar belongs.  Source: Railcar Report Group

RlseDateLd
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Date the railcar was released to start the load cycle. Source: Cycle.  Format: mm/dd/yyyy

RlseDttmLd

Date and time the railcar was released to start the load cycle.  Source: Cycle   Format: mm/dd/yyyy
hh:mm.

RTADttmLd

Requested date and time of arrival for load shipment.  Source: Shipping Instruction.  Format:
mm/dd/yyyy hh:mm

RTADttmMty

Requested date and time of arrival for empty shipment.  Source: Shipping Instruction.  Format:
mm/dd/yyyy hh:mm

RTCycle

A combination of the SegmentLd and SegmentMty.  Source: Calculated by RMS: OriginLd + ' to ' +
DestLd          OriginMty + ' to ' + DestMty       .
Format: Anywhere, NS to Somewhere, NA              Somewhere, NA to Anywhere, NA

RTCycleEndDate

The date that the round trip cycle ends.  This is the second loaded release date.  Source: Cycle.
Format: mm/dd/yyyy

RTCycleEndDttm

The date and time that the round trip cycle ends.  This is the second loaded release date and time.
Source: Cycle.  Format: mm/dd/yyyy hh:mm

RTCycleTime

Total number of days for the entire round trip.  Source: Calculated by RMS.  Format: 00.0

SegmentLd

A combination of the load origin and destination.  Source: Calculated by RMS: Origin + ' to ' +
Destination.  Format: Anywhere, NS to Somewhere, NA

SegmentMty

A combination of the empty origin and destination.  Source: Calculated by RMS: Origin + ' to ' +
Destination.  Format: Anywhere, NS to Somewhere, NA

ShipperLd

Company name listed as the Shipper party by the shipper for the load shipment.  Source: Shipping
Instruction or if a match is made on a Party Alias, Party

ShipperMty

Company name listed as the Shipper party by the shipper for the empty shipment.  Source: Shipping
Instruction or if a match is made on a Party Alias, Party
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STCCDescLd

A description related to the seven digit numeric code representing 38 commodity groupings for the load
shipment.  Source: RMS Commodities

STCCLd

A seven digit numeric code representing 38 commodity groupings for the load shipment.  Source:
Shipping Instruction

TransitTimeLd

Number of days of transit time while loaded.  Source: Calculated by RMS: APDttmLd (not available)
minus RlseDttmLd.  Format: 00.0

TransitTimeMty

Number of days of transit time while empty.  Source: Calculated by RMS: APDttmMty (not available)
minus RlseDttmMty (not available).  Format: 00.0

UnloadTime

The number of days it takes for the railcar to be unloaded.  Source: Calculated by RMS: RlseDttmMty
(not available) minus APDttmLd (not available).  Format: 00.0

WaybillDateLd

Date the load waybill was created.  Source:  Shipping Instruction

WaybillDateMty

Date the empty waybill was created.  Source:  Shipping Instruction

WaybillNumLd

Waybill number assigned to the load shipment by the rail carrier.  Source:  Shipping Instruction

WaybillNumMty

Waybill number assigned to the empty shipment by the rail carrier.  Source:  Shipping Instruction

4.7.19 Shipping Instructions (formerly Bills)

Provides a view with fields primarily oriented to the Shipping Instruction records in RMS.  A shipping
instruction is either a bill of lading or waybill.

List of fields

AARCarType
Type of railcar using the AAR type codes. For more information about type codes, see Exhibit D,
Section IX of the AAR Equipment Register.

BOLDate
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Date the bill of lading was created (format: mm/dd/yyyy).  Source: Shipping Instruction

BOLDttm

Date and time bill of lading was created (format: mm/dd/yyyy hh:mm).  Source: Shipping Instruction

BOLNum

Bill of lading number assigned to the shipment by the shipper.  Source: Shipping Instruction

CareOfAddress1

First line of address of care of party.  Source: Shipping Instruction

CareOfAddress2

Second line of address of care of party.  Source: Shipping Instruction

CareOfCIF

Care of party customer identification file code number.  Source: Shipping Instruction

CareOfCity

City location of Care of party.  Source: Shipping Instruction

CareOfFState

State location of Care of party.  Source: Shipping Instruction

CareOfPostalCode

Postal code of Care of party.  Source: Shipping Instruction

CareOfCountryCode

Country code of Care of party.  Source: Shipping Instruction

CareOfName

Company name listed as the care of party by the shipper.  Source: Shipping Instruction or if a match is
made on a Party Alias, Party

Commodity

Description of the commodity carried in the railcar.  Source: Shipping Instruction unless it matches an
alias of a proprietary Commodity - in that case, it will display the proprietary Commodity Name.

ConsigneeAddress1

First line of address of consignee party.  Source: Shipping Instruction

ConsigneeAddress1

Second line of address of consignee party.  Source: Shipping Instruction
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ConsigneeCIF

Consignee party customer identification file code number.  Source: Shipping Instruction

ConsigneeCity

City location of consignee party.  Source: Shipping Instruction

ConsigneeCountryCode

Country code of Consignee party.  Source: Shipping Instruction

ConsigneeName

Company name listed as the consignee party by the shipper.  Source: Shipping Instruction or if a
match is made on a Party Alias, Party

ConsigneePostalCode

Postal code of Consignee party.  Source: Shipping Instruction

ConsigneeState

Two character state abbreviation location of consignee party.  Source: Shipping Instruction

Contract
Number identifying the contract between the freight payor and the rail carrier.  Source: Shipping
Instruction

Correction
Code representing a correction to the shipping instruction.  (Example: AI = Addidtional Information; CO
= Correction) Source: Shipping Instruction

DestCity
City / station where the shipment is to terminate.  Source: Shipping Instruction or if a match is made on
a Station Alias, Station

DestState
State / station where the shipment is to terminate.  Source: Shipping Instruction or if a match is made
on a Station Alias, Station

Destination
City / station (Format: City, ST) where the shipment is to terminate.  Source: Shipping Instruction or if a
match is made on a Station Alias, Station

DocCreated

Date that the shipping instruction electronic document was created.  Source: Shipping Instruction

FreightPayerCIF

Freight payer party customer identification file code number.  Source: Shipping Instruction

FreightPayerName

Company name listed as the party that is paying the freight charges.  Source: Shipping Instruction or if
a match is made on a Party Alias, Party
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GrossWeight

Total weight of the shipment including the weight of the railcar and lading.  Source: Shipping Instruction

HazClass

The hazardous classification corresponding to the shipping name of the hazardous commodity. 
Source: Shipping Instruction

HazEmergencyContact

Contact name. Source: Shipping Instruction

HazEmergencyTelephone

Communications number including country or area code when applicable.  Source: Shipping Instruction

HazIndustryCode

Code indicating a code from a specific industry code list.  Source: Shipping Instruction

HazPackingGrpCode

Code indicating degree of danger in terms of Roman number I, II or III.  Source: Shipping Instruction

HazPageNumber

The United Nations page number as required for the international transport of hazardous materials.
Source: Shipping Instruction

HazResidue

Code indicating that the shipment is not a loaded movement but contains a residue from a prior
movement. Source: Shipping Instruction

HazShippingName

The proper shipping name of the hazardous commodity as specified by Title 49 Code of the Federal
Regulations, or the shipping name of the dangerous good as defined in the Canadian Transportation of
Dangerous Goods Act and Regulations, or the international regulations as promulgated by the United
Nations.

HazSTCC

Code describing a commodity or group of commodities. Source: Shipping Instruction

HazUNNAIDCode

Code identifying the hazardous material identification number as required by Title 49 of the code of
Federal Regulators. UN/NA stands for United Nations/North America. Source: Shipping Instruction

Imported

Date and time that the shipping instruction was inserted into the RMS database. Source: RMS

IsAttached
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True or False indicating whether the record has been assigned to an existing trip cycle record.  Source:
RMS

IsDuplicate

True or False indicating whether there is another record that is already assigned to a trip cycle record
that this record should be assigned to.  Source: RMS

LE

Indicates whether the shipment is for a railcar that is empty (E) or loaded (L).  Source: Shipping
Instruction

LEDesc

Indicates whether the shipment is for a railcar that is empty (EMPTY) or loaded (LOAD).  Source:
Shipping Instruction

Modified

Date / time when the record was last modified. Source: Shipping Instruction (RMS)

NetWeight

Weight of the lading.  Source: Shipping Instruction

OrderInDttm

Date and time the railcar was ordered in to be actually placed at the consignee/care of party's industry.
Source: Shipping Instruction (manual entry)

Origin

City / station (Format: City, ST) where the shipment originated.  Source: Shipping Instruction or if a
match is made on a Station Alias, Station

OriginCity

City where the shipment originated. Source: Shipping Instruction or if a match is made on a Station
Alias, Station

OriginState

City where the shipment originated. Source: Shipping Instruction or if a match is made on a Station
Alias, Station

PaymentMethod

Code identifying payment terms for transportation charges. 11 - Rule 11; CC - Collect; NC - No
Charge; NR - Non Revenue; PP - Prepaid (by Seller).  Source:  Shipping Instruction

PickupFrom

The party at the physical location where the shipment is to be picked up. Source: Shipping Instruction

PickupFromAddress1
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First line of address of Pickup From party.  Source: Shipping Instruction

PickupFromAddress2

Second line of address of Pickup From party.  Source: Shipping Instruction

PickupFromCIF

Pickup From party customer identification file code number.  Source: Shipping Instruction

PickupFromCity

City location of Pickup From party.  Source: Shipping Instruction

PickupFromState

State location of Pickup From party.  Source: Shipping Instruction

PickupFromPostalCode

Postal code of Pickup From party.  Source: Shipping Instruction

PickupFromCountryCode

Country code of Pickup From party.  Source: Shipping Instruction

PONUm

Displays the purchase order number that was entered on the bill of lading.  Source: Shipping
Instruction

Pool

Railcar sub-fleet / pool that the railcar belonged to at the time of this shipment.  Source: Railcar Pool

Railcar

Initial and Number of the equipment used for the shipment (XXXX 123456); there is always one space
between the initials and number with no trailing or leading spaces or zeros.  Note: This is not a good
field to use for sorting.  If you wish to sort by the railcar initial and number, it is recommended to use
the fields RailcarInitial and RailcarNumber.  Source:  Shipping Instruction

RailcarInitial

Initial of the equipment used for the shipment.  Source:  Shipping Instruction

RailcarNumber

Number of the equipment used for the shipment.  Source:  Shipping Instruction

ReportGroup

Railcar grouping to which the railcar belongs.  Source: Railcar Report Group

Route
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Includes SCAC abbreviations of railroads that are involved in the shipment and Rule 260 junction
abbreviations indicating interchange points.  Source:  Shipping Instruction

RTADttm
Requested time of arrival date and time. This is a date/time that the shipment is requested by the
consignee to arrived. Source: Shipping Instruction hand entered or may be imported automatically from
a text file.

SenderCode

Indicates the organization that sent the shipping instruction electronic document to RMS.  Source:
Shipping Instruction

ShipFrom

This party at the actual origin location physically originating a shipment.  Source: Shipping Instruction

ShipFromCIF

Ship from party customer identification file code number.  Source: Shipping Instruction

ShipFromAddress1

First line of address of Ship From party.  Source: Shipping Instruction

ShipFromAddress2

Second line of address of Ship From party.  Source: Shipping Instruction

ShipFromCity

City location of Ship From party.  Source: Shipping Instruction

ShipFromCountryCode

Country code of Ship From party.  Source: Shipping Instruction

ShipFromPostalCode

Postal code of Ship From party.  Source: Shipping Instruction

ShipFromState

State location of Ship From party.  Source: Shipping Instruction

ShipmentDesc

User maintained field of up to 30 alpha numeric characters. May also be imported automatically using
the ISG System.  Source: Shipping Instruction.

ShipmentID

User maintained field of up to 6 alpha numeric characters. May also be imported automatically using
the ISG System.  Source: Shipping Instruction.

ShipperAddress1
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First line of address of Shipper party.  Source: Shipping Instruction

ShipperAddress1

Second line of address of Shipper party.  Source: Shipping Instruction

ShipperCIF

Shipper party customer identification file code number.  Source: Shipping Instruction

ShipperCity

City location of Shipper party.  Source: Shipping Instruction

ShipperCountryCode

Country code of Shipper party.  Source: Shipping Instruction

ShipperPostalCode

Postal code of Shipper party.  Source: Shipping Instruction

ShipperName

Company name listed as the Shipper party by the shipper.  Source: Shipping Instruction or if a match is
made on a Party Alias, Party

ShipperState

Two character state abbreviation location of Shipper party.  Source: Shipping Instruction

Source

Indicates where the shipping instruction came from.  Source: RMS

STCC

A seven digit numeric code representing 38 commodity groupings.  Source: Shipping Instruction

STCCDesc

A description related to the seven digit numeric code representing 38 commodity groupings.  Source:
RMS Commodities

TareWeight

Weight of the railcar unloaded. Source: Railcar.

TransMethod

X - Intermodal; R - Railcar

UserField1

User maintained field of up to 50 alpha numeric characters. Source: Shipping Instruction.

UserField2
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User maintained field of up to 50 alpha numeric characters. Source: Shipping Instruction.

UserField3

User maintained field of up to 4000 alpha numeric characters. Source: Shipping Instruction.

WaybillDate

Date the waybill was created.  Source:  Shipping Instruction

WaybillNum

Waybill number assigned to the shipment by the rail carrier.  Source:  Shipping Instruction

4.7.20 Sightings

Provides a view with fields primarily oriented to where the railcar was reported.  The dataset is based
mostly on the Sighting records in RMS.

List of fields

City

Station city where the railcar was reported (i.e. the location of bad order).  Source:  Sighting or if a
match is made on a Station Alias, Station.  Format: Mycity.

CityState

Station city and state where the railcar was reported (i.e. the location of bad order).  Source:  Sighting
or if a match is made on a Station Alias, Station.  Format: Mycity, NA.

Comments

Up to 4 characters that may be entered by the user when inserting or updating a sighting record.
Source: Sighting

DestCity

City / station where the shipment is to terminate.  Source: Sighting or if a match is made on a Station
Alias, Station.

Destination

City and state / station where the shipment is to terminate.  Source: Sighting or if a match is made on a
Station Alias, Station.  Format: Mycity, NA

DestState

Two character state abbreviation where the shipment is to terminate.  Source: Sighting or if a match is
made on a Station Alias, Station.

ETARRCity

City name for which the ETA is provided.  Source: Sighting (Note: CLM Format H is the sighting format
that will provide this). Typically this ETA is from the railroad.
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ETARRDttm

Date and time that the railcar is estimated to arrive at the final destination according to the railroad.
Source: Sighting (Note: CLM Format H is the sighting format that will provide this).  Format:
mm/dd/yyyy hh:mm

ETARREvent

Sighting event code for which the ETA is provided.  Source: Sighting (Note: CLM Format H is the
sighting format that will provide this). This event code is usually either J, which means Interchange
Delivery or Z, which means Placement Actual. Format: J = interchange delivery; D = arrival final
destination; Z = placement actual

ETARREventDesc

Sighting event description for which the ETA is provided.  Source: Sighting (Note: CLM Format H is the
sighting format that will provide this). This event is usually either Interchange Delivery or Placement
Actual.

ETARRState

State name for which the ETA is provided.  Source: Sighting (Note: CLM Format H is the sighting
format that will provide this). Typically this ETA is from the railroad.

ETARRType

If sighting data is gotten from Steelroads or Railinc, and the ETA is provided by the same, this field
may have a value of P, which means Predictive, which means that the ETA has been estimated based
on similar historical transit moves. This means that the railroad did not provide an ETA to Steelroads or
Railinc.  Source: Sighting (Note: CLM Format H is the sighting format that will provide this).

Event

One character code identifying the event last performed on the railcar.  Source: Sighting.  Format:  See
Event Codes in the Glossary

EventDate

When the event last performed on the railcar happened.  Source:  Sighting.  Format:  mm/dd/yyyy

EventDesc

Phrase describing the event last performed on the railcar.  Source: Event Descriptions.  Format:  See
Event Codes in the Glossary

EventDttm

When the event last performed on the railcar happened.  Source:  Sighting.  Format:  mm/dd/yyyy
hh:mm

EventTime

When the event last performed on the railcar happened.  Source:  Sighting.  Format:  hh:mm:ss am/pm

IsCarTemp

Indicates whether the railcar is a Temporary fleet assignment.  Source: Railcar.  Format: True or False
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LE

Indicates whether the shipment is for a railcar that is empty (E) or loaded (L).  Source: Shipping
Instruction

LEDesc

Indicates whether the shipment is for a railcar that is empty (EMPTY) or loaded (LOAD).  Source:
Shipping Instruction

Modified

Date / time when the record was last modified. Source: Sighting (RMS)

Pool

Railcar sub-fleet / pool to which the railcar belongs.  Source: Railcar Pool

Railcar

Initial and Number of the equipment used for the shipment (XXXX 123456); there is always one space
between the initials and number with no trailing or leading spaces or zeros.  Note: This is not a good
field to use for sorting.  If you wish to sort by the railcar initial and number, it is recommended to use
the fields RailcarInitial and RailcarNumber.  Source:  Shipping Instruction

RailcarInitial

Initial of the equipment used for the shipment.  Source:  Shipping Instruction

RailcarNumber

Number of the equipment used for the shipment.  Source:  Shipping Instruction

Railroad

SCAC railroad abbreviation for the railroad which last reported the location of the railcar.  Source:
Sighting

SightingID

Unique identifier of sighting record.  Used mostly by RMS.  Source:  Sighting (RMS).  Format: 00

Source

Three character abbreviation indicating the source of the sighting record.  Source:  Sighting (RMS).

State

Two character state abbreviation where the railcar was reported.  Source: Sighting or if a match is
made on a Station Alias, Station.

TrainID

Identifier of the train that the railcar is in.  Source: Sighting.



Railcar Management System Help115

© 1997 - 2019  Railcar Tracking Company a Division of Savage Services Corp.

4.7.21 Railcar Leases

Provides a view with fields primarily oriented to railcars and their respective characteristic and lease
information.  The dataset is based mostly on the Railcar records in RMS, but also gets lease
information from the Railcar Lease records.

List of fields

AARType

Code indicating the type of railcar.  Association of American Railroads (AAR) standard.  Source:
Railcar  Format: Alpha Numeric 4 characters maximum

BuildDate

When the railcar was built.  Source: Railcar  Format: Date Time - mm/dd/yyyy

Class

An additinional code for railcar classification. Source: Railcar  Format: Alpha Numeric 12 characters
maximum

ContractNumber

Lease contract number.  Source: Railcar Lease

ContractNumberSub

Sublease contract number.  Source: Railcar Sublease

EffectiveDate

When the lease contract period began.  Source:  Railcar Lease

EffectiveDateSub

When the sublease contract period began.  Source:  Railcar Sublease

ExpirationDate

When the lease contract period ended.  Source:  Railcar Lease

ExpirationDateSub

When the sublease contract period ended.  Source:  Railcar Sublease

Height

Height of railcar.  Source:  Railcar. Format: 00

IsCarInactive

Indicates whether the railcar is inactive (in RMS).  Source:  Railcar  Format: True or False

IsCarLeased
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Indicates whether the railcar is leased.  Source: Railcar Lease.  Format: True or False

IsCarOwned

Indicates whether the railcar is leased.  Source: Railcar.  Format: True or False

IsCarSubleased

Indicates whether the railcar is subleased. Source: Railcar Sublease. Format: True or False

IsCarTemp

Indicates whether the railcar is a Temporary fleet assignment.  Source: Railcar.  Format: True or False

IsLeaseInactive

Indicates whether the lease contract is inactive.  Source:  Railcar Lease  Format: True or False

IsSubleaseInactive

Indicates whether the sublease contract is inactive.  Source:  Railcar Sublease  Format: True or False

LeaseTypeDesc

Describes the type of lease.  Source: Railcar Lease.

Length

Length of railcar.  Source: Railcar.  Format: 00

Lessor

Name of company that is providing the leased railcars.  Source: Railcar Lease.

Lessee

Name of company that is leasing the subleased railcars.  Source: Railcar Sublease.

LoadFee

Rarely used. Dollar amount indicating an amount of money provided to the lessee for each railcar
assigned to the lease that is loaded during a particular period.  Source:  Railcar Lease.  Format:
Currency 00.00

LoadFeeSub

Rarely used. Dollar amount indicating an amount of money provided to the lessee for each railcar
assigned to the sublease that is loaded during a particular period.   Source:  Railcar Sublease.  Format:
Currency 00.00

LoadLimit

The maximum product weight allowed for the particular railcar type. Can be pounds or kilograms.
Source: Railcar  Format: Numeric with no decimal 000000

MonthlyRate
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Dollar amount indicating the payment required to lease each railcar.  Source:  Railcar Lease.  Format:
00.00

MonthlyRateSub

Dollar amount indicating the payment required to sublease each railcar.  Source:  Railcar Sublease.
Format: 00.00

Pool

Railcar sub-fleet / pool to which the railcar belongs.  Source: Railcar

Railcar

Initial and Number of the equipment used for the shipment (XXXX 123456); there is always one space
between the initials and number with no trailing or leading spaces or zeros.  Note: This is not a good
field to use for sorting.  If you wish to sort by the railcar initial and number, it is recommended to use
the fields RailcarInitial and RailcarNumber.  Source:  Shipping Instruction

RailcarInitial

Initial of the equipment used for the shipment.  Source:  Shipping Instruction

RailcarNumber

Number of the equipment used for the shipment.  Source:  Shipping Instruction

ReportGroup

Railcar grouping to which the railcar belongs.  Source: Railcar Report Group

RetireDate

When the railcar was retired.  Source: Railcar  Format: mm/dd/yyyy

ShellCapacity

Shell capacity for each particular railcar.  Source:  Railcar  Format: 00

SubleaseType

Describes the type of sublease.  Source: Railcar Sublease.

TareWeight

Weight of the empty railcar. Source Railcar. Format: 00

UserField1

Can be used for any entry that the user wants. Source: Railcar  Format: up to 30 alpha or numeric
characters

UserField2

Can be used for any entry that the user wants. Source: Railcar  Format: up to 4,000 alpha or numeric
characters
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Width

Width of railcar.  Source:  Railcar. Format: 00

5 Daily Reports

These reports are designed to identify railcars that are at risk of not making their intended destination
in an acceptable time frame. They are mainly based on the last reported sighting for each active
railcar.

5.1 Bad Orders

Description:
RMS determines which railcars are currently in bad order status.  Elapsed time in BO status as well as
the location where the railcar was placed in BO status is included.

Step by step instructions:
1. Click the Daily Reports menu and click the View Report link.
2. The Filter Builder will display that will allow you to select some simple filters. For more advanced

filtering, click on Advanced Filter tab. For unlimited filtering capabilities, click on the Custom
Expression Filter tab.

3. Click the View Report command button.

5.2 Demurrage - Railroad In Progress

Description:
Using the Railroad Demurrage/Detention Criteria, RMS determines which railcars are currently
incurring demurrage. There is also a setting on the Filter Builder that enables the viewing of railcars
that will incur demurrage soon.

Step by step instructions:
1. Click the Daily Reports menu.
2. Click the View Report link.
3. The Filter Builder will display that will allow you to select some simple filters. It opens with the most

common type of filter already selected. The Demurrage Status filter is chosen to show railcars that
are currently incurring demurrage; there is no date range indicated because it is assumed that only
incomplete - cycles in progress will be displayed; the Cycle filter has incomplete selected; the
Railcar Status filter is set to only show Active railcars (it is possible for a inactive railcar to have an
incomplete cycle if it was deactivated in the middle of a cycle). The Quick Filter (cont.) tab and the
Advanced Filter tab provide additional filtering possibilities; for unlimited filtering, use the Custom
Expression Filter.

4. Click the View Report button.
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5.3 Inbound Railcars

Description:
Displays all railcars that are either in transit or at a particular destination.  It is grouped primarily by
destination and secondarily by cycle status (i.e. "At Destination" or "In Transit"). 

Step by step instructions:
1. Click the Daily Reports menu; click the View Report link.
2. The Filter Builder will display that will allow you to select some simple filters. For more advanced
filtering, click on Advanced Filter tab. For unlimited filtering capabilities, for unlimited filtering, use the
Custom Expression Filter.
3. Click the View Report button.

5.4 Last Sighting - various

Description:
By Destination – same as above except is sorted by the city and state that the railcar is destined.
By Elapsed Time – displays the last event and location of a railcar that was reported by a railroad and
sorts it by the number of days that have elapsed since that reporting in descending order.
By Last Location – same as above except is grouped by the last city and state in which the railcar was
reported.
By Pool – same as above except is grouped by the pool of which the railcar belongs.
By Pool Summary - only shows the subtotals.
By Railcar – same as above except is sorted by railcar initials and number.

Step by step instructions:
1. Click the Daily Reports menu and click the View Report link adjacent to the report that you wish to

view.
2. The Filter Builder will display that will allow you to select some simple filters. For more advanced

filtering, click on Advanced Filter tab. For unlimited filtering capabilities, use the Custom
Expression Filter.

3. Click the View Report button.

5.5 Railcar history view and report

Description:
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Lists all sightings (CLMs) for the selected railcar sorted by date in descending order.  Only those
sightings are displayed that happened between the Start and End dates listed for the Historical Period. 
The default setting for these dates is the last 30 days.  You can change either or both of these dates on
the Home window or on the Filter Builder when it displays.

Step by step instructions:
1. Click the Daily Reports menu and click the View Report link adjacent to Railcar History.
2. The Filter Builder will display that will allow you to select some simple filters. For more advanced

filtering, click on Advanced Filter tab. For unlimited filtering capabilities, click the Custom
Expression tab.

3. Click the View Report button.

6 Management reports

About Management Reports

These reports are designed to summarize the historical movements of railcars to shed light on how rail
carriers have been performing over specific periods of time.

Management Report Criteria

Various management reports (reports launched from the Management Reports window), require
criteria to run.  If the proper criteria is not entered, RMS will prompt the user what criteria is required. 
To determine what criteria is required for each report, refer to the section on each report.

6.1 Bad Order Activity by Railroad

Description:
Displays all bad order activity by railroad for a user-specified period of time.

Step by step instructions :
1. Click the Management Reports menu; click the View Report link adjacent to Bad Order Activity by
Railroad.
2. The Filter Builder will display that will allow you to select some simple filters. For more advanced
filtering, click on Advanced Filter tab. For unlimited filtering capabilities, click the Custom Expression
tab.
3. Click the View Report button.

6.2 Bad Order Duration by Railroad

Description:
Displays the duration of completed bad orders by railroad for a user-specified period of time.

Step by step instructions :
1. Click the Management Reports menu; click the View Report link adjacent to Bad Order Duration by
Railroad.
2. The Filter Builder will display that will allow you to select some simple filters. For more advanced
filtering, click on Advanced Filter tab. For unlimited filtering capabilities, click the Custom Expression
tab.
3. Click the View Report button.
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6.3 Demurrage - Proprietary by Month

Criteria that determines the demurrage charge are entered on the
Proprietary Demurrage/Detention Criteria window. This report is designed for RMS users who own or
lease railcars and want to manage how long other organizations hold on to their railcars for
unloading/loading. This report differs from the Demurrage - Proprietary by Party and Demurrage -
Proprietary by Station reports in that is calculates demurrage by a specific month provided by the user
at run time. For example, if the user provides a date of 10/1/2018 as the PeriodBeginDate, then RMS
will calculate and display only demurrage that was incurred in the month of October, 2018. If there was
a railcar that incurred some demurrage in September, 2018 and wasn't released empty until October
15, 2018, then the amound of demurrage that this dataset returns is from 10/1/2018 through
10/15/2019. It is assumed that the user ran this dataset-based report for September 1, 2018 last month
and any demurrage charges in September were displayed on that report.

NOTE: Some assembly required. You will need to create the report from the existing dataset by
following the instructions below. In a future release, there will be a finished report that you can use or
clone.

Step by step instructions to create and use the report.
1. Click the Custom Reports menu and click the New Custom Report button.
2. Click the Demurrage Proprietary by Month dataset link.
3. Select the fields and configure them as shown below.

The formula for the field aliased DemBegin: CASE WHEN  PlacedDate >  PeriodBeginDate THEN
DATEADD(DAY,1,PlacedDate) ELSE PeriodBeginDate END

The formula for the field aliased DemEnd: CASE WHEN DemurrageEndDate < DATEADD(DAY,-
1,dateadd(MONTH, 1, PeriodBeginDate)) THEN  DemurrageEndDate ELSE DATEADD(DAY,-
1,dateadd(MONTH, 1, PeriodBeginDate)) END
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4. Click the Title tab and enter Demurrage Proprietary by Month (or whatever title you would like).
5. Click the Filter tab and select PeriodBeginDate from the Field drop down text box; select = from the
Operator drop down text box; enter a date that represents the first day of the month that you would like
to include on the report. NOTE the report will only provide a singe month on the report.
6. Click the Insert link.
7. Click the Save and View Report button.
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6.4 Demurrage - Proprietary by Party

Description: 
Displays the accrued detention in days and associated fees over a designated historical period.  The
report is grouped and sorted by responsible party, which is the organization that is receiving the
shipment.  This is usually the consignee, but it there is a care-of party designated on the bill, then they
are the responsible party.

Required table entries: 
You must enter a Demurrage > Proprietary record, which requires a Station entry with all applicable
aliases and a responsible party (Party) entry with all applicable aliases.  You must also have a Shipping
Instruction for each shipment that you want to show up on the report. If you are not importing or
entering Shipping Instructions, then you may use the Detention History by Station report.

Step by step instructions :
1. Click the Management Reports menu; click the View Report link adjacent to Demurrage-

Proprietary by Responsible Party.
2. The Filter Builder will display that will allow you to select some simple filters. For more advanced
filtering, click on Advanced Filter tab. For unlimited filtering capabilities, click the Custom Expression
tab.
3. Click the View Report button.

6.5 Demurrage - Proprietary by Station

Description: 
Displays the accrued detention in days and associated fees over a designated historical period.  The
report is grouped and sorted by Destination.

Required table entries: 
You must enter a Demurrage > Proprietary record, which requires a Station entry with all applicable
aliases. 

Step by step instructions :
1. Click the Management Reports menu; click the View Report link adjacent to Demurrage -

Proprietary by Station.
2. The Filter Builder will display that will allow you to select some simple filters. For more advanced
filtering, click on Advanced Filter tab. For unlimited filtering capabilities, click the Custom Expression
tab.
3. Click the View Report button.

6.6 Demurrage - Railroad by Station

Description:

Using the Railroad Demurrage/Detention Criteria, RMS determines which railcars have incurred
demurrage.
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Step by step instructions:

1. Click the Management Reports menu; click the View Report link adjacent to Demurrage - Railroad
by Station.

2. The Filter Builder will display that will allow you to select some simple filters. It opens with the most
common type of filter already selected. The Demurrage Status filter is set to "HAS INCURRED", the
date range is filled in for the last 30 days, the date range is applied to when the cycle ended (release
end date), Cycle filter has all selected to display both incomplete and complete cycles; the Railcar
Status filter is set to show All railcars. The Quick Filter (cont.) tab and the Advanced Filter tab provide
additional filtering possibilities. For unlimited filtering capabilities, click the Custom Expression tab.

NOTE: If you wish to see demurrage estimates for a railroad that provides credits for railcars that were
loaded / unloaded faster than the acceptable days provided by the railroad, then you will want to
remove the Demurrage Status filter.

3. Click the View Report button.

6.7 Last Sighting History

This report will be helpful if you want to see the latest location of railcars on any given day for up to the
last 45 days. NOTE: This report can take a long time to run. For examle, if a Last Sighting by Railcar
report takes 5 seconds to run, this report with a filter that will display the last 30 days of last sightings,
will take approximately 30 * 5 seconds = 150 seconds or 2.5 minutes since it is performing an
individual query for each AnalysisDate. If the date range is 1/1/2016 to 1/31/2016 then the first
AnalysisDate would be 1/1/2016 and the system will query the database to determine which railcars
were active on that day and their latest reported sighting before 11:59pm of the AnalysisDate. This
report is based on the Last Sightings History dataset.

NOTE: If this report fails to display and returns an error, it most likely has timed out. It this case, clone
the report and schedule it to run in the evening.

NOTE: To use this report to determine the number of railcars in a serving area, something required for
Union Pacific demurrage estimation, go here.

NOTE: To use this report to determine the number of railcars at industry, something required for Union
Pacific demurrage estimation, go here.

To run this report, follow these step by step instructions:

1. Click on the Management Reports menu.
2. Click the View Report link next to the Last Sighting History report label.
3. Adjust the filter. When the Quick Filter displays, remove the Event Date filter dates; click the
Advanced Filter tab; select the AnalysisDate field; select the Between Operator; enter the begin date
and end date Values; click the Insert link.
4. Click the View Report button and when prompted that you are running the report with little filtering,
click the Yes button and your results will look like this:
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The date in bold with a grey background is the AnalysisDate and the records within the AnalysisDate
group will show each railcar that was active on that day and its latest sighting as of 23:59 that day.

6.8 Pool Changes

When a railcar is assigned to a pool for the first time or from one pool to another, a Pool Change
record is generated in the Event Logs.  These changes are summarized in this report.

Step by step instructions:
1. Click the Management Reports menu; click the View Report link adjacent to Pool Changes.
2. The Filter Builder will display that will allow you to select some simple filters. For more advanced
filtering, click on Advanced Filter tab. For unlimited filtering capabilities, click the Custom Expression
tab.
3. Click the View Report button.

6.9 Railcar Utilization

Railcar Utilization Summary
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Railcar Utilization

These reports are designed to provide an effective means to understand how much use you have
gotten out of your railcar assets.

It combines a shipment summary (i.e. the number of shipments for a specified period with the daily
average number of railcars and their load / empty / empty at origin status for a given time period.

Average Number of Shipments per Railcar calculation

These two measurements are used together to determine the average number of shipments per railcar
over a given time frame for each pool and the overall fleet.  For example, say we want to compare our
railcar utilization for the month of May 2013 to the same month a year ago to determine if the fleet is
being utilized better. Run the Railcar Utilization Summary report for May 1, 2012 to May 31, 2012 and
then run the same report for May 1, 2013 to May 31, 2013.  Often, the number of railcars in your fleet
will be different than a year ago: railcars are added and/or removed.

# shipments May 2012 = 125
Avg. # railcars May 2012 = 99           
Avg. # shipments per railcar = 125/99 = 1.26

# of shipments in May 2013 = 140                   
Average # of railcars in May 2013 = 120         
Avg. # of shipments per railcar = 125/99 = 1.17

This example shows a common situation.  Even though more shipments were performed in May, 2013
than in May, 2012, the actual utilization of the railcar fleet was less.

Step by step instructions:
1. Click the Management Reports menu; click the View Report link adjacent to Railcar Utilization
Summary or Railcar Utilization, which is the same report except that is shows the detail records in
addition to the summary.
2. On the Advanced Filter tab screen, select Analysis Date from the Field drop down text box, select
" Between " from the Operator drop down text box; enter the beginning date of the time period in the
first Value text box and enter the ending date of the time period in the secon Value text box. For
unlimited filtering capabilities, click the Custom Expression tab.
3. Click the View Report button.

Note: There are several properties that determine the data that is returned on these reports. Click on
the Data Management > Report Properties menu. You can choose whether the count of shipments is
based on the ship date or cycle completion date (release event that ends the cycle). You can also set
the Analysis Interval (Days). This tells RMS how often to check the active/inactive and pool status of
each railcar. The smaller the interval, the more accurate the report will be. However, the report will run
much longer. If your railcars rarely change pools and there are not many additions, deactivations, then
a larger interval such as 7 days may be enough to provide accurate results with a much shorter run
time.



Railcar Management System Help127

© 1997 - 2019  Railcar Tracking Company a Division of Savage Services Corp.

Note: For larger fleets (500 +) this report may take several minutes and may be better run via the
Scheduler during non-working hours and exported to a file or emailed as an attachment. See
Setting Up Automatic Delivery of Custom Reports for instructions on how to do this. If you clone these
reports, when you click on the Save / Preview 1st 100 only button, it will not display any records. This is
due to the long time it would take to do this for larger fleets. We understand that this makes it more
difficult to perfect the layout. However, the report layout really can't be changed since there are scripts
that run in the layout file itself. Therefore, you can only change the Title and Filters, so a layout preview
is not really necessary.

Note: Normally, you would want railcar utilization to be measured for only the railcars that you own or
lease (i.e. Permanent railcars). This report will return the utilization for all railcars, Permanent and
Temporary because the system does not keep records indicating when a railcar was in Permanent /
Temporary status. However, when RMS adds Temporary railcars (and RMS should add Temporary
railcars - you should rarely add Temporary railcars yourself), it always adds them to the System Cars
pool. It is recommended that you always keep Temporary railcars in the System Cars pool and never
add Permanent railcars to the System Cars pool. This way, you can include a filter when running this
report to exclude railcars that were in the System Cars pool during the analysis period.

Here is an example of what this type of filter would look like:

6.10 Shipping Instructions Detail

This report is designed to show most of the key information from a shipping instruction on a single
page.

Step by step instructions:
1. Click on the Management Reports menu
2. Click on the View Report link adjacent to the Shipping Instructions Detail label
3. When the Filter Builder displays, select the filters needed and then click on the View Report button
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6.11 Trip Cycles - Load-Unload Performance

Description:
This report is very similar to the Demurrage - Proprietary by Station report except that it includes
performance measurements for stations that do not necessarily have a Demurrage - Proprietary
criteria record associated with them. If a station does have Demurrage - Proprietary criteria entered,
then that information is utilized in this report.

Step by step instructions:
1. Click the Management Reports menu; click the View Report link adjacent to Cycles - Load-Unload
Performance.
2. The Filter Builder will display that will allow you to select some simple filters. For more advanced
filtering, click on Advanced Filter tab. For unlimited filtering capabilities, click the Custom Expression
tab.
3. Click the View Report button.
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6.12 Trip Cycles - Round Trips

For backward compatibility with RMS 3.X, a few reports are made available that show a complete
round trip comprised of a load and empty cycle. A round trip cycle begins with a load release and ends
with the subsequent load release. What starts one round trip cycle, ends the prior round trip cycle.

Round Trip by Pool Summary

Results are displayed grouped by railcar pool and excludes detail records, so only the pool and the
summary information are displayed.

Round Trip by Pool

Results are displayed grouped by railcar pool.

Round Trip by Route Summary

Results are displayed grouped by the load origin destination pair and empty destination pair and
excludes detail records.

Round Trip by Route

Results are displayed grouped by the load origin destination pair and empty destination pair.

Step by step instructions:
1. Click the Management Reports menu; click the View Report link adjacent to Trip Cycles - Round
Trip by...
2. The Filter Builder will display that will allow you to select some simple filters. For more advanced
filtering, click on Advanced Filter tab. For unlimited filtering capabilities, click the Custom Expression
tab.
3. Click the View Report button.

6.13 Trip Cycles - Segments Detail

Description:

Displays the time it took between specified events at specified stations between a specified time
period. 

Step by step instructions:

1. Click the Management Reports menu, click the View Report link adjacent to Trip Cycles - Segments
Detail

2. The Filter Builder will display that will allow you to select some simple filters. Because the filters
required for this report are so extensive, RMS offers to save the required filter elements for you to
make running the report in the future much easier. These saved filter settings may be retrieved from
the Stored Segment Filters drop-down text box at the top of the Filter Builder window. For unlimited
filtering capabilities, click the Custom Expression Filter tab. Optional filtering and Advanced Filtering is
available as well.   NOTE:  Station entries are now optional.
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3. Click the View Report button.

Note:  Both starting and ending event dates for each cycle segment, to be displayed, must fall between
the Start / Origin Date and the End / Destination Date.  The Segment Criteria can be deleted by clicking
the Delete command button; it also can be updated by first selecting the segment criteria record,
making any needed changes, and then clicking the OK command button.

This report is based on one-way trips, so the two events used must happen during a one-way trip. For
example, for a loaded shipment, the one way trip would start with a release load event and end with a
release empty event. This is different than RMS 3.X versions because the trip cycles are now stored as
one-way trips in RMS 4.X and higher. The advantage is that this report runs much faster. If you need to
understand the time between a release load event and a arrival empty event for the return empty trip,
you will need to run two reports: one showing the time between the release load event and the release
empty event and one showing the time between the release empty event and arrival empty event. This
shouldn't be too large of an impact since these reports run so much more quickly.

The segment filter records may only be delted if used by a a report other than the default report.

6.14 Trip Cycles - Total Trip by Route

Description:
This report displays transit time and layover time, which are the major parts of a trip cycle.

Step by step instructions:
1. Click the Management Reports menu; click the View Report link adjacent to Trip Cycles - Total Trip
by Route.
2. The Filter Builder will display that will allow you to select some simple filters. For more advanced
filtering, click on Advanced Filter tab. For unlimited filtering capabilities, click the Custom Expression
tab.
3. Click the View Report button.

6.15 Trip Cycles - Transit Performance

Description:
This report is designed specifically to measure the transit time from origin to destination. It also shows
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whether the transit met a standard that is defined in the OD (origin destination) Pair record.

Step by step instructions:
1. Click the Management Reports menu; click the View Report link adjacent to Trip Cycles - Total Trip
by Route.
2. The Filter Builder will display that will allow you to select some simple filters. For more advanced
filtering, click on Advanced Filter tab. For unlimited filtering capabilities, click the Custom Expression
tab.
3. Click the View Report button.

7 Data Management

This section of RMS is comprised of a collection of windows that allow you to add, update and delete
various reference table data.

To access these forms, click on the Data Mgmt menu and then click on the desired submenu directly
below it.

7.1 Commodities

The shipping instruction contains two fields:

1) STCC (Standard Transportation Commodity Code) - a 7 digit number that identifies a type of
commodity and
2) Commodity, which is a typically a description of the STCC

For ease of data entry of shipping instructions, RMS maintains a lookup list of both standard (STCC
and its related description) and proprietary commodity descriptions. Why two types of commodity
descriptions? Some users may wish to store a company specific commodity description in the
commodity field. For example, some types of sand (distinguished by the size of grain) are used for very
different applications, but the STCC is the same for each. In this case, the company needs a way for
RMS to help them distinguish which railcars contain Sand A (smaller grain size) and Sand B (larger
grain size).

On the Shipping Instruction data entry window, you will see a lookup list to select the STCC and then
you may choose to see either a lookup list of standard or proprietary descriptions.

If you import shipping instructions using a Railroad Customer 417 Account and would like to use a
proprietary commodity description, you can achieve this with a few simple steps. Normally the
commodity description that is imported into the Commodity field is a description of the STCC.

1. The proprietary commodity description must be placed in a "Customer Refrerence Number" field on
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the bill of lading. Specifically, this field must map to the 02 element of the N9 segment of the EDI
404/417 document. A qualifier of CR must be included in the 01 element of the N9 segment. If you are
using a railcar carrier website to enter bills of lading, call their customer service department and ask to
speak to their EDI department and ask them what specific field to use on the website is used.

2. In RMS, open the Import Properties window (Data Management | Import Properties), click on the
Options tab and place a check in the box labeled, "Fill shipping instruciton record Commodity
Description field with Customer Reference Number", click the Save button.

7.1.1 Add, Update or Delete Standard (STCC) Commodities

Follow these instructions to Add, Update or Delete a standard Commodity record.

Add a new standard Commodity

1.  From the Data Management menu, select Commodities > Standard.
2.  Click on the Add New Commodity link. Enter the commodity STCC number and its related
description.  Note that required entries are indicated by a red asterisk.
3.  Click on the Save command button.

Update an existing standard Commodity

1. From the Data Management menu, select Commodities > Standard.
2. Click on the Edit link next to the Commodity record.
3. Make changes to the commodity record as required.
4. Click on the Save command button.

Delete an existing standard Commodity
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1.  From the Data Management menu, select Commodities > Standard.
2.  Click on the Delete link next to the Commodity record.

7.1.2 Add Update or Delete Proprietary Commodities

Follow these instructions to Add, Update or Delete a proprietary Commodity record.

Add a new proprietary Commodity

1.  From the Data Management menu, select Commodities > Proprietary.
2.  Click on the Add New Commodity link. Enter the commodity name. 
3.  Click on the Save command button.

4. Click on the Edit Aliases link
5. Enter the name of the commodity exactly the way it is displayed on the shipping instruction then click
the Add link. There may be multiple spellings and if so, repeat this step for each.

Update an existing proprietary Commodity

1. From the Data Management menu, select Commodities > Proprietary.
2. Retrieve an existing commodity using the Edit link.
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3. Make changes to the commodity name as required.
4. Click on the Save command button.

Delete an existing proprietary Commodity

1. From the Data Management menu, select Commodities > Proprietary.
2. Click on the Delete link.

7.2 Contract Rail Rates

This window is used to keep track of Contracted Rail Rates between you and rail carriers.  By storing
contract rate information here, you can take advantage of several pieces of functionality, such as:

· Quickly access contract rate information using the QuickFind feature rather than shuffling through
file folders.

· Summarize contracts by Commodity, Railroad, Origin and Destination in several easy to run reports.

See Add / Update / Delete Contracts.

7.2.1 Add, Update, Delete Contract Rail Rates

Add a new Contract Rate

1.  From the Data Management menu, select Contract Rates.
2.  Click on the Add New Contract Rate link. Enter the contract rate details.  Note that required entries
are indicated by a red asterisk.
3.  Click on the Save command button.

Update an existing Contract Rate

1. From the Data Management menu, select Contract Rates.
2. Click the Edit link.
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3. Make changes to the contract rate as required.
4. Click on the Save command button.

Delete an existing Contract Rate

1. From the Data Management menu, select Contract Rates.
2. Click on the Delete link.

7.3 Cycles

Cycles, or otherwise known as Trip Cycles, are derived records that summarize the major events of a
complete shipment.  A complete shipment, for a permanent railcar, begins at the Release (Load /
Empty) event and ends at the next Release event (Load / Empty).  The event that begins a cycle, ends
the prior cycle.

7.3.1 Review cycles

Follow these steps to review and subsequently repair cycles:

1.  From the Data Management menu, select Cycles.

2.  Select the cycle status to review: Complete, Incomplete, or All

3.  Select the filters of cycles to include: 

Valid (either Completed Cycles or Cycles in Progress) - the OD pair is an OD pair that has been
entered into the RMS database, and the placement location matches the subsequent release end
location (the release at the end of the cycle not at the beginning);

Invalid (either Completed Cycles or Cycles in Progress) - the OD pair does not match an OD Pair that
has been entered into the RMS database, or the placement location does not match the subsequent
release end location (the release at the end of the cycle not at the beginning);
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Labeled, Unlabeled, or All (either Completed Cycles or Cycles in Progress) - cycles that have been
reviewed already and have been labeled G - GOOD, B - BAD - CANNOT REPAIR, or S - SPECIAL
CAUSES (i.e. Shop time, derailment, etc.);

NOTE: As of version 5.11.01, RMS automatically labels cycles S - SPECIAL CAUSES that contain bad
order events.

With Billing, No Billing (excludes labeled cycles), or All.  No Billing means no related shipping
instruction is available or has been attached to these cycles (Note: a shipping instruction may be
entered for this cycle, but if the bill / ship date differs from the cycle loaded release date more than
several days (the number of days can be changed - See Reference Values - Relate BOL Days), RMS
will not attach it to the cycle).  Only the cycles that you choose will show up on the report.

4.  Enter the desired date range and select how to apply that date range (i.e. When cycle starts or
When cycle ends).

Note:  Incomplete cycles are automatically selected based on when the cycle starts.  Cycles start with
the release event and end with the subsequent release event.

5.  Click OK - you will see the following window.

6.  Click on the Edit/View link to review a particular cycle. 
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7.  If the cycle needs to be fixed (if you do not wish to fix the cycle, go to step 12), you may edit an
existing sighting, add a new sighting or delete an existing sighting.  To edit a sighting, click on the Edit
link.  To add a new sighting, click on the Add New Sighting link.  To delete a sighting, click on the
Delete link.

Note: When adding or modifying sighting records, a 5 character comment can be entered in the
Comments field as a reminder that this was a manually entered record or any other meaning you want
to assign to it - this is not required.
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Note: If you add, delete or edit sightings for a cycle, the changes will not be reflected until the Create
Cycles process has run.  The reason for this is when sightings that are part of a cycle are altered, RMS
deletes the cycle record and then re-creates the record during the Create Cycles process.  When a
cycle is re-created, all of the cycles following it, for the same railcar, are re-created as well.  This is
done because a cycle that has been created incorrectly usually causes following cycles to be created
incorrectly.  Don't worry, they will all be recreated in the next Create Cycles.

12.  You may label a cycle; this will enable you to include or exclude these labeled cycles in your
reports.  To do this, click on the Drop Down command button on the right side of the Label text box.
Choose one of the following status:

G - GOOD - The cycle is completely accurate. (This is provided for backward compatibility with older
versions of RMS, it is not recommended that you use this status)
S - SPECIAL CAUSES - The railcar was bad ordered or spent time in the shop for some other reason.
B - BAD - CANNOT REPAIR -  Choose not to repair the cycle.

Then click the Save Cycle Changes button.  To remove a label, clear the entry in the Label text box
and click the Save Cycle Changes button.

Note: As of version 5.11.01, RMS automatically labels cycles S - SPECIAL CAUSES that contain bad
order events.

Note:  
A normal cycle begins with a release (either load or empty) event; several arrivals and departures are
typically included until the destination is reached.  At the destination you will see at least one of the
following events (in the order shown): Arrival Final Destination, Placement Constructive, Placement
Actual.  The last sighting record for a cycle should be the next release event (this must be the opposite
load / empty status as the release event that started the cycle); this sighting is also used as the first
sighting for the following cycle. There is an option that you can set in the Import Properties (from Data
Management) Options window where, if checked, RMS will create a new cycle on the ending Release
event regardless of the load / empty status.  This option is useful if you have railcars that are unloaded
and then re-loaded before being released back to the railroad.  If you do not have re-loads, it is
recommended that you do not choose this option since creating cycles based on load / empty changes
provides the most accurate results.
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7.4 Demurrage/Detention

The terms Detention and Demurrage may be used somewhat synonymously.  When the terms
Demurrage/Detention are used, they are referring to the holding of equipment, usually during the
loading or unloading of it; from constructive or actual placement to release of equipment.  Private
Railcar Storage is sometimes used to describe when private railcars are constructively placed and are
sitting on railroad-owned tracks (that are not leased by the shipper/consignee) waiting to be actually
placed. Most railroads dump all of this into one term, Demurrage.

There are two types of Demurrage/Detention in RMS: 1) Proprietary and 2) Railroad.

Proprietary Demurrage/Detention

Typically used by a railcar owner/lessee who ships loads to customers and wants to measure and
manage the time that those railcar assets are held for unloading.

Reports to use: Management Reports > Detention History by Station and
Detention History by Responsible Party

Datasets to use for Custom Reports: DetentionHistory

Railroad Demurrage/Detention

Typically used by anyone who wishes to measure and manage their exposure to railroad assessed
accessorial charges for the holding of railroad-owned railcars and/or the storage of private railcars on
railroad-owned tracks.

Reports to use:

Datasets to use for Custom Reports: Demurrage Railroad

7.4.1 Proprietary Demurrage Criteria

Follow these steps to add or update criteria used to calculate proprietary demurrage/detention on
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various reports. Demurrage/detention measurement and charges will not display on a report unless
criteria has been entered for the particular station where the railcar is unloaded/loaded. You may also
make the criteria Party specific in the case where you may deliver railcars to more than one
organization at the same station.

1. Select the Data Management > Demurrage > Proprietary menu; click the Add New Criteria link.

2. Choose the Station for which this criteria will apply.  Tab to the Acceptable Days field box and enter
the number of days that are allowed at this location before charges take effect.

4. If you wish to make the criteria Customer / Party specific, choose this organization from the
Responsible Party drop-down list.

5. Enter a daily charge.

6. Check / Fill in any free days that are given.

Note:  RMS considers the selected free days and does not count them in the elapsed time
calculation. Elapsed time begins on 12am the day after the railcar was placed (either Constructively or
Actually whichever comes first), which is similar to most railroad calculations.  The most variation is
found in what days are free according to different railroads.

7.4.2 Railroad Demurrage Criteria

Follow these steps to add or update criteria used to calculate railroad demurrage or private railcar
storage on various reports. Demurrage measurement and charges will not display on a report unless
criteria has been entered for the particular raillroad on which the railcar is unloaded/loaded. You may
also make the criteria Station and Commodity code (STCC) specific. RMS has the main (not all)
business rules for the major Class I railroads as of 2016: Burlington Northern Sante Fe, Canadian
National, Canadian Pacific, CSX, Kansas City Southern, Norfolk Southern, and Union Pacific. Your
company may have a special agreement with a railroad, you will want to review these policies and
make updates as required. It is recommended that if you have a special arrangement with a railroad,
that you create a new criteria record that is specific to a station and/or commodity.

It is recommended to enter at least two criteria records for each railroad - one for Loading and another
for Unloading.

1. Click the Data Management > Demurrage > Railroad menu.
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2. If you don't see the Railroad/Activity that is needed, then click the Add New Criteria link.

3. Choose the Railroad for which this criteria will apply.  Tab to the Activity and select whether this
criteria will be associated with Loading or Unloading.

4. Enter the daily charge for private railcars sitting on railroad-owned tracks between constructive
placement and actual placement and the daily charge for railroad-owned railcars held between
placement (constructive or actual) and release.

5. Next, select whether the order in date/time is considered by the railroad for reducing your demurrage
charges.

Note: Some railroads will reduce your charges by the time that elapsed between when you ordered a
constructively placed railcar into your industry and when the railroad actually placed the railcar at your
industry. The order in date/time is entered on the RMS Shipping Instruction window on the Other tab.

6. Enter the days allowed for a private railcar stored on railroad property before charges begin to
accrue. Indicate whether these days are free or credited.

Note: Credit days are different than Free days. Credit days, if not used in full for a particular railcar
shipment, may be used to offset accrued demurrage charges for another railcar shipment. Most
railroads restrict the use of credits to the particular industry location, one billing period, and activity (i.e.
loading or unloading).

7. Enter the days allowed for a railroad-owned railcar held between placement (constructive or actual)
and release. Some railroads also allow extra days if the railcar is unloaded and then reloaded before
released back to the railroad. Indicate whether these days are free or credited.

8. Select the time that the demurrage clock begins in the Clock start time text box.

9. Click on the Allowed Calendar Days tab. If there are any days of the week or holidays that are
allowed, select or enter them here. Indicate whether they are free or credited.

10. Click on the Other Optional tab if you need to make this criteria Station or STCC (commodity code)
specific.

11. Click the Save button.
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7.5 EDI File Transfer

If you need to get data in the form of EDI (electronic data interchange) or standard CLM (car location
messages) documents, this is the place to specify the location of this data (i.e. server), the format of
the files and the network protocol to use.

7.5.1 EDI File Transfer setup

This page is typically used to specify the locations of FTP folders that contain either shipping
instructions (aka waybills) and sightings (aka CLM).

1. Click the Data Management > Import Properties

2. On the Import Properties window, select the appropriate tab: click on the Shipping Instruction Data
tab if waybills (EDI 417) are to be gathered and / or click the Sighting Data tab if CLMs are to be
gathered; check the Railroad / VAN check box; the EDI File Transfer Profiles form will open (you may
also open the EDI File Transfer window by clicking the Data Management > EDI File Transfer branch
menu;

NOTE: Required entries are indicated by a red asterisk.

3. Click the Add New File Transfer link.

4. Fill out a name for the particular profile in the Name text box – this is just to identify the account so
that you can easily recognize and retrieve it if it needs to be updated.

5. Select the Format of the file from the Format drop-down box.

6. Choose a Source of the data from the Source drop-down box; this is usually the railroad or VAN
(value added network) that has set up this particular account.

7. Choose a protocol from the Protocol drop-down box.

8. Type in the User Name and Password in the respective text boxes to access the account.

9. Enter the Host address of the account (i.e. ftp.railcartracking.net).

NOTE: Do not enter the FTP:// . This is taken from the Protocol entry.



Railcar Management System Help143

© 1997 - 2019  Railcar Tracking Company a Division of Savage Services Corp.

10. If the files reside in a folder, enter the folder name / path in the Folder text box (i.e. .
out/shipping_instructions )

11. Files are selectively downloaded by naming convention. This aids in getting files directly from the
railroads, which may blend different kinds of files in the same folder. For example: enter clm to
download files that are named bnsfclm000.txt, bnsfclm001.txt, bnsfclm002.txt, etc.

12. Each company (your company) has a unique identification code, get or establish this with the
railroad and enter it into the Corp. ID text box. If you do not know this or are unable to get it, simply
enter a three character abbreviation for your company.

13. Departments or subsidiaries may have separate unique identifications, get or establish this with the
railroad and enter it into the Dept. ID text box. If you do not know this or are unable to get it, simply
enter a three character abbreviation for your company department.

14. Place a check in the Passive Connection check box, this is more firewall friendly.

15. Most accounts will require RMS to delete the file after it is downloaded, but some will automatically
delete the file once it is downloaded (Transentric accounts are the only ones that do this that we know
of at this time).  Place a check in the Delete File After Transfer check box if RMS must delete the file
after it is downloaded (recommended).

16. If you wish to set the account as Inactive, place a check in the Inactive check box.  Even if the
Import Properties are set for RMS to get Shipping Instruction or Sighting Data from a railroad or a
VAN, if the EDI File Transfer Profile is set to Inactive, no data will be gathered from that particular
server account.

NOTE:You don't want to leave files on the account once they are downloaded because then the import
process will take longer and longer while RMS is downloading duplicate files.  RMS will not add
duplicate records to its database, but you don't want to waste your time waiting for unnecessary files to
be downloaded.  Plus, the railroad or value added network that manages the account may get upset
that you are using so much storage on their server.

NOTE: Some servers don't allow passive connections, so you'll have to do a little testing here.

Additional Information:  Copies of the files that are downloaded from any EDI File Transfer Profile
are placed in the RMS Flat File Directory; you can alter this by following the steps in the
Flat File Directory help topic.  If you wish to schedule automatic imports, see the Scheduler help topic.

Sometimes you will need to set up a fleet update or CLU. The fleet update is done during the
Import Data Only and Import Data and Create Cycles scheduled batch processes. This is a process
where RMS will upload a list of railcars to an FTP folder. This list will indicate if the railcars are to be
added / deleted from the data source's list of railcars to provide data. The list may also indicate which
railroads are to be included or excluded from the data feed. Follow these instructions to set up this type
of process:

1. Click the Data Management > EDI File Transfer menu;

2. Click the Add New EDI File Transfer link;

3. Fill out the page as shown below and click the Save button.

- The Name may vary, but it is recommended to include the fleet name since there may be multiple
fleet updates.
- Format = CLU (always)
- Destination = Railinc (for most setups - or another railroad that offers CLU functionality)
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- Host = ftp.railcartracking.net (for most set ups)
- Folder = in/fleet_updates (for most setups)
- Corp. ID = any entry here - it doesn't matter since it is not used
- Fleet Name = the name of the fleet at the data source
- RR Include / Exclude = 4 characters per railroad. For example, if the Railinc data source fleet is set to
Exclude railroads and you are getting data directly from CN and BNSF (so you don't need data from
Railinc for CN and BNSF), then enter "CN  " with two spaces after it for a total of 4 characters. Then
enter "BNSF" with no spaces since it is already 4 characters. There should be no spaces in between
the railroads. Note that the include/exclude setting is done by Railinc or the railroad on the fleet.
- Passive Connection is usually the best since it is firewal friendly.

7.6 Import Properties

7.6.1 Import Properties

Import Properities:

1. Shipping Instructions Data:  Choose Data Source(s) then click Save.

2. Sighting Data:  Choose Data Sources then click Save.
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3. Options:  Select all applicable import options, then click Save.

· Exclude shipping instructions where the railcar is not part of the active RMS fleet. Shipping
instructions will not get imported for any railcars that are not already entered and active in RMS.

· Exclude shipping instructions for empty railcars. Shipping instructions for empty shipments will be
ignored and not imported.

· Exclud shipping instructions for intermodal shipments. Shipping instructions for intermodal
shipments will be ignored and not imported.

· Exclude shipping instructions that don't have an origin and railcar fleet status that matches an
existing active contract. In the Contract Rates, you can enter rates for moves from particular origins
and destinations. There is an option where you can indicate the fleet status (All, Temporary,
Permanent). If a shipping instruction has an origin that matches an existing active contract and the
railcar fleet status matches the fleet status selected in the contract record, the shipping instruciton
will be imported.

· Fill shipping instruction record Commodity Description field with Customer Reference Number. For
some commodities, such as sand, the STCC is not specific enough. In this case, the shipper can fill
in a more specific commodity code in the Customer Reference Number section of the bill of lading.
This code will be filled into the Commodity field of the Shipping Instruction record.

· Do not deactivate Temporary railcars upon completion of cycle. When temporary railcars finish a trip
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cycle, RMS automatically deactivates them (assuming that there is not a shipping instruction for the
return trip cycle). This is not recommended for most situations.

· Never archive temporary railcar sightings that do not have a related shipping instruction. Sometimes
a shipping instruction is delivered to RMS many days after the actual ship date. This can cause RMS
do not be able to relate the imported sightings with the shipping instruction. RMS will not import
sightings for temporary railcars unless it can determine that there is a valid shipping instruction for
the current shipment. Otherwise, it archives the sightings. This setting turns off that behavior. It is not
recommended for most situations.

· Include sightings where the railcar is not part of the active RMS fleet. Normally RMS will not import
sightings for railcars that are not already added and active in the system. In some situations, you
may want RMS to automatically add the railcar to the fleet and import the sightings. This might be
helpful in the situation where your data source automatically discovers newly leased railcars and
sends sightings for them before you get a chance to add the railcar in RMS. Otherwise, it is not
recommend for most situations.

4. Cycle Options

A cycle is a one-way trip from Release at origin to Release at destination. RMS can separate these
cycles in different ways depending on your needs.

· Create new cycle when the load/empty status changes. This is a good setting when you ship loads
and then the railcars ALWAYS come back empty (i.e. no reloads).

· Create new cycle when the load/empty status changes and Create a new cycle on consecutive
Actual Placement (Z) and Release (W) events regardless of Load/Empty Status. Check this option
if you ship reloads. RMS will separate the cycles even if the load/empty status does not change.

· Create a new cycle on these consecutive location and event pairs:   It is not recommended that
you use this option without talking with RMS technical support team first. You might want to use
this option if you ship reloads and you are not getting complete sighting data that includes the
Released event and Actual Placement event. You may also want to use this option if you ship
intermodal, which often does not have the expected load/empty status or the expected Released
and Actual Placement events.

7.7 Origin-Destination (OD) Pairs

OD Pairs help RMS better understand your route network.  It can then do more work for you like chart
transit time performance against a standard ( see Trip Cycles: Loaded and Empty Transit) and
summarize mileage for a trip cycle ( see Trip Cycle by Route report).
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7.7.1 Add, Update, or Delete origin-destination (OD) pairs

Add an origin-destination (OD) pair

1.  Click the Data Management > Origin/Destination Pairs menu.
2.  Click the Add New Origin/Destination Pair link.
3.  Click on the Drop Down command button at the right edge of the text box labeled Origin; choose
the location by highlighting and clicking on the selection.  Do the same for Destination.
4.  Average Transit (Days) is no longer used, but remains for backward compatibility.
5.  Standard Transit is not required, but is necessary if you wish to see an On-Time Performance; (see
Trip Cycles: Loaded and Empty Transit reports)
6.  Mileage is an optional entry. It is used by the Cycles by Route Management Report, which is a
Trip Cycles - Round Trips report.
7.  Click on the Save command button.

Update an origin-destination (OD) pair

1.  Click the Data Management > Origin/Destination Pairs menu.
2.  Click the Edit link to select the OD Pair.
3.  Enter and/or modify information as required.
4.  Click the Save command button.

Delete an origin-destination (OD) pair

1.  Click the Data Management > Origin/Destination Pairs menu.
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2.  Click the Delete link.

7.8 Parties

This reference table stores information about the companies that are involved in your route network.  It
should also include any companies or organizations that are designated as a shipper, consignee, or
care of party on a bill of lading.  If you are going to use the Railcar Leases feature, you'll need to store
the names of the railcar lessors here too.

7.8.1 Add, Update, Delete Parties

Add a party

1.  Click the Data Management > Parties menu.
2.  Click the Add New Party.
3.  Type in the company name.  Required.  Add any other information that you wish.
4.  Add at least one Alias.  Before you can do this, you must click the Save command button.  Once
you have done this, click on the Aliases command button. Aliases are the various different spellings of
a company name that may appear on a shipping instruction.   
5.  Type in any other information desired in the rest of the text boxes provided.  Optional.

Update a party

1.  Click the Data Management > Parties menu.
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2.  Click the Edit link
3.  Make any desired changes. 
3.  Click the Save command button when finished.

Delete a party

Note:  If this party appears in other records (i.e. Demurrage, Contract Rates), you will not be able to
delete it until you remove or replace it in the other records.

1.  Click the Data Management > Parties menu.
2.  Click the Delete link.

7.9 Problem Logs

This is a place to store a record of conversations about service problems and commitments with rail
carriers, customers, vendors, or any other organizations that you work with.

7.9.1 Add, Update, or Delete Problem Logs

Add problem log
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1.  Click the Data Management > Problem Logs menu or from the Home window, click on the Problem
Logs tab window, which will enable you to manage logs for the railcar that is selected on the Home
window.
2.  Click on the Add New Problem Log link, which will take you to a new blank record.
3.  Fill in the information on the screen as needed.
4.  Click Save when finished.

Update a problem log

1.  Click the Data Management > Problem Logs menu or from the Home window, click on the Problem
Logs tab window, which will enable you to manage logs for the railcar that is selected on the Home
window.
2.  Use Open, Closed or All option button to return the desired list of records.
3.  Click the Edit link for the record that you wish to update.
4.  Edit the problem record as needed.
5.  Click the Save command button.

Note: When you put a date in the Resolution date text box, the problem is considered closed.

Delete a problem log

1.  Click the Data Management > Problem Logs menu or from the Home window, click on the Problem
Logs tab window, which will enable you to manage logs for the railcar that is selected on the Home
window.
2.  Click on the Delete link.

7.10 Railcar Pools

Pools can be used to segregate railcars according to what plant they are shipped out of, what kind of
product they carry, car type, or any other reason you can think of.  Once you assign railcars to pools,
you can then see them grouped and sorted on most reports by their pool; you can even filter most
reports to see only information for railcars in the particular pool.  In order to assign a railcar to a pool,
you must first add a pool record.

You may also relate a Trip Plan to a Railcar Pool on this window.  See the Trip Plan help topic for more
information about using Trip Plans.
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7.10.1 Add a railcar pool

Step by step instructions:

1.  Click the Data Management > Railcar Pools menu.
2.  Click on the Add New Pool link.
3.  Type the pool description.
4.  Select a Trip Plan that this pool will be related to.  This is an optional feature and is only useful in a
very specific situation: if you wish to get Enhanced ETAs for inbound railcars (load or empty) travelling
to one destination AND you don't import Shipping Instructions (waybills).  Please call Customer
Support for more information.
5.  Click the Save command button.

7.10.2 Update a railcar pool

Step by step instructions:

1.  Click the Data Management > Railcar Pools menu.
2.  Click on the Edit link.
3.  Make the desired changes.
4.  Click the Save command button.
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Note:
If you change the name of the pool, this will not effect the railcars that are assigned to this pool; they
will still be assigned to the same pool, but it will display on reports with the new name.  If you wish to
keep track of the time that a railcar was in various pools, don't change the name of the pool, rather,
create a new Pool and go to the Railcar Update window and reassign the railcar(s) to the new pool.
RMS keeps track of when railcars move from one pool to another when you use this process.

7.10.3 Delete a railcar pool

Your company may discontinue or sell off a segment of business, which requires you to reassign all the
railcars that were assigned to this pool to different pools.  You will need to reassign each railcar to a
different pool.  Don't delete a pool record even if there are no railcars assigned to it because RMS
keeps track of when railcars were in pools. You may rename an unused pool to INACTIVE - FRAC
SAND POOL for clarification.

Step by step instructions:

1.  Click the Data Management > Railcars > Pools menu.
2.  Click the Delete link.

7.10.4 Assign one or more railcars to a pool

Step by step instructions:

1.  Click the Data Management > Railcars > View/Add/Update menu.
2.  Place a check in the checkbox of the railcar(s) that you wish to assign to a particular pool.  To
select all railcars on the page, click the Select All button.
3.  Click on the Assign to Pool button.
4.  Select the pool that you wish to assign the railcar(s) to and click the Assign to Pool button.
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7.11 Railcars

7.11.1 Add / select multiple railcars

Follow these steps to add and/or select multiple railcars.

1.  Click the Data Management > Railcars > View/Add/Update menu and then click the Add / Select
Multiple Railcars link.

2.  Enter or paste the railcar initials and numbers into the text box on the window is labeled Enter or
paste railcars here.

NOTE: You can enter or paste railcars in various formats such as:

keyx626
keyx 626
keyx000626
keyx   626
keyx 000626
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3.  Click on the Validate button.

4.  RMS will display the railcars that it was able to recognize including a total count at the bottom of the
text box labeled Count.  If everything looks ok, click on the Save / Select button to commit the records
to the database and to select the records for further action.

NOTE: If the railcars are already present in the database (either active or inactive), RMS will not add a
duplicate. In this case, it will include these railcars in the list of selected railcars so that you can
perform actions on them along with any railcars that were newly added.

5.  After the save is completed, the Railcars View/Add/Update window will appear and all the railcars
pasted/added to the prior window will now be selected for bulk actions; see Update railcars for further
instructions.

NOTE: Railcars added to the fleet in this manner will be identified as Permanent, which means that
RMS will track them while loaded AND empty.  If you wish to only track a railcar for one loaded
shipment, identify the railcar as Temporary.  A better way to manage Temporary railcars is to
add/import the shipping instruction(s) to RMS and then let RMS add the railcar automatically to the
fleet as a Temporary. 
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7.11.2 Add a single railcar

There is another way to add railcars to RMS.

1.  Click the Data Management > Railcars View/Add/Update menu.

2.  Click on the Add New Railcar link.

3.  Enter the initial and number and any characteristics that you wish to save for reference.

4.  Click the Save button.

7.11.3 Assign railcars to report group

The following instructions will show you how to quickly and easily add many railcars to a group with
which you may easily filter Daily Reports.  This is helpful when you have a handful of hot shipments
that you want to watch closely.

If you haven't created any Report Groups yet, follow these instructions to do so. Otherwise go to

1. Click on the Data Management > Railcars > Report Groups menu

2. Click the Add New Report Group hyperlink.

3. Enter the name of the report group and click the Save button.

4. Click the Data Management > Railcars > View/Addd/Update menu



Data Management 156

© 1997 - 2019  Railcar Tracking Company a Division of Savage Services Corp.

5. Select the railcars you want to select using the check boxes in the left column or use the easy copy
and paste select multiple railcars process.

6. Then click the Assign to Report Group button
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4. Select the appropriate Report Group then click the Assign to Report Group button.

7.11.4 Assign railcars to sublease

The following instructions will show you how to quickly and easily add many railcars to a sublease.

1. Go to Data Management>Railcars>Subleases.

2. Click the Add New Sublease link.

3. Fill out the form as shown below. Note that the Lessee is selected from Parties. You may need to
add the Lessee as a Party before completing this form.
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4. Click the Data Management > Railcars > View/Add/Update menu

5. Select the railcars you want to select using the check boxes in the left column or by using the simple
copy and paste select multiple railcars process.
6. Then click the Assign to Sublease button.
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4. Select the appropriate Sublease then click the Assign to Sublease button.

7.11.5 Change Status

You can change the status of a railcar's fleet status (i.e. Temporary or Permanent) quickly from the
Railcar>View/Add/Update screen.
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1. Select the railcars to change the status using the Select checkbox in the Select column (column 1)
or use the process to add / select multiple railcars by simple copy and paste.

2. Click Change Status.

3. Select OK to confirm. Permanent railcars will be changed to Temporary and Temporary railcars will
be changed to Permanent.
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7.11.6 Change ownership

You can change the status of a railcar's ownership status (i.e.Owned = True or Owned = False) quickly
from the Railcar>View/Add/Update screen. This is a toggle operation. In other words, if the Owned
property for the railcar is True, this will change it to False.

1. Select the railcars that you would like to change ownership status. Note the Owned column indicates
the railcar current ownership status.

2. Click the Change Ownership button.

3. Click the OK button.

7.11.7 Deactivate and reactivate railcars

Note: This feature is used usually when a permanent railcar is no longer used by your company
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(temporary railcars do not typically need to be deactivated manually - usually RMS will deactivate them
automatically unless there is a data problem); either it was scrapped or returned to the lessor after an
expired lease.  Use this feature if you wish to no longer track a railcar on a daily basis, but still want to
retain all historical shipment information.  When you check this box on the Railcar window, it will no
longer display in your Active fleet and it will no longer show up on Daily Reports.  When a railcar is
deactivated, be sure that you remove the railcar from any other trace files in external data delivery
systems that determine what CLM records you receive.  For example, if you use Steelroads as a
source of CLM records, be sure to remove that railcar from the Track and Trace trace list; if you use a
third party to receive CLM records, ask them to remove the railcar from the fleet or if they have a
system that enables you to perform the deletion, use that. If you use RMS Data Services for CLM
records, the railcar will automatically be removed.

Note: If you are using RMS to track Temporary or System Cars and you are entering or importing
shipping instructions into RMS, RMS will automatically deactivate and reactivate these railcars as
needed. Typically, when the railcar is unloaded and released as empty, RMS will complete the load
cycle and deactivate the railcar.

Deactivate a railcar:

1.  Click the Data Management > Railcars > View/Add/Update menu.
2.  Select the railcar to be deactivated by placing a check in the check box or using the easy
select multiple railcars process using simple copy and paste.
3.  Click the Deactivate Selected command button.
4.  A question will appear asking for additional actions.  Check the appropriate actions then click OK.

TIP: It is recommended that you check all options as shown above. Even though the railcar is no
longer in your permanent fleet, it could be used by another company to send your company materials
in the future. If you think that this is a possibility, then changing the fleet status to Temporary will
enable RMS to automatically reactivate the railcar when a shipping instruction including this railcar is
imported in the future. Returning the railcar to the System Cars pool is good practice if the railcar is
automatically reactivated, it will not surprisingly show up on a report filtered by proprietary pools.
Removing incomplete cycles and archiving related sightings is good practice since it will prevent an
old incomplete cycle from getting fused with a newer cycle if and when the railcar is reactivated in
the future.

NOTE: You may deactivate many railcars at a time by checking multiple railcars before clicking the
Deactivate Selected button.

Reactivate a railcar:

Note: If you have begun a new lease on a railcar that was leased the prior year and deactivated by
you, you will need to use this feature.  Any other uses would be rare.  Once a railcar is reactivated, it
will show up on Daily Reports and be listed in the Railcars Update window Active railcars list.  Be sure
to add this railcar to any other trace files that determine what CLM records you receive.  For example,
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if you use Steelroads as your source of CLM, add this railcar to the Track and Trace trace list; if you
use a third party to receive CLM records, ask them to add the railcar to the fleet or if they have a
system that enables you to perform the addition, use that. If you use RMS Data Services for CLM
records, the railcar will be automatically added.

1.  Click the Data Management > Railcars > View/Add/Update menu.
2.  Click the Inactive option button.
2.  Select the railcar to be reactivated by placing a check in the check box. 
3.  Click the Reactivate Selected command button.

Note: You may reactivate many railcars at a time by checking multiple railcars

7.11.8 Delete railcars

Warning: Deleting a railcar is not recommended.  When a railcar is deleted, most records related to
that railcar are deleted as well.  Related records include:  Shipping Instructions, Cycles, Sightings,
Problems and Event Logs (these are used only by RMS).  Depending on the volume of data in your
database, deleting one railcar can take several minutes because all the related records are being
deleted as well.  If this railcar is simply idle and will be used again soon, you definitely do not want to
delete it in order to preserve all of the historical information for this particular railcar.  Even if this railcar
has been scrapped, you should preserve its history so that your Management Reports will include the
important movement history.  It is recommended that you deactivate a railcar instead of deleting it.

If you still wish to delete the railcar, follow these steps.

1.  Click the Data Management > Railcars > View/Add/Update menu.
2.  Place a check in the check box next to the railcar.

Note: You may delete many railcars at a time by checking multiple railcars

3.  Click on the Delete Selected command button.

7.11.9 Search railcars

You can search railcars by entering on keyword in the text box to the left of the Search Railcars button
to reduce the displayed railcars. Search is not case sensitive. For example:

· Enter hopewell and click the Search Railcars button to find and display only railcars in the
HOPEWELL PLANT pool

· Enter 123456-33 to find and display only railcars that are assigned to the lease with a contract
number of 123456-33

· Enter keyx626 or keyx 626 or keyx000626 or keyx   626 or keyx 000626 to find and display
only KEYX 626

· To search and find multiple railcars by their initial and number, see Add / select multiple railcars
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7.11.10 Update railcars

1.  Click the Data Management > Railcars > View/Add/Update menu.

2.  To find a railcar quickly in a large list, enter the railcar initial, a space, and the number in the text
box next to the Search Railcars button and then click that button. This would be the entry to find a
railcar with the initials of ACFX and a number of 123456: ACFX 123456   To find a group of railcars that
have similar characteristics, enter a keyword in the it the text box, then click the Search Railcar button.
This will apply the search keyword to the Railcar, Pool, Lease, Sublease, Report Group or Status
columns. For example, if you would like to view all railcars with a status of Temporary, then type temp
in the Search text box and click the Search Railcars button. The search is not case sensitive.

3. You are also able to search by railcar status. Simply click Active, Inactive or No Pool Assignment
radio buttion before you click "Search Railcar".

4.  Click the Edit link next to the railcar that you wish to update (see edit screen below):
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4.  Make necessary changes and/or fill in the blanks with all pertinent information.  NOTE:  5 Year Test,
10 Year Test and Stub Sill Insp fields have been added and are available to add to reports.  They are
present in the "Railcars and Lease Information" custom report dataset.

5.  Click the Save command button.

NOTE: If you need to change the initials and/or number of a railcar, click on the Change marks
command button; this will enable these fields.
ONLY DO THIS IF THE RAILCAR HAS ACTUALLY BEEN RESTENCILED .  Otherwise, you should
never change the initials and/or number of a railcar because this will cause invalid measurements.

7.12 Railroads
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7.12.1 Add, Update, Delete railroads

Add a railroad

1.  Click the Data Management > Railroads menu.
2.  Click the Add New Railroad link.
3.  Enter the railroad SCAC (Serving Carrier Alpha Code) abbreviation and the full railroad name and
any other information that you wish to save.
4.  Click on the Save command button.

Update a railroad

1.  Click the Data Management > Railroads menu.
2.  Click the Edit link.
3.  Make desired changes and click the Save command button.

Delete a railroad

1.  Click the Data Management > Railroads menu.
2.  Click the Delete link.

7.13 Reference Values

In order for RMS to integrate with other systems, import data, send reports via email, etc. it needs to
know quite a few usernames, passwords, and various settings so that you don't have to constantly
enter these yourself.  Plus, storing this information enables RMS to run in an automated fashion.
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7.13.1 Update Reference Values

To insert or change Reference Values, follow these steps:

1.  Click the Data Management > Reference Values menu.
2.  Click the Edit link.
3.  Insert or change the value in the Value text box.
4.  Click on the Save button.

7.13.2 Days to Keep Data Files

This is the number of days that you wish RMS to keep data files that are dowloaded from data sources
and written to the Flat File Directory.  The default is 90 days.

7.13.3 Days to Keep Error Logs

Number of days to keep the error logs that record what scheduled batch activities were run and when
and if there were errors encountered. Default is 30.

7.13.4 Days To Save Backup

This is the number of days that you wish RMS to keep backup files.  The default is 1 day. It is
recommended that you contact Customer Support to set up a backup plan appropriate for your
company.
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7.13.5 Days Until Deactivate Non-Moving Temporary Railcars

Sometimes temporary railcars are diverted out of your company's service before the cycle was
completed normally. Or an inbound empty is rejected. In either case, no further sightings can be
received for them because your company is no longer listed on the shipping instruction. However, the
system started a cycle for the shipment and the railcar will not be deactivated until the cycle is
completed by either getting a sighting that indicates a load/empty change or a Release sighting.

This is the number of days that Temporary railcars can not move (i.e. no sightings have been received)
before getting deactivated. If there was a cycle in progress, its Complete setting is set to True. It will be
difficult to run reports on these cycles unless the date range filter is applied to when the cycle starts
because there is no Release end date recorded to the cycle. For this reason, it is recommended to
complete the cycle by manually entering the Actual Placement and Release End sightings if possible.
This way the cycle will be completed and the railcar deactivated normally.

The default setting is 365 days.

7.13.6 Email address

This is the email address that RMS uses as the FROM address when it sends reports via email.

7.13.7 Emailed Report Supplemental Message

For scheduled, emailed reports you may want to add an additional message to the recipient. You can
add a specified message in Reference Values.  This message will display in the body of the email
message. To do this go to Data Management>Reference Values
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1. Click Edit for Emailed Report Supplemental Message

2. Type message in the Reference Value field.

3. Click Save.

7.13.8 Flat File Directory

This is the directory that RMS places most of the text files it creates, such as:

-         Database file backups (Files with a .bak file extension)
-         Copies of CLM / sighting trace records downloaded from various data sources (file names begin
with CLM)
-         Copies of 417 Waybill records downloaded from various data sources (file names begin with
BILL417 or Cust417)

The reason RMS places copies of records in this directory is that if there was a computer crash and
the database needed to be reloaded for the last few days, you would have easy access to the data. 
RMS automatically deletes CLM and BILL417 files from this folder after 90 days. This setting can be
adjusted in the Days to Keep Data Files.

1. Open Windows Explorer

2. Create a new folder.

Note: If you have multiple people using RMS, be sure that the Flat File Directory is a folder that is
accessible to all users, preferably on a central computer server. For example, if you make the folder a
mapped drive like x:\sharename, be sure that all users have their x drive mapped to the same shared
folder. It is recommended that the name of the server is used instead of a mapped drive because it is a
more reliable way of doing things. Even if you are the only user of RMS on a single computer, you will
still need to create a Flat File Directory folder in a place on your computer where all progarms and
users will have access to it. Somewhere in the My Documents folder is always a good choice. Once
the folder is created, right click on the folder and click properties. Click on the Sharing tab and check
the Share this folder on the network check box and the Allow network users to change my files check
box.
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3. Click the Data Management > Reference Values menu and click the Edit link for Flat File Directory.

4. Click on the Browse button and select the folder that you just created and click Save.

7.13.9 Outgoing mail server settings

If you wish to send RMS reports via email, you will need to store several references relating to your
company's outgoing mail (SMTP - Simple Mail Transport Protocol) server.

References:

Outgoing Mail Server

You will enter an IP (Internet Protocol) address for the outgoing email server that will be used for
routing outgoing email messages that contain RMS reports as attachments.  You may use the actual
numeric IP address, which would look like this: 189.99.99.01.  Or you may use an alias, which would
look like this: smtp.myemailserver.net.  It is recommended that you use an alias.

You may need to ask your IT department for this address.  Be sure to ask them if authentication for
outgoing email is required and if so, what user name and password to use.  You may be able to find all
of this information in your email client application (Outlook for example).

Outgoing Mail Enable SSL
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Set this to true is SSL encryption is required.

Outgoing Mail Port

If this reference value is left blank, RMS will use the industry standard email port of 25.  Clarify this with
your IT department.

Outgoing Mail User Name

If authentication is required for outgoing email messages, enter the User Name here.  If this reference
value is left blank, RMS will assume no authentication is required.

Outgoing Mail Password

If authentication is required for outgoing email messages, enter the Password here.  If this reference
value is left blank, RMS will assume no authentication is required.

7.13.10 Proxy Server Settings

Sometimes a company uses a Proxy Server to validate Internet usage on the company network.  If this
is the case, you will need to tell RMS some key information about the Proxy Server so that it can
successfully gather information from the Internet.

You can get the necessary Proxy Server information from your IT department, or you can get it
yourself.  To get this information yourself, follow these step-by-step instructions:

1. Open Internet Explorer.Click on the Tools | Internet Options menu.

2. Click the Connections tab and click on the LAN Settings command button.

3. If your company uses a Proxy Server, the check box labeled Use a proxy server will be checked. 

4. Record the values that are listed in the tex boxes labeled Address and Port. If these boxes are gray
with no values, then click the Advanced command button and record the Address and Port values for
the Secure server type. Record your Proxy Server username and password (this information is
probably not stored anywhere on your computer, so if you don't know or remember it, ask your IT
department).

ProxyAddressPort

This is the IP (internet protocol) address of the proxy server and the port it is accessed through.  When
you enter the Proxy Server Address, immediately after that, type a colon ":", and then type the Port
value in the Value text box.  For example, if your Proxy Server Address is "Internet" and the Port is
"80", then type "Internet:80".

ProxyPassword

This is the password for the proxy server.

ProxyUserName

This is the user name for the proxy server.

NOTE: Logins and passwords may be case-sensitive.
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7.13.11 Relate BOL Days

If you enter or import Shipping Instructions (bills of lading or waybills) into RMS, it will attach these
records to the appropriate trip cycle record.  In order to do this, RMS compares the Bill of Lading date
on the shipping instruction record to the Release date on the trip cycle record.  Of course, it also must
match the railcar initial and number and load/empty status.  If the trip cycle release date is later than
the bill of lading date by the number entered for the Relate BOL Days reference or less, it will attach or
relate the two records.

Why would the trip cycle release date be later than the bill of lading date? Normally the release sighting
should be generated when the railroad receives the bill of lading from the shipper, so the dates should
be the same under normal circumstances. Due to importing/reporting issues, it is possible for sightings
to not be imported until a railcar is well into its cycle. This would cause RMS to miss the actual release
sighting. When RMS gets the first sighting for the shipment, it will consider that the release date.

NOTE: For intermodal equipment, RMS will not consider the load/empty status when attaching a
shipping instruction to a cycle. Railcars are considered intermodal if its AAR Type starts with
F,P,Q,R,S,U,V (this is configurable by RMS technical support if needed). You will need to add the AAR
Type to a railcar in the Data Management > Railcars > Update railcars section.

7.13.12 Relate BOL Days Early Release

If you enter or import Shipping Instructions (bills of lading or waybills) into RMS, it will attach these
records to the appropriate trip cycle record.  In order to do this, RMS compares the Bill of Lading date
on the shipping instruction record to the Release date on the trip cycle record.  Of course, it also must
match the railcar initial and number and load/empty status.  If the trip cycle release date is earlier than
the bill of lading date by the number entered for the Relate BOL Days Early Release reference or less,
it will attach or relate the two records.

Why would the trip cycle release date be earlier than the bill of lading date? Normally the release
sighting should be generated when the railroad receives the bill of lading from the shipper, so the dates
should be the same under normal circumstances. Sometimes, when a shipping instruction is received
from a Class I railroad , but a short line railroad generates the release sighting, the bill of lading date
shown on an imported shipping instruction is later than the trip cycle release date.

NOTE: For intermodal equipment, RMS will not consider the load/empty status when attaching a
shipping instruction to a cycle. Railcars are considered intermodal if its AAR Type starts with
F,P,Q,R,S,U,V (this is configurable by RMS technical support if needed). You will need to add the AAR
Type to a railcar in the Data Management > Railcars > Update railcars section.

7.13.13 Steelroads settings

If you are configuring RMS to get some or all of its sighting data from Steelroads, you will need to store
information that enables RMS to automatically access your account.

Steelroads Login

This is the login or user name of the account.

Steelroads Password

This is the password of the account.
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NOTE: Steelroads passwords typically expire every 90 days.  Put a reminder to yourself to change
your password every 80 days and when you have done that in Steelroads, be sure to update the
password in RMS.  This way you will never be caught by surprise.  These passwords are case
sensitive.

Steelroads Trace List(s)

This is the name of the trace list that RMS references in order to get complete history of your
private/permanent railcars.  It is recommended that you establish a trace list in Steelroads that contains
all of your private/permanent railcars.  If you don't have private/permanent railcars, in other words, if
you only borrow your equipment for one shipment at a time (temporary), it is not recommended that
you use trace lists.  If you have both permanent and temporary railcars, establish your permanent
railcars in trace lists and RMS will trace the temporary railcars individually every time you run an RMS
import.

You may now be realizing that history for temporary railcars may not be as complete as permanent
railcars.  That may be true since RMS can only get the last location of a temporary railcar, so if you run
an RMS import every 4 hours, three times a day (7am, 11am, 3pm), there may be two events that
happen between 7am and 11am.  The second event will be imported, the first event will not.  For many
shippers, this is an acceptable thing.  If you require complete history for temporary railcars, then you
have two other options: 1) get access to the Steelroads Parameter Trace, which may involve a fee  2)
buy Enhanced CLM (sighting) data from Railcar Tracking Co.  Contact Customer Support and we'll
help you.

NOTE: You may only have 1,000 railcars per trace list, so if you have more railcars, establish separate
trace lists.  If you have multiple trace lists, you must enter them in this reference value separated by
semi-colons.  For example: SRTRACE1;SRTRACE2;SRTRACE3

NOTE: No one else should run these trace lists because they are similar to a mailbox.  If the trace list
is run, it empties the mailbox.  Only RMS should run these trace lists to ensure that you have complete
history.

NOTE: The trace lists will only store the last 4 days worth of data, so you must run an RMS import at
least that often.  You may schedule an RMS import.  See the Scheduler help topics.

7.13.14 Technician Email Address

Enter the email address(es) that will receive the error logs when RMS encounters errors during a
scheduled activity. The default is support@railcartraking.com. You may add additional email addresses
and separate them by commas.

7.14 Scheduler

The RMS Scheduler keeps the schedule of processes / activities that need to run at a specific time.
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7.14.1 Add, Update, Delete a scheduled activity

These steps establish the Schedule.  The scheduled activities are queued and get launched every 5
minutes.

Add a scheduled activity

1. Click the Data Management > Scheduler menu.
2. Click the Add New Schedule link.
3. Select the Activity to schedule from the Activity text box; select a Date and Time you wish to run the
activity; select how often the activity should run with the Interval text box.
4. Click the Save button.

NOTE: RMS will run activities with a date/time less or equal to the server's date/time within one hour.

Update a scheduled activity

1. Click the Data Management > Scheduler menu.
2. Click the Edit link.
3. Modify the Activity and click the Save button.

Delete a scheduled actiivyt
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1. Click the Data Management > Scheduler menu.
2. Click on the Edit link.

7.14.2 Backup Database

It is recommended to run this nightly. When it is run, here is what happens:

· Checks the logical and physical integrity of all the objects in the specified database, which helps
identify data problems.

· Rebuilds the database table indices, which improves performance.
· Writes a backup of the database to the Flat File Directory.

If corruption is found or another type of error is encountered during this process, an email will be sent
to the Technician Email address.

7.14.3 Create Cycles Only

· Assimilates sighting records into Cycle records.
· Deactivates Temporary railcars which have completed a cycle
· Deactivates Temporary railcars with incomplete cycles and no movement for longer than a

given time period.

7.14.4 Delete Railcar Data

Removes accumulating data that is over X years old. The year setting is selected on the Add New
Schedule dialog box as shown below. The data that is deleted is:

· Shipping Instructions
· Sightings
· Cycles
· Problem Logs
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7.14.5 Import Data and Create Cycles

This will run the Import Data Only process and the Create Cycles process together. First the Import
Data and then the Create Cycles.

7.14.6 Import Data Only

This will run the Import Data process.  What data is imported and from where is determined in the
Import Properties window.

If you wish to have your Daily reports to have current sightings on them you may wish to run this
several times during the day.  Users may continue to work in RMS while the import is happening.

7.14.7 Output Batch Reports

This process will enable you to automatically export and/or email RMS reports.  Go to Data
Management>Scheduler.

1. Click Edit for Output Batch Reports.  The following screen will appear:
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2. Select the output batch start date
3. Select the time of send
4. Select the interval (Daily, Monthly, One Time, Weekly or Yearly)
5. Select Batch
6. Click Save.

NOTE:  If there are no data records to display on the report, RMS will create a message informing
recipients of a scheduled report that there are no new reocrds attached to the report.

7.14.8 Update Trip Plans

This process is used to create/update RMS Trip Plans.  Trip Plans are used to record the events and
locations in a trip and their respective days to the final destination.  This is used by RMS to generate
Enhanced ETAs.  This process takes a lot of computing power and is best run over the weekend, once
per week.  It may take several hours to run. The default setting is to scan shipments for the last 60
days. You can change this setting to more or less days or a specific date range in the Data
Management > Reports > Properties window and Date Ranges tab.

NOTE: You must have shipping instructions that have entries for at least these fields in order for RMS
to create Trip Plan records that are useful enough to be used for ETAs: Origin, Destination, Route,
Load/Empty status, Transportation Method.

While RMS creates Trip Plans, it also creates the Station and OD Pair records that comprise your
route network. A very valuable by-product of this is that it allows RMS to validate cycle records. This
enables RMS to identify cycles that are invalid and will you find problems with the data that need
correcting. This is referred to as scrubbing the data (click link for more information on this).

7.15 Shipping Instructions (AKA: Bills of Lading, Waybills)

Shipping instructions information is very important if you want customer and/or commodity specific
reporting capabilities.  Although, most reports will function without this information.
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If you have a business computer system that generates this information, RMS could capture it with a
customized linkage.  RMS can get billing information directly from Class I railroads (in the form of ASC
X12 standard EDI 417 waybills) and comma delimited text files (fields must be in a specified order)
without customization.  If you prefer to get this information from a third party or from a business system
that cannot provide the data in the comma delimited format required, call Customer Support to discuss
your specific needs and possible solutions.

See Add shipping instructions; Update shipping instructions, Delete shipping instructions.

Note: Bills of lading, waybills, and shipping instructions are used synonymously in this help document.

7.15.1 Add shipping instructions manually

Step by step instructions to add shipping instructions manually:

1.  Click the Data Management > Shipping Instructions menu and click the Add New Shipping
Instruction link.
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2.  Enter the railcar initials and number on each of the two text boxes labeled Railcar intitial and
number.  If the railcar has not been entered in the RMS fleet yet, you may type in the initials and
number.  When you save the record, you will be asked if you wish to save the railcar in the RMS fleet
as a temporary assignment or a permanent assignment.  Temporary means that the railcar will only be
tracked for its loaded shipment; when the railcar is unloaded, it will be deactivated automatically. 
When a railcar is deactivated, it no longer shows up on Daily Reports, but the historical data remains in
the database and can be  analyzed using the Management Reports.  Permanent assignment of railcars
is the default and means that they will be tracked always whether they are loaded or empty and
whether there is a shipping instruction related to the current trip cycle.

4.  Enter Bill of Lading Number, Bill of Lading Date and Bill of Lading Time, LE Status, Trans. Method. 

This is enough information for RMS to make a temporary fleet update for free running / railroad-owned
railcars.  However, if you wish to use the full functionality of RMS, it is recommended that you at least
enter Shipper / Consignee / Care Of; Origin and Destination; and Route information.

5.  Click the Save command button to save the new shipping instruction.  Click Save & New to save the
shipping instruction and return to a new "Add New Shipping Instruction" page.  Click Save & New
Similar to save and clone the current shipping instruction.

NOTE: You may also add a shipping instruction from the Home page by selecting a railcar, entering a
date range, clicking the Refresh button, clicking the Shipping Instructions tab and then clicking the Add
New Shipping Instruction link.

7.15.2 Update shipping instructions

1.  Click the Data Management > Shipping Instructions menu. The following window will appear:
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2.  To find a particular shipping instruction, you may search several different ways.  In Step 1 leave the
All radio buttons selected.  In Step 2, if you know the bill of lading or waybill number, this would
probably be the fastest search method.  If you are not sure of the number of the shipment, type in the
railcar initial and number.  In Step 3, be sure to include a date range that the bill of lading date would
fall within.

3.  Click OK.

4.  Make the desired changes to the record and then click the Save command button.

NOTE: You may also update a shipping instruction from the Home page by selecting a railcar, entering
a date range, clicking the Refresh button, clicking the Shipping Instructions tab, and click the edit link
for the particular shipping instruction that you would like to modify.

7.15.3 Update multiple shipping instructions

** New feature in version 6.15.00 **

You may need to update the shipping instructions for many railcars that are moving together (i.e. the
shipments have at least matching Bill of Lading Date, Origin, Destination, Route). This process can be
done in a streamlined fashion by following these steps:

1. Once you have the Edit Shipping Instruction page open for one of the railcar shipments,
modify the record as needed. For example, change the Destination City and State for a diversion.

2. Click the Save button.

3. You will be prompted with a dialog box as shown below. Select the railcars that are moving with this
particular shipment by placing a check in the check box.

4. Click the Update all selected (checked) records button. All of the selected records will be
updated in the same manner as the record that you modified yourself.

NOTE: Only the field values that you modified in the initial record will be updated in the other records.
For example, if you modified the Destination City and State to "Tampa, FL", only the destination city
and state for the other records will be upldated to "Tampa, FL". If some of the other records have a
different waybill number or bill of lading number than the initial record that you updated, their original
values will remain.

NOTE: Often when one or more railcars are diverted, RMS will receive an updated waybill that contains
a correction code automatically. RMS will then automatically update the existing shipping instructions
with the new information. Some railroads do not deliver corrected waybills directly, but do send them to
another data repository where they may be purchased. Please contact support to find out if you can
take advantage of this automation.



Railcar Management System Help181

© 1997 - 2019  Railcar Tracking Company a Division of Savage Services Corp.

7.15.4 Delete shipping instructions

To delete one or more shipping instructions, follow these steps:

1.  Click the Data Management > Shipping Instructions menu.

2.  To find a particular shipping instruction, you may search several different ways.  In Step 1 leave the
All radio buttons selected.  In Step 2, if you know the bill of lading or waybill number, this would
probably be the fastest search method.  If you are not sure of the number of the shipment, type in the
railcar initial and number.  In Step 3, be sure to include a date range that the bill of lading date would
fall within.

3.  Click OK.
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4.  Click the Delete link for the records that you wish to remove permanently.

NOTE: You may also delete a shipping instruction from the Home page by selecting a railcar, entering
a date range, clicking the Refresh button, clicking the Shipping Instructions tab, and click the delete
link for the particular shipping instruction that you would like to remove.

7.15.5 Review shipping instructions

To maintain data integrity, RMS provides a way to identify suspect shipping instruction records.

The most common way to do this is to check Attached and Duplicate radio buttons in Step 1 on the
Review shipping instructions window and click OK.  RMS will return a list of shipping instructions that
are not Attached and/or Duplicate.

Definitions:

Attached = True: the shipping instruction has been identified by RMS to be the record related to a
particular trip cycle record.  RMS makes this relation by comparing the shipping instruction Ship Date
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and Load/Empty Status with the trip cycle Release Date and Load/Empty Status.  If the two dates differ
within the specified plus or minus days (you set the number of days in Reference Values:
Relate BOL Days and Relate BOL Days Early Relase), then it "attaches" or relates the two records.

Attached = False: The two dates mentioned in the Attached definition do NOT differ within the
specified plus or minus days range.

Duplicate = True:  the shipping instruction COULD, but is NOT attached to a trip cycle because there
is already another shipping instruction attached to the trip cycle record.

If RMS identifies duplicates, you will want to look at the identical shipping instructions (done by
including the Attached shipping instructions) and then determine which ones you wish to delete.  If you
delete the shipping instructions that are Attached to the trip cycle, RMS will automatically attach the
best matching remaining shipping instruction to the cycle. Duplicates can be caused by human error
while entering shipping instruction records into RMS or a waybill may have been cancelled and
reissued by a rail carrier without the proper correction code.

If RMS identifies unattached shipping instructions, this may indicate that the trip cycle has been mis-
created due to a data reporting error.  The most common data reporting error is when a rail carrier
reports a railcar as empty when it is really loaded or vice versa.  This causes RMS to prematurely
terminate the existing trip cycle and prematurely start another trip cycle.

Note: You should only review shipping instructions that are dated prior to the last time you ran the
Create Cycles procedure.  The Create Cycles procedure creates new trip cycle records.  If the new trip
cycle records have not been created yet, RMS will display many of the recent shipping instructions
where Attached = FALSE, however this is not really an indicator of a problem yet because the shipping
instructions cannot attach to a trip cycle record that doesn't exist yet.

7.15.6 Import from Railroad Customer 417 Account

Coupling CLM / Sighting data with shipping instruction data (bills of lading or waybills) can be a
powerful combination.  For example, not only will you know where your railcars are and what station
they are destined to, you will know what customer they are going to and what product they are carrying
and many other helpful pieces of information about the shipment.

The Class 1 Railroads have a policy that they call "Customer 417s".  The policy says that if you are a
Party to the shipment (i.e. Shipper, Consignee, Care Of, Freight Payor), you are entitled to get one free
electronic copy of the EDI 417 Waybill record.  The key is that the data must be transmitted directly to
you.  If the data is transmitted to a third party first, like a Value Added Network (VAN) or an Application
Software Provider (ASP), then there may be a charge.  The 417 Waybill is almost identical to the 404
Bill of Lading, which is what the shipper transmits to the railroad to initiate a shipment.  It has all the
important information about the shipment such as Shipper, Consignee, Care Of parties, Origin,
Destination, Weight, Commodity, Bill of Lading Number, Date, Time, Route, and Contract Number. 
However, the information in the 417 record is encoded in X12 EDI (Electronic Data Interchange)
format.  This formatting makes it hard to use the information unless you have specific software that
understands this formatting and can translate it.

RMS can translate 417s.  All you have to do is tell RMS about where to pick up these records.  These
locations will be FTP (File Transfer Protocol) sites of the Class 1 Railroads.  FTP sites are accessible
via the Internet and are used to transfer files from a remote computer.  Each time one of your
shipments (outbound or inbound) is billed (i.e. a bill of lading is transmitted to the originating railroad),
the originating railroad creates an electronic record called a 417.  The 417 is used between the various
railroads that will be involved in completing this shipment; it gives them vital information required to
make sure that the shipment gets to the proper place.  The 417 record is then written to a railroad's
FTP site.  It is then available for RMS to download by naming convention.
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Follow these steps to get 417 waybills for your shipments:

1. Ask the railroads that originate these shipments to set up an FTP account and to send copies of
each 417 for each shipment to this FTP site.  Determine what railroads (line haul carrier Class I's -
few shortlines have the ability to transmit waybills to customers) originate outbound or inbound
shipments for your company.  For each of these railroads, contact an e-commerce manager that is
in charge of setting up Customer 417 accounts.  They will probably ask you to send a letter on
your company letterhead authorizing this and specifying the shipments origins and destinations. 
Once this letter is received, they will establish an FTP account and 417 records will begin showing
up in this account.

Note: Contact Railcar Tracking Co. Customer Support and ask for a Waybill Authorization Letter
template and a list of most Class I railroad e-commerce contacts.  If you copy your authorization letters
to support@railcartracking.com, we can be available to assist in answering some of the more technical
questions that the railroads may have. It is recommended that you follow up with each railroad on a
weekly basis. It takes between two to eight weeks to get these accounts established.

2. Click the Data Management > Import Properties and check the Railroad/VAN check box; the EDI
File Transfer Profiles form will open; tell RMS about the locations of these 417 records so that it
can import them  during the Import Data process. 

3. If the EDI File Transfer Profiles form is not already open, click the Data Management > EDI File
Transfer command button.

4. Click the Add New EDI File Transfer link.

5. Fill out a name for the particular profile in the Name text box – this is just to identify the account so
that you can easily recognize and retrieve it if it needs to be updated.

6.    Select EDI 417 from the Format drop-down box.

7. Choose a Source of the data from the Source drop-down box; this is the railroad that has set up
this particular account.

8.    Select the Protocol.

9. Type in the User Name and Password in the respective text boxes to access the account.

10.  Enter the Host Internet address of the account (example: ftpedi.bnsf.com).

11. If the files reside in a folder, enter the folder name in the Folder text box.

12. The Filename text box is not used at this time.

13. Each company (your company) has a unique billing identification, get or establish this with the
railroad and enter it into the Corp. ID text box.

14. Departments or subsidiaries may have separate unique billing identifications, get or establish this
with the railroad and enter it into the Dept. ID text box.

15.  Fleet name is not required.

16.  Enter a check in the Passive Connection check box.

17. Enter a check into the Delete File After Xfer check box if the 417 files are not automatically deleted
after download – be sure to ask the railroad about this because an incorrect setting could cause
errors during your import.  So far, the UP (via Transentric) is the only account that we know of that
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automatically deletes files after download.

18. Click the Save button.

NOTE: Once the record is imported, the import date and time will appear on the record in RMS.

NOTE:You don't want to leave files on the account once they are downloaded because then the import
process will take longer and longer while RMS is downloading duplicate files.  RMS will not add
duplicate (exact) records to its database, but you don't want to waste your time waiting for unnecessary
files to be downloaded.  Plus, the railroad or value added network that manages the account may get
upset that you are using so much storage on their server.

If you wish to schedule automatic imports of 417s, see the Scheduler help topic.

7.15.7 Import from RTC Data Services

For a quicker setup, you may subscribe to Data Services. Contact Railcar Tracking Co. Technical
Support or Sales and with 5 business days or less, shipping instructions from over 550 railroads will be
automatically imported into RMS for any shipment where your company is a party mentioned on the
waybill. Once the set up is complete, you will be emailed instructions.

7.15.8 Import from a text file

RMS will import shipping instructions from a comma separated values (CSV) text file.  Shipping
Instructions are imported at the beginning of the Import Data process, which encompasses the import
of shipping instruction and sighting (CLM) data.

Step by step instructions:

1. Click the Data Management > Import Properties menu.

2. Click the Shipping Instructions Data tab, click on the check box to select Text File.

3. Click Save.

4. Name the text files according to the naming convention below. This is how RMS knows that the file
is a shipping instruction and is formatted in CSV.

5. Put the files into the Flat File Directory.

Note: There is an option to download these files from an FTP server. Follow the instructions given in
the Import from Railroad Customer 417 Account with the exception of choosing "Waybill CSV Text"
from the Format drop down list. Also, the FTP server may not necessarily be a railroad server since
railroads do not typically deliver waybills in CSV format.

The next time you Import Data, RMS will automatically search for these files in the Flat File Directory
and import them.  Once the file is imported, the import date and time will be added to the record in
RMS. Often a script may be created that automatically places the files in the Flat File Directory.

Note:  When a shipping instruction is imported for a railcar that does not exist in the RMS fleet, the
railcar is automatically added to the RMS fleet as a Temporary.  This means that RMS will only track
this railcar for that particular shipment (usually load shipments).  If you want to track this railcar for all
shipments (load and empty), then you must uncheck the Temporary check box found on the Railcar
window.  If you want all of your railcars to be Permanent, you must add the railcars to the RMS fleet



Data Management 186

© 1997 - 2019  Railcar Tracking Company a Division of Savage Services Corp.

first.  To do this, see Add Railcars topic.

Required Record Format for the Text File

The text file must be delimited by commas with fields that may contain commas qualified with double-
quotes (example: "Integrated Soils, Inc."). Do not include column headings in the file. The text in the
columns must not exceed the width given below.  If BOL Time is missing, the record will import with a
default time.
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48 ShipFromCity Text 30 No

49 ShipFromState Text 2 No

50 ShipFromPostalCode Text 15 No

51 ShipFromCountryCode Text 3 No

52 PickupFrom Text 35 No

53 PickupFromAddress1 Text 55 No

54 PickupFromAddress2 Text 55 No

55 PickupFromCity Text 30 No

56 PickupFromState Text 2 No

57 PickupFromPostalCode Text 15 No

58 PickupFromCountryCode Text 3 No

59 CareOfAddress1 Text 55 No
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60 CareOfAddress2 Text 55 No

61 CareOfCity Text 30 No

62 CareOfState Text 2 No

63 CareOfPostalCode Text 15 No

64 CareOfCountryCode Text 3 No

65 ShipperPostalCode Text 15 No

66 ShipperCountryCode Text 3 No

67 ConsigneePostalCode Text 15 No

68 ConsigneeCountryCode Text 3 No

69 ShipperCIF Text 80 No

70 ConsigneeCIF Text 80 No

71 CareOfCIf Text 80 No

72 FreightPayerCIF Text 80 No

73 ShipFromCIF Text 80 No

74 PickupFromCIF Text 80 No

75 HazUNNAIDCode Text 6 No

76 HazPageNumber Text 6 No

77 HazSTCC Text 30 No

78 HazResidue Text 1 No

79 HazPackingGrpCode Text 3 No

80 HazIndustyCode Text 30 No

81 HazClass Text 30 No

82 HazShippingName Text 25 No

83 HazEmergencyContact Text 60 No

84 HazEmergencyTelephone Text 80 No

File Naming Convention

When you save a file that contains properly formatted shipping instructions as shown above, the name
of the file and the location is important. You must name the file in a way that RMS knows how the data
is formatted and what type of records it contains.  This is the naming rule:

Part of Name Character Position Explanation
Import flag indicator 1 - 11 If this is present, is "NotImported"
Type of records 12 - 15 BILL is used to identify that these are billing
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records
Format of records 16 - 18 TXT
Format of file 19 - 21 COM
Source of records 22 - 25 Quite often this is used for a railroad SCAC
for example: BNSF, UPXX, KCSX ** optional
Date / time stamp 26 - 41 YYYYMMDDHHMMSSMS (ensures that the
file name is always unique)

For example: a file that was created on July 13, 2007 at 2:03pm where the shipping instruction records
are in the TXT, comma separated values (CSV) format would read:

NotImportedBILLTXTCOMXXXX2007071314030101.txt

Location of File

When you have properly named the file, save it in the Flat File Directory.

Migration from RMS version 3.X to new versions considerations

You may need to extract shipping instructions from an RMS 3.X database.  Here is the query (modify
the date to suit your needs) to use in the Data Management > Advanced > Ad Hoc Query window -
paste it into the SQL text box and click on Run Query; when the data is displayed, click on the Save
Results button - this will save the results as a comma separated values (CSV) file which is easily
imported by RMS using the Text option.  Please see the File Naming Convention notes above to know
how to name this file and where to save it.

SELECT """" & [CarInitial] & """" AS CarInitial2, T_BOL.CarNumber, """" & [BOLNum] & """" AS
BOLNum2, T_BOL.BOLDate, T_BOL.BOLTime, """" & [Shipper] & """" AS Shipper2, """" & [Consignee]
& """" AS Consignee2, """" & [OriginCity] & """" AS OriginCity2, T_BOL.OriginState, """" & [DestCity] &
"""" AS DestCity2, T_BOL.DestState, """" & [Route] & """" AS Route2, T_BOL.STCC, """" &
[Commodity] & """" AS Commodity2, """" & [Contract] & """" AS Contract2, T_BOL.Weight, """" &
[CareOf] & """" AS CareOf2, T_BOL.Correction, IIf(IsNull([LEStatus]) Or
Len(Trim([lestatus]))=0,'L',[LEStatus]) AS Expr1, "TXT" AS Source2, T_BOL.ShipmentID,
T_BOL.ShipmentDesc, T_BOL.ExpOrderDttm, T_BOL.TransMethod, Now() AS DocCreated2
FROM T_BOL
WHERE (((T_BOL.Imported)>=#7/9/2007#));

7.16 Sightings

7.16.1 Add / Update / Delete railcar sightings

Follow these steps:

Add new railcar sightings

1. From the Home window, select the railcar for which you wish to add sightings from the Railcar
drop down text box.

2. Click the Add New Sighting link (Sightings tab).
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3. Fill in the fields with the desired entries. Required entries are indicated by a red asterisk.
4. Click to Save.  You have three options:

A.  Click the Save button to save the railcar sighting.
B.  Click Save & New to save the railcar sighting and return to a blank Add New Sighting page to
create a new railcar sighting.
C.  Click Save & New Similar to save the railcar sighting and return to an Add New Sighting page
that is prepopulated with the fields matching the previous railcar sighting data.

Update railcar sightings
1. From the Home window, select the railcar for which you wish to update sightings from the Railcar

drop down text box.
2. Change the date range as necessary using the Begin and End text boxes and click the Refresh

button. Sightings for that time period will display (on the Sightings tab).
3. Click the Edit link for the sighting record. Make changes to the record and click the Save button.

NOTE: It is recommended that you enter a brief code (5 characters or less) in the Comments field to
indicate what type of modification

was made to the record.

NOTE: Any modification to a sighting automatically causes the cycle that the sighting is a part of and
any following cycles to be deleted. This

is done to ensure that the cycle(s) are recreated propertly. The next time that RMS runs the Create
Cycles process, these cycles will be

recreated including the updated information on the sighting(s).

Delete railcar sightings
1. From the Home window, select the railcar for which you wish to delete sightings from the Railcar

drop down text box.
2. Change the date range as necessary using the Begin and End text boxes and click the Refresh

button. Sightings for that time period will display (on the Sightings tab).
3. Click the Delete link.

NOTE: If the sighting that is deleted is part of a cycle, that cycle and any following cycles are deleted.
This is done to ensure that the cycle(s)

are recreated propertly. The next time that RMS runs the Create Cycles process, these cycles will be
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recreated without the sighting(s) that were deleted.

7.16.2 Restore Archived Sightings

When a sighting for a Temporary railcar is imported that doesn't have a current shipping instruction
associated with it, the sighting will be archived. There is also an option when deactivating railcars, to
archive sightings that are part of an incomplete cycle. To restore an archived sighting, click the
Archived Sightings tab from the Home page.

1. Select the sightings you want to restore by placing a check in the adjacent check box.
2. Click the Restore Selected Sightings button.

The sightings will be moved to the main database and will be shown in the Sightings tab window after
the window refreshes.

7.16.3 Import railcar sightings

During this process, the new railcar sightings (CLMs) are assimilated into the database and into new
and/or existing cycles.  If a CLM record does not have a value for the Railroad field, it will still import.

There are several ways to import CLMs into RMS.  The first is to import CLMs directly from
Steelroads. The next way is to import CLMs from a text file provided to you from some other source;
these CLMs must be in Format D or H in either fixed or CSV (comma separated values)
text file format.  The third way is to import CLMs from Data Services from Railcar Tracking Company.
If you are having trouble deciding which source to use, give us a call and we'll guide you to the most
cost effective choice depending on your specific needs.

7.16.3.1 Import from Steelroads

To import railcar sighting records (commonly referred to as CLM) from Steelroads, follow these step by
step instructions (it is assumed that you already have entered your railcar fleet or shipping instructions
into RMS before performing this function; see Add/Update Railcars):

1. Click the Data Management > Import Properties menu. 

2. Click on the Sighting Data tab.

3. Check Steelroads check box and select the File Format.  Note: CLM Format H includes the ETA and
is the recommended format.

4. Choose either the option button for "Last Event for Privates and Temps" or "New Events for Privates
and Last Event for Temps". If you are tracking only private (owned or leased) railcars, choose "New
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Events...". If you are tracking private AND temporary railcars, choose the "New Events..." option.  The
only time that it is recommended to use the "Last Event for Privates and Temps" option, is if you don't
want to maintain the separate Steelroads Trace List that is required to get new events for private
railcars.

5. Click the Save button.

6. Click the Data Management > Reference Values menu.

7. Click the Edit link for "Steelroads Login"; enter your Steelroads user name (case sensitive) in the
Value text box; click Save.

8. Click the Edit link for "Steelroads Password"; enter your Steelroads password (case sensitive) in the
Value text box; click Save.

9. If you own, lease or have permanently assigned railroad pool railcars that you wish to trace all
events for, it is recommended that you maintain a saved Trace List in Steelroads, otherwise go to step
10.  Steelroads's New Events response option (an option that enables you to receive all of the events
on all railcars in the list since the last time a trace was performed – traces must be performed within 4
days of each other to avoid gaps in the railcar movement history) requires a saved Trace List in order
to operate properly.  It is recommended that you have a Trace List to be used only by RMS; this is
because if you run the Trace List from within a browser, the last trace date would be reset and the next
time RMS would run that Trace List, it would not receive the events that printed out in the prior
browser-based trace.  To take advantage of this option, you must maintain two lists of permanent
railcars: one in RMS and one in the Steelroads Trace List.  This is a bit more work, but the benefit of
having a complete movement history for each railcar is worth the extra work. If you really do not want
to do this, you could use Data Services, which does not require this extra step.  

10. Once the record is imported, the import date and time will appear on the record in RMS.

Note: Steelroads allows a maximum of 1,000 railcars per Demand Trace List.  If you wish to trace more
than 1,000 railcars, create multiple lists.

Click the Edit link for "Steelroads Demand Trace List(s)" and enter the name of a list of railcars (case
sensitive) that you have saved in Steelroads in the Value text box; click Save.  If you have multiple lists,
enter these list names separated by a semi-colon.

Temporary railcars (those that are only being used and tracked for a loaded shipment and are not
controlled by your company) will be traced by their last event each time the RMS runs an import.  Thus
it is important to run at least one import per day. The maximum recommended number of imports, if
you are tracking temporary railcars, is 4.

This process must be scheduled. See the Add, Update, Delete a scheduled activity for instructions on
how to set up a scheduled Import Data Only or Import Data and Create Cycles.

NOTE:  If you're encountering a large number of time out errors and you have a high volume of
railcars, you will want to adjust the Trace Request Batch size to a smaller number.  This may be
accomplished by opening the Help>Diagnostics window and clicking Edit next to BatchSize.  This
requires administrative access, and you may need to request the administrator to do this.

7.16.3.2 Import from a text file
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1. Click the Data Management > Import Properties menu.

2. Click on the Sighting Data tab.

3. Check the Text File check box. Do not check the Manually assign event years check box unless you
will be importing data older than a few days.

4. Click Save.

5. Place text files of sightings in the Flat File Directory. Note: the sightings must be formatted in either
standard CLM Format D or H in fixed or CSV (comma separated values) and the files must be named
according to the conventions listed at the bottom of this topic.

This process must be scheduled. See the Add, Update, Delete a scheduled activity for instructions on
how to set up a scheduled Import Data Only or Import Data and Create Cycles. Once the import takes
place, the import date and time will be added to the record in RMS.

WARNING:  Do not import more than one year at a time.  RMS cannot distinguish between CLM
records from the same month, but in different years.

CLM File Naming Conventions

Part of Name Character Position Explanation
Import flag indicator 1 - 14 "NotImported" (this indicates that the file
needs to be imported)
Type of records 15 - 17 Always "CLM"
Format of records 18 "D" or "H" depending on the format of the
records 
Format of file 19 - 23 Either "Fixed" for fixed length or "Comma" for
comma delimited
Source of records 24 - 26 "TXT" for text file
Date / Time Stamp 26 - 39 Example: 6/11/2007 12:01:01 PM would be:
"20070611120101"
File extension ".txt"

Completed example: NotImportedCLMDFixedTXT20070611120101.txt

The naming convention allows files to be dropped into the Flat File Directory and if they are named
properly, RMS will automatically import them upon the next import process, keeping things very simple.
After the file is imported successfully, the "NotImported" part of the file name is removed by RMS.

7.16.3.3 Import from Data Services

You may subscribe to Data Services. Contact Railcar Tracking Co. Technical Support or Sales and in
five business days or less, sightings will be automatically imported into RMS for any shipment where
your company is a party mentioned on the waybill.

7.17 Stations

7.17.1 Add a station

1. Click the Data Management > Stations.
2. Click on the Add New Station link.
3. Type the full spelling of the city in which the station is located in the Station City text box, and type
the state two-letter abbreviation in the Station State text box.
4. Enter the rest of the information as required.  
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Note:

Some stations may have many aliases and some may have only one.  RMS will automatically add
industry standard aliases.

This manual does not intend to teach about abbreviations and recommends that the user does an in-
depth study to gather all the various spellings of all stations in the distribution route network.  However
some rules of thumb regarding abbreviated spellings (aliases), which RMS enters automatically:

All aliases have 9 characters or less. Many times the 3-3-3 standard is used (usually for current
location city on a railcar sighting record).  The 3-3-3 standard builds an alias as the first 3 characters of
a location's first name; the first 3 characters of a location's 2nd name (if applicable) and the first 3
characters of a location's 3rd name (if applicable).  East, West, North, South are abbreviated to one
character: E, W, N, S.  Fort is FT.  There are several other rules; it is recommended that you contact
your rail carrier if you have questions.  For example:  Fort Worth = FTWORTH; Salt Lake City =
SALLAKCIT; East Bridge Junction = EBRIJUNCT.

Many times the first 9 characters are used (usually for destination city on a railcar sighting).  For
example:  Fort Worth = FORT WORT or FT WORTH; Salt Lake City = SALT LAKE; East Bridge
Junction = EAST BRID or NEW ORLEA.

Alias abbreviations can be very confusing, so again, it is recommended that aliases be gathered from
empirical research (actually looking at the spellings) because there are so many variations. The aliases
are shown on the Home > Sighting data tab screen in the Location and Destination columns.

7.17.2 Update a station's characteristics

1. Click the Data Management > Stations menu.
2. Find the station to be updated by entering the first few characters of the station name and click the
Search Stations command button.
3. Click the Edit link.
4. Change the information as required.

WARNING:  You should use extreme caution when updating the station city and/or station state. 
These should only be changed if you misspelled them.  Any other action will corrupt the database and
cause invalid measures.

7.17.3 Merge a station

Occasionally, two station records are created for the same station city & state due to inconsistent
spelling of the city / state. This feature enables a station to be merged into another station with only a
few mouse clicks.

Follow these steps to merge a station into another station.

1. Click the Data Management > Stations menu.

2. Click the Merge Station hyperlink for the station that you wish to merge into another station.
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3. Once the Merge dialog box opens, choose from the drop down list box the station that you wish to
merge into and click the Merge button.

All of the station aliases of the original station will be added to the target station.

7.17.4 Managing & Responsible stations

Often a shipment is billed to one station, such as Charlotte, NC and the railcar is actually placed in
Pineville, NC. This can cause confusion when you are running reports and want to filter by destination
(or origin or last location) - which one do you use? If you want to simpify shipment origins and
destinations and you don't want to merge the stations, then make one of the stations a Managing
station and then make it the other stations Responsible station. In this example, we will make
Charlotte, NC the managing station for Pineville, NC because our company tends to refer to these
shipments as going to Charlotte, NC.

1. Click on the Data Management > Stations menu
2. Click the Edit link for the Charlotte, NC station
3. Click on the Other tab; place a check in the Managing Station check box; click the Save button
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4. Click the Edit link for the Pineville, NC station
5. Click the Other tab; select Charlotte, NC from the Responsible Station drop down list; click the Save
button
6. When you run any report and filter by Origin, Destination or Last Location = Charlotte, NC, the
results will include Pinville, NC as well.

NOTE: The origin, destination or last location will show as Charlotte, NC.

7.17.5 Delete a station

1. Click the Data Management > Stations menu.
2. Find the station to be updated by entering the first few characters of the station name and click the
Search Stations command button.
3. Click the Delete command link.

NOTE:  You will not be able to delete a station until all other records that reference the station are
deleted first: OD Pairs, Demurrage/Detention criteria, Contract Rates, Trip Plans. If you attempt to
delete the station, RMS will tell you what records need to be deleted before it can be deleted as shown
below. You may also click on the Merge button to merge the station into another station.
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7.18 Trip Plans

Enter topic text here.

7.18.1 Automatic Generation

See the topic Scheduler > Update Trip Plans for instructions on how to schedule this feature.

Trip Plans are used to record the events and locations in a trip and their respective days to the final
destination.  This is used by RMS to generate ETAs.  This process takes a lot of computing power and
is best run over the weekend, once per week.  It may take several hours to run. The default setting is
to scan shipments for the last 60 days. You can change this setting to more or less days or a specific
date range in the Data Management > Reports > Properties window and Date Ranges tab.

NOTE: You must have shipping instructions that have entries for at least these fields in order for RMS
to create Trip Plan records that are useful enough to be used for ETAs: Origin, Destination, Route,
Load/Empty status, Transportation Method.
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While RMS creates Trip Plans, it also creates the Station and OD Pair records that comprise your
route network. A very valuable by-product of this is that it allows RMS to validate cycle records. This
enables RMS to identify cycles that are invalid and will you find problems with the data that need
correcting. This is referred to as scrubbing the data (click link for more information on this).

7.18.2 Update multiple event days to destination manually

If you prefer to set the Days To Destination for trip plan events yourself and you would like to do this
using data from a spreadsheet, follow these steps.

The accepted input is from a spreadsheet (i.e. tab delimited) in either this format:

With this format, RMS will update the Days To Destination for all trip plans that are destined to the
station that the user selects and where the Trip Plan Event has matching Event State, Event City, and
Railroad.

Or:

With this format, RMS will update the Days To Destination for all trip plans that are destined to the
station that the user selects and where the Trip Plan Event has matching Event State and Railroad.

If Days To Destination are updated by this process, it will also lock the Days To Destination so that the
Update Trip Plans scheduled process will not overwrite the setting.

For example, if you want to update all Days To Destination for Trip Plans destined to Decatur, IL, follow
these steps:

1. Open the spreadsheet that contains the Days To Destination estimates for particular States, Cities
and railroads

2. Copy all of the data entries from A3 to D?? (do not include column headers).

3. In RMS, open the Data Management > Trip Plans page and click on the link titled: Update Multiple
Events.

4. Select Decatur, IL from the Destination drop down.

5. Paste the data into the large text box at the top of the page.

6. Click the Validate button, then click the Save button.

NOTE: If you enter a negative number for Days To Destination, this will signal RMS to not generate an
ETA for that particular Event State, Event City, and Railroad.
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8 Admin

This menu will display different submenus depending on the role of the user. If your role is
Administrator, then you will see all of the submenus as shown below. Otherwise, you will only see the
Change Password menu.

8.1 Create User

Administrators are able to setup user accounts in RMS.  To do this, go to Admin>Create User.  The
following screen will appear:
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1. Enter a user name for the user.
2. Create a password
3. Confirm the password
4. Enter user's email address
5. Enter a security question (NOTE:  To bypass this feature, enter Q in this field)
6. Enter answer for security question (NOTE:  To bypass this feature, enter A in this field)
7. Select Role.  There are three roles:
     A.  Administrator:  This role has access to everything in RMS including the Admin tab which allows
user to create users, manage the site and create roles.
     B.  Power User:  This role has access to everything in RMS except the ADMIN Tab.
     C.  Guest:  This role has READ ONLY access to RMS.  They do not have the ability to edit anything
in the system.
     NOTE:  Customized roles can be configured.  Contact support@ralcartracking.com for additional
information about customized roles.
8.  Click Create User.

8.2 User Management

This window enables you to:
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· Delete users
· Change passwords of users
· Change roles of users
· Reset the password of users

Delete user

Simply click the Delete link next to the user name that you wish to delete.

Change password of users

1. Click on the Change Password link next to the user name.
2. The window below will open; enter the old password, the new password and the new password
again and click OK.

NOTE: If the old password was forgotten, you should use the Reset Password process instead.

Change role of users

1. Click on the Change Role link next to the user name.
2. The window below will open; select the role and click the Change Role button.
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NOTE: The roles that are available by default are Administrator, Power User and Guest.

· Administrator: has full access to all features
· Power User: has full access to all features except most User Management functions
· Guest User: has read only access to all features except most User Management functions

If your company requires a different role, please contact support@railcartracking.com, and we can
customize a role for you.

Reset password of users

To reset a password click Reset Password associated with the account for which you are resetting a
password.  You will see the following message:

The admin can then forward the password to the user; when the user logs in, he/she will be prompted
to change the password.

8.3 Create Role

This feature is not fully implemented. If your company requires a different role, please contact
support@railcartracking.com, and we can customize a role for you.
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8.4 Change Password

1. Click on the Admin>Change Password menu.
2. Enter the old password.
3. Enter the new password and repeat.
4. Click the Change Password button.

9 Help

9.1 Error Logs

To search for information to help diagnose an issue, go to Help>Error Logs. There are several different
types of logs that are written, not just errors.

1. Informational: log information such as when a process starts and ends.
2. Statistical: records the number of records handled during a process.
3. Warning: raises a message about situations that are unusual, but not serious enough to stop the
process or notify anyone.
4. Error: logs a message that describes an problem encountered during the process. When an error is
logged, the errors are emailed to the Technician Email Address, which is maintained in the Data
Management > Reference Values.

To display logs, follow these steps:

1. Select the Type of Message you want to receive or leave at default (All Messages) to view all
messages.
2. Enter Begin Date
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3. Enter End Date
4. Click Refresh
5. Messages pertaining to the time period will appear as shown below:

9.2 Event Logs

Event Logs

To search for an event, go to Help>Event Logs

1. Select the railcar initial from the Railcar Initial field

2. Select the railcar number from the number field.

3. Check whether the railcar is active or inactive.

The Event Log will automatically filter to the events pertaining the railcar identified.

10 Glossary

6-3-3

The first 6 characters of the first part of a company name, plus the first 3 characters of the second part
(if there is one) of a company name, plus the first 3 characters of the third part (if there is one) of a
company name – with no spaces in between.  Always spell out completely the last part of the company
name, but only so much until you have a total of 12 characters.  For example, General Motors
Corporation would be GENERAMOTCOR.  Another example, Intel Corporation would be
INTELCORPORA.  Type in any other information desired in the rest of the text boxes provided. 

Bad Order Codes

When the Event field value = B (bad order), then the TrainID field value will change to include a code
that describes the type of repair that is required.
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Code Classification Description
A Body Including floors, roof, sides, ends and multi-level rack.
B Braking System Any brake component listed in Rule 83**, Car Part Codes,
under the headings of Brake Equipment and/or Piping.
C Clean-Out Including preparation for loading such as clean-out,
conditioning and/or pre-tripping, but excluding mechanical refrigeration equipment.
D Derailment/Accident Derailment/Accident Damage resulting from derailment,
sideswipe, fire, flood or other casualty.
E Doors Doors Including side, end and hopper doors, outlet gates,
hatch and dome covers.
F Draft System Draft System Including couplers, yokes, draft gears, draft
lugs, draft sills, EOC and COC cushioning units and articulated connections.
G Interior Linings & Coatings Interior Linings & Including any interior lining or coating.
H Load Load Requiring measurement, weighing, adjustment, transfer
or containment of leaking commodity.
I Load Restraining Devices Load Restraining Devices Components integral to car such as
tie down equipment, interior bulkheads, DF equipment, trailer hitches, container pedestals or other
similar equipment.
J Mechanical Inspection Mechanical Inspection Including inspection resulting from
Early Warning letters, Maintenance Advisory notifications or special instructions received from car
owners or handing line.
K Refrigeration Equipment Refrigeration Equipment Including inspection, pre-tripping and
defective equipment listed in Rule 83, Car Part Codes, under the heading Mechanical Refrigeration
Equipment.
L Safety Appliances Safety Appliances Including handholds, sill steps, ladders,
running boards, crossover boards, brake steps and uncoupling levers.
M Trucks Trucks Including side frames, truck bolsters, friction castings,
springs, snubbers and side bearings, but excludes wheel assemblies and brake rigging.
N Underframe Underframe Including center sills, side sills and body
bolsters,crossbearers, crossties, body center plates and body side bearings.
O Wheel Assembly Wheel Assembly Including wheels axles, friction or roller
bearings, wedges, adapters, periodic attention and hot boxes.

Event Codes

AAR      Description CLM
ALR Actually Loaded on Rail
ALV Actually Loaded on Vessel
ARD Actual Arrival Date at Final Destination
ARI Arrival Transit Location A
ARR Arrival Final Destination D
BAD Bad Order B
BFR Release from Bad Order G
BHV Bad Order Heavy Repair B
BLG Bad Order Light Repair B
BOH Bad Order - Hours to Repair B
CG1 Car Grade By Inspection 
CRD Cargo Receipt Date
CSL Cargo Stripping
DDL Delivery Attempt
DEA Deactivate Railcar
DFL Departure from Location P
DRM Deramped V
EAD Estimated Arrival Date
EDD Estimated Departure Date
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EFT Estimated Free Time
ERD Estimated Arrival at Final Destination
ETA Advanced Estimated Time of Arrival 3
EWI Early Warning Inspections
EWL Early Warning Letter (AAR Only)
FTE Free Time Expired Date
HAR Highway Arrival RR Facility C
HMI Hold or Miscellaneous H
HRE Release from Hold or Miscellaneous 9
IBD In Bond
ICH Interchange Delivery J
ICR Interchange Receipt R
IGT Intermodal In-Gate C
INV Inventory Move (AAR Only)
IRD Intransit
IRI Ingate from Rail Interchange K
ITS Ingate from Rail Terminal or Satellite L
MWY Move Away M
NOB No Bill at Location N
NOT Notified at Destination Party Y
OGT Intermodal Out-Gate
ORI Outgate to Rail Interchange
OTS Outgate to Rail Terminal or Satellite
PAC Placement Actual Z
PCH Pool Change
PCO Placement Constructive Y
PFP Pulled from Patron X

Layover

A term used to indicate the time it takes a railcar to be loaded or unloaded. The measurement begins
at the constructive placement event (if this event is reported) or actual placement event and ends with
the following release event.

Permanent railcar

The railcar is permanently assigned to your company.  Typically this means that the railcar is owned or
leased by your company, thus you wish to track its loaded and empty movements.  It could also mean
that a railroad has assigned a set of railcars to be used exclusively by your company.  When you add a
railcar to the RMS fleet, it is, by default, a permanent railcar.  RMS will track its loaded and empty
movements indefinitely.

SCAC

Serving Carrier Alpha Code.  This is how railroads identify themselves in a standard way.  Up to 4
alpha characters are allowed.

SPLC

Standard Point Location Code.  A 6 digit number identifying a station.

SQL

Abbreviation for Structured Query Language.  It is an industry standard, english-like language for
selecting, inserting, updating and deleting database records.  You may query the RMS database
directly by clicking on the Data Management | Advanced | Ad Hoc Query menu.
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STCC

Standard Transportation Commodity Code.  It is a seven digit numeric code representing 38
commodity groups.

Temporary railcar

The railcar is temporarily assigned to your company.  Typically this means that the railcar has been
assigned to your company by the railroad just for one particular shipment; it could also be an inbound
shipment to you from a supplier who owns or leases themselves.  After the railcar is unloaded and
returned to the railroad or supplier, it may never be used by / for your company again; it goes back into
a general pool that is used by many railroad customers.  Also known as "system cars" or "free
runners".  It is not recommended that you add a temporary railcar to RMS. It is best to let RMS handle
the adding of the railcar when it receives a shipping instruction (i.e. waybill).  RMS will automatically
deactivate temporary railcars immediately after they are unloaded.  Deactivation means that
movements of the railcar are no longer tracked and the railcar does not display on Daily Reports (i.e.
any report that shows just the last location of railcars).

11 Advanced

Enter topic text here.

11.1 Email Reports

It is possible to email reports.  To do this, click the Mail To icon at the top of the page once the report
is generated.

1.  Enter the following format.
2.  File Format:  Select the report format you'd like to send.
3.  To:  Enter email address.
4.  From:  Ensure your email address is correct.
5.  Subject:  Enter a subject.
6.  Message:  Enter a message to be included in the body of the email with report attached.
7.  Click Send Email.
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11.2 Import Railcar Sightings

Excluding records / lines

There are several settings that RMS uses to ignore lines in a sightings text file because they would
cause problems:

· Improved sighting data import to ignore text file lines that match the ignore table entries.
· Sightings with Event = '3' must be excluded from import.
· The Import Data process now accomodates CLM records that do not have a value for the Railroad

Field.

11.3 Release Sightings

RMS will handle temporary railcar reloads when railroad reports an empty release sighting and load
waybill on same day.

11.4 Known Issues
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